
 
 
 

 
 
Version 6.51 
 
VERY IMPORTANT 
 
It is highly recommended that this manual is read thoroughly and that the default data supplied with Dynasoft TeleFactura is used to 
accustom oneself with the programme. This will make porting new data to Dynasoft TeleFactura a lot easier. 
 
Fully test all billing scenarios before final invoices are sent out to customers. This includes any change in your data 
that was the result of modifications Dynasoft might have done following a request for support. Finally, ensure that 
regular off-server backups are done of all your data. 
 
Please do not send us any sensitive information contained in your files such as customer credit card details, smtp 
details,… 
 
IMPORTANT: 
 
Things to look out for when installing TeleFactura: 

 Ensure you install all windows updates, service packs and hot fixes for your system before running this programme 
 TeleFactura requires .Net Framework 4.7.2 or more recent 
 Make sure no viruses or spyware are present on your network and PCs 
 For users of Windows Vista/Server 2003 or more recent, it might be necessary to install ‘ActiveX Installer Service’ 
 Check your security settings and turn off ‘Data Execution Prevention’ (DEP) for your programme during the installation 

process if needed or add TeleFactura to the allowed programmes in DEP 
 Unless you know how to configure Windows user accounts, configure your system so that your programme runs with 

elevated administrator privileges. It is possible to run TeleFactura under a standard Windows account and make it 
impersonate the system’s administrator by going to the log in screen and setting the administrator’s details under ‘Win 
admin’ 

 Disable ‘User Account Control’ if required 
 TeleFactura reads and writes data in ‘Drive:\Program Data\Dynasoft’ (Windows Vista or more recent) or ‘Drive:\Documents 

and Settings\All Users\Dynasoft’ (Windows XP/2003 or older). Make sure this folder has read/write privileges although this 
should not be a problem if running the programme under a normal administrator Windows account 

 To run the programme, right-click the TeleFactura.exe shortcut on your desktop and select ‘Run as administrator’ 
 
We recommend reading the programme’s user guide first before reading this manual. The guide is available in the programme’s 
work area after it loads. 
 
More information on TeleFactura: http://www.dynasoft.net/telefactura-telecoms-billing 
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1. How To Perform An Upgrade 
 
Dynasoft TeleFactura keeps the data it uses in two places: the database (MS Access, MS SQL Server or MySQL) and some xml files 
on the local machine. 
 
Steps to follow: 
 
Simply run the TeleFactura installer and follow the instructions given on screen. Here are the options made available by the installer 
depending on the version installed: 
 

 An older version is installed: the installer makes it possible to perform an upgrade or un-install the version on the 
computer. 

 A newer version is already installed: the installer makes it possible to downgrade the installation or un-install the version on 
the computer. 

 The current version is already installed: the installer makes it possible to re-install the current version or un-install the 
version on the computer. 

 
Always perform a backup of your data before running version upgrades of the programme. 
 
If a back-up has to be restored, ensure the previous data is completely deleted or at least ensure the restore overwrites this old data 
completely. 
 

2. First Start-up 
 
In order to get up-and-running quickly with Dynasoft TeleFactura and create your first invoice based on these pre-defined settings, 
simply follow the following steps: 
 
1. Double click the ‘Dynasoft TeleFactura’ icon on your Windows desktop. 
 
2. ‘Programme Access’ screen: Follow these steps: 
 
- Enter your email address and telephone number in the boxes on the bottom left-hand side of the screen; 
- Enter a username, password in ‘1. Identifications’; 
- Select the language of your choice; 
- In ‘2. Database’, the programme already selects by default the following settings:  

- MS Access tab, 
- ‘Activate MS Access’, 
- ‘Activate default path’, 

- Click OK. 
 
If you have the full-working version of the programme and are accessing the programme’s data remotely onto a network resource, 
specify the path to the Access file, then click ‘Activate other path’ under ‘Other path’ for MS Access. For MySQL and MS SQL Server, 
the database scripts located in ‘Program Files > Dynasoft > TeleFactura > Assets > System > MYSQL or MS SQL Server’ have to be 
installed first after the database system is correctly installed. Once these scripts have been installed, enter the required connection 
information in the tab of the database system you wish to use. 
 



 

 
 

3. How to Use the Programme 
 

3.1. Identification 
 

 
 
Access: On first start-up 
 
This manual deals with Dynasoft TeleFactura and its support for Microsoft Access, MySQL and Microsoft SQL server. 
 
All system and data files and directories used by Dynasoft TeleFactura have to be located in folders accessible from the programme. 
As stated previously, the programme uses only two locations to store all of its data: some xml files (Program Data > Dynasoft > 
TeleFactura > Assets > System > TeleFacturaXML001.xml and TeleFacturaXML002.xml) and a database. 
 
U1. Identification 
 
User: Enter the login details needed to gain access to the programme. Also, select the programme language. If you defined the user 
name and password to use when you created a DSN in Windows, there is no need to enter these again here. Just enter the 
connection string for the DSN. 
Windows admin: This tab is provided so the programme can be run under a non-administrator Windows account. The programme 
will impersonate the main administrator account so it can run properly when using it under an account that has fewer access rights. 
Note only the programme will gain these additional rights and not the user accessing it. 
 
U2. Database 
 
Select if the porgramme’s default data has to be imported into the programme. This data are customer, distributor and supplier 
accounts, as well as some CDR files, packages, subscriptions and price lists that all can be used to familiarise the user with using the 
programme. 
 
1. For MS Access 
 
The database is a file, called TeleFacturaDB.mdb. The database file is accessed locally or remotely depending on the way the 
programme accesses the data as set on the screen above. 



 

 
Clicking the ‘Activate default path’ option makes the programme use the local (default) location for the data on the machine where 
the programme is installed. In this case, these locations are the directory ‘Program Data > Dynasoft > TeleFactura > Assets > 
System > MS Access’ for the database. 
 
You may use the programme on a network by clicking ‘Activate other path’ on the screen above. For this, simply identify the path to 
the database where the database file is located (Paste it or locate the directory using the button with the ellipsis). UNC or fully 
defined paths can be used here. The programme will look for the database file it needs on the remote machine. 
 
Also, if the programme isn’t running under a Windows administrator or power user account, the network (for a domain) or the PCs 
(for a workgroup) administrator login name and password and the domain and workgroup themselves have to be specified under 
‘Win admin’. This is so the programme receives the necessary rights. 
 
Finally write a valid email address and phone number to register the programme at the bottom under ‘Programme activation’. 
 
A back up of the database is performed every time the programme opens. The file, called “TeleFacturaDB_Bckp.mdb”, is saved in 
“Program Data > Dynasoft > TeleFactura > Assets > Temp”. The feature for remote access is not available with Windows 95, 98 or 
ME. 
 
2. For MYSQL 
 
Specify the connection string to the database. An example would be ‘Provider=MSDASQL.1;Persist Security Info=True;Data 
Source=TeleFacturaDB_MySQL_DSN’ where TeleFacturaDB_MySQL_DSN is a Data Source Name. 
 
The scripts to create the tables and views of the database are located in ‘Program Files > Dynasoft > TeleFactura > Assets > System 
> MYSQL’. Install the file called ‘TeleFacturaDB_DBInstallScript.sql’. 
 
3. For MS SQL Server 
 
Specify the connection string to the database. An example, through ODBC, would be ‘Provider=MSDASQL.1;Persist Security 
Info=True;Data Source=TeleFacturaDB_MSSQL_DSN’ where TeleFacturaDB_MSSQL_DSN is a Data Source Name. Example if an SQL 
user has to be specified: ‘Provider=MSDASQL.1;Persist Security Info=True;Data Source= TeleFacturaDB_MSSQL_DSN;Initial 
Catalog=TeleFacturaDB;User ID=MyUser;Password=MyPassword;’. 
 
The scripts to create the tables and views of the database are located in ‘Program Files > Dynasoft > TeleFactura > Assets > System 
> MS SQL Server’. Install the file called ‘TeleFacturaDB_DBInstallScript.sql’. 
 
Connecting through OLEDB is generally considered better than through ODBC so we recommend writing a connection string that 
makes use of OLEDB. 
 
Click on the log button to see more information about errors when trying to connect to the database and/or remote machine. 
 
If an SQL user is used to connect to the database, it is important to specify its database user name and password in the 
Configuration screen > Option 4.C.9. 
 
TeleFactura uses a table in the database called ProgrammeLogs to store all events associated with the use of the programme. This is 
where error messages are stored when doing the following: billing, sending email messages, retrieving CDR files, backing up data, 
logging into the programme and replicating the database with the Web Access.  This is how the fields in the table are used and what 
they store if the fields are not empty: 
 
‘Billing’ log: 
Voice calls: 
FileLineReference1 contains the originating number or the customer number 
FileLineReference2 contains the number called 
FileLineReference3 contains the customer price list name 
Data and Service items: 
FileLineReference1 contains the SN or the customer number 
FileLineReference2 contains the service description code 
FileLineReference3 contains the customer price list name 
 
‘Messaging’ log: 
FileLineReference1 contains the customer number 
 
‘SysUsers’ log: 
FileLineReference1 contains the user index 
FileLineReference2 contains the user name 
 
‘Logon’ log: 
FileLineReference1 contains a TeleFactura reference code 
FileLineReference2 contains the Windows version 
FileLineReference3 contains the TeleFactura version 
 
‘Backup’ log: 
N/A 
 
‘Replication’ log: 
N/A 



 

 
‘Retrieval’ log: 
N/A 
 
‘Payment’ log: 
N/A 
 
Explanation of what some of the fields mean in the log files: 
 
EntryCaption1, EntryCaption2, EntryCaption3: Fields for the error messages. 
FileLineNumber: Line number where error occurred in a file (CDR,…), if relevant. 
FileLineDateTime: The field for date and time taken from a file (CDR,…), where available. 
FileLineReference1, FileLineReference2, FileLineReference3: Additional information provided for certain logs (e.g., originating number 
in a voice/data CDR in a billing log,…). 
ProgrammeErrorNumber, ProgrammeErrorDescription: Run-time error given out by TeleFactura, where available. 
 
When clicking a ‘View log’ button, if an empty notepad file gets opened, then it probably means there are too many lines in the 
underlying table for Windows to display all the lines. Delete some lines in the database or via the programme’s screens and try 
again. 
 

3.2. Main Interface 
 

 
 
Access: On first start-up after identifying the network details 
 
The eight main menu items in the programme and their individual sub-items are the following ones: 
 

 Home: 
o Dashboard: perform regular tasks and access an extensive set of financial and business data 
o Customers, Distributors and suppliers: Manage all business contacts from these three screens. 
o Billing: This is where all billing tasks are performed. 

 Data: 
o Price lists: Add, import and delete all price lists from this screen. 
o Price list details: Access the content of the price lists for all your services. 
o Invoices: Access all of your customers’ invoices. 
o CDR data: View and manage all rated CDR data. 

 Tools: 
o Browser: Web browser to navigate the Internet or your network. Certain URL’s can be pre-programmed for each 

user and appear in the browser’s address bar by going to the Users menu in System. 
o FTP: Download CDRs and other files directly into your programme using this powerful FTP client already built-into 

TeleFactura. 
o Messaging: Configure the programme to send all your customer’s invoices automatically to them once these have 

been created. 
o SQL Builder: Powerful SQL-based utility to export data from the system. 
o Import data: Import all the data the system needs using an easy-to-use import utility. 
o Mediation: Convert non-standard files (XML, binary,…) in files separated by a delimiter and in rows and columns. 
o Retrieval of CDR files via FTP: Automatic or manual retrieval of CDR files and unzipping of all files if required. 
o Provisioning: Manage the provisioning of customer accounts with your suppliers and distributors. 
o Financial reports: Three hundred reports giving full and precise control over all your business’s activity. 
o LCR: Build Least Cost Routing lists using the voice price lists in your system. 
o Web Access replication: Update the MS Access database on your Web server with the latest file (MS Access only). 
o Back up: TeleFactura will either manually or automatically back-up your registry and database data to an ftp 

location or to disk and even compress all files (MS Access only). 
 Assets: 

o DDI/SIMs: Management of all the DDI/SIMs that can be allocated to the customers. 
o Inventory: Management of all the stocks items within your organisation. 



 

o Packages: Voice/data bundles that can be allocated to customers. 
o Subscriptions: Recurrent charges, products and services that can be allocated to customers. 

 Settings: 
o Configuration: This is where all the configuration elements of your programme are set, such as the times when 

peak and week-end rates start, payment methods, VAT, currency used, programme language, call types, options 
for your distributors and your customer’s invoices and subscriptions that have to be billed for your customers. 

o Master price lists: Display of your price list master table. 
o Provisioning: Configuration of the provisioning of customer accounts with your suppliers and distributors. 
o Billing files: Configure the European payment standard ‘SEPA’. 
o Customer groups: Set up customer groups so these can be linked directly to distinct price lists and packages. 
o Accounting: Settings for Sage Accounts or Xero (Accounts versions only). 
o Payment gateways: Settings for your online payment accounts (Sage Pay, Paypal,…) (Pay versions only). 

 System: 
o User accounts: Add, modify or delete the users that are authorised to access the programme and define their 

access rights. 
o Reset certain aspects of the programme: the locking of records, rebuild the service numbers (SNs) and finally the 

association between the customers’ subscriptions and their SNs. These resets can also be done via the 
configuration screen, under points ‘7.A.3’, ‘7.A.4’ and ‘7.A.6’ respectively. 

 Tasks: 
o Access to key directories where your files are located: invoices, price lists, voice/data and recurrent services CDRs. 

 Help: 
o Manual: Access this manual directly via your main interface. 
o Guide: Access to the online guide of the programme. 
o About…: Copyright information about Dynasoft TeleFactura, link to our Website to purchase the product and link to 

the latest news about your programme. If you are connected to the Internet, TeleFactura will send a copy of all 
your data to our servers as backup. This is useful if you forgot to perform a backup and have lost all your data. We 
can then send you a copy back. You can disable this feature from this screen (MS Access only). 

 
All the important files used by your programme are located by default in the directory ‘Program Files > Dynasoft > TeleFactura > 
Assets > System’ and ‘Program Data > Dynasoft > TeleFactura > Assets > System’. This includes the MS Access database, which 
can be accessed, provided you have MS Office installed, simply by double-clicking the icon TeleFacturaDB.mdb. No password is 
needed. Log files (e.g., BillingLog.txt, etc.,...) are also located in this folder. 
 
Shortcuts to sub-menus via de menu bar on the left-hand side: You may also access each of the main sub-menus by clicking in the 
corresponding area in this bar. Click in the ‘File’ menu on ‘Minimise to system tray’ minimises the programme to the system tray. 
Right click over the TeleFactura icon in the system tray to restore the main window. Use the ‘File’ menu to exit the programme 
completely or click on the X at the top right-hand side corner of the main interface. In the status bar, one can keep track of the 
status of the tasks of the Tools menu if these have been activated. A green LED means the task is underway. A red one means it is 
idle. 
 
When entering your own data into TeleFactura, start by first entering your price lists (see chapter 3.5.1), then your CDR formats 
(see chapter 3.4.2.3) and finally your customers (see chapter 3.4.2.1). 
 

3.3. Settings 
 
3.3.1. Programme configuration 
 

 
 
Access: Main interface > Settings > Configuration > First tab 
 
Main Configuration 
 
Many of the parameters in the configuration screen also exist in the contacts’ screens. If nothing is modified there, then the 
programme will use the global settings defined in the configuration. Settings in the contacts’ screens that override those of the 
configuration are marked with two stars (**). 
 



 

1. Identification 
 
Identify your company’s details. Specify how fiscal or company id’s are called in your country where requested. Add, remove and 
select what are your payment methods for the customers. If no payment method is specified for each customer, the default method 
identified here will appear on the customer invoice. The currency you work with. This will be used throughout the system and will 
appear on the invoices. Your preferred language for the programme. 
 

 
 
Access: Main interface > Settings > Configuration > 2-9 tabs 
 
2. A. Numbering options 
 

1. Here, write in the numbering system that will used to keep track of invoice numbers. They will increment automatically as 
long as you specify a digit as the last character at least. By default the system uses ‘INV_0’, but any other system can be 
specified. 

2. Write in the numbering system that will used to keep track of order numbers. 
3. Write in the numbering system that will used to keep track of customer numbers. 
4. Write in the numbering system that will used to keep track of distributor numbers. 
5. Write in the numbering system that will used to keep track of supplier numbers. 

 
2. B. Radius AAA 
 

1. Set the directory where the TekRadius command line executable is located. 
2. Connection string to the Radius Manager database. 

 
2.C. System folders 
 

1. Add the different directories where invoices are saved as you create them. Invoices are saved using the following file-
naming convention: customer number, hyphen, invoice number, hyphen and the day’s date. For instance: 5-INV_1-
01_01_2020.pdf, means this is an invoice for customer number 5, invoice number ‘INV_1’ and date 1st January 2020. 

2. CDRs are organised in a tree structure with the paths that have to be specified here are located at the top of this hierarchy. 
These root directories are where the directories for the different CDRs are located that were created in the suppliers’ 
screen. For instance there is a default CDR format called ‘DynasoftVoiceCDR’ created for the default supplier. If you go to 
‘Program Data > Dynasoft > TeleFactura > Assets > CDRs > VoiceData > DynasoftVoiceCDR’, you will see a CDR file. The 
root directory for voice/data CDRs is then ‘Program Data > Dynasoft > TeleFactura > Assets > CDRs > VoiceData’, i.e. the 
folder where the programme expects CDR folders for voice to reside in and which is situated immediately above the 
‘DynasoftVoiceCDR’ folder. 

 
3.A. Information types 
 

1. Specify the types of customers that exist. Each customer needs to be associated with a type when they are created. 
2. Enter the various types of credit cards available where you are. 
3. Write the different types of suppliers that exist. These are shown in the suppliers’ account screen. 
4. Write the different types of transactions that exist. These are shown in the customers’ finance screen. 
5. Dynasoft TeleFactura uses three levels or types of distributors. Each distributor has to belong to a certain level. These are 

identified here. 
 
3.B. Product categories 
 
The programme uses product categories to organise the various products and services sold to customers (voice services, recurrent 
services, packages, subscriptions,…). With these text boxes and where they are used (the packages and subscriptions screens), it’s 
possible to organise everything that is sold to your customers the way you want with the names you want. The programme then 
uses these names to display totals for each category in the customers’ invoices. For example, by default the programme calls 
packages ‘Packages’. This is the name that will appear in the invoices to group together all the packages. With the boxes given here, 
you may use any other name. The main sections in an invoice’s summary are grouped together based on this product category by 
default. 



 

 
3.C. Rating 
 

1. This option makes it possible to round the total of a customer invoice. Write a number to which the programme will round 
an invoice total. For example, if an invoice comes to 345.23 and one has written a value for the number of 0.30, then the 
new total will 345.30. 

2. To avoid printing pages and pages of invoice itemisation with too many calls with too small a value, specify a minimum 
value below which they will be ignored. 

3. How decimal monetary values are rounded up or down or as a 4 decimal number. 
4. When importing price lists as per chapter 3.5.1, you may create your own cost items above and beyond those that 

TeleFactura offers by default. For voice services only, simply click on the cost items you created here to include them in all 
calculations of your customers’ invoices. You may send us an email if you fail to see how a particular field you added in 
might fit within the computation of your customer’s call costs: support@dynasoft.net. 

 
4.A. Files to include in invoices 
 

The program is compatible with JPG, 256-colour BMP, monochrome BMP, 16-colour BMP, 24-bit BMP and GIF image formats. 
 
1. The logo to be displayed on the customers’ invoices. Logo sizes in mm (W*H) are as follows: 

a. Classic: 466 * 550 
b. Contemporary: 571 * 169 
c. Elegant: 1016 * 381 
d. Professional: 423 * 349 
e. Streamlined: 423 * 307 
f. Modern: 423 * 291 
g. AvantGarde: 1037 * 190 
h. Standard: 910 * 296 
i. Elite: 825 * 360 
j. Traditional: 825 * 296 
k. Vanguard: 825 * 360 
l. Mainstream: 825 * 360 

2. You may identify a picture file for your customers’ payment slips. This file will appear on your customer’s invoices along 
with basic information about the invoice such as the due date, payment method,… 

3. It is possible to show on the customers’ invoices a covering page with a picture that uses all the space of the page. This can 
be used to show announcements or adverts. Specify the path and name to the picture file here. The picture will use the 
entire space of an A4 sheet of paper, so dimensions can be, say 2 cm shorter lenght-wise and width-wise than an A4 sheet. 

4. A picture can be shown on the customer invoices. Specify the path to it here. Dimensions in mm (L*H): 47 * 18. The image 
appears at the bottom right of the summary part, normally on the second page. 

 
4.B. System options 
 

1. Identify the employees or commercial representatives that exist in your organisation. 
2. Write and save the different separators that are normally used in price lists, CDRs, etc.… 
3. TeleFactura requires knowing if a connection to the database is done via a specific database user. Specify its user name and 

password here. 
4. Proxy server through which you access the Internet. 
5. Click and select the printer that will be used to send all invoices for printing. 
6. Specify the home page of the Web browser integrated with TeleFactura, under Tools. 
7. Path of the TeleFactura Web Access on your Web site. 
8. Path of the TeleFactura CRM login page on your Web site. 
9. Select the columns that should appear on the contacts screen: customers, distributors and suppliers. 

 
4.C. Accounting 
 

1. In each individual customer’s screen, it is possible to export the transactions data (invoices, payments…) into a csv file for 
later importing into an accounting package. MYOB is already supported. Don’t hesitate to let us know what other package 
you would want to see Dynasoft integrate. 

 
5.A. Design of the invoices 
 
Select the colour scheme to use for the lines and borders on your invoices along with the template to be used. You may view the 
template by double clicking on the jpg files. Specify the type of font to use on the invoices. It is also possible to define the template 
to use for each customer by going to each customer account. Click the following link to download examples of invoices: 
http://www.dynasoft.net/downloads/telefactura_progr/telefactura_invoice_templates.zip. 
 
Templates are Crystal Reports files located in Assets > System. See chapter 3.14, point A for more information. 
 
5.B. Display of the data in the invoices: 
 
An invoice is separated into two parts: the summary part and the itemised part. The options under this point are there to define how 
invoices will be built by default: namely, the document type (invoice or billing note), if the client’s statistics and graphs section 
should be indicated, if the payment slip should appear on customer bills, the cost centre summary section, if each section of the 
detailed part should appear in a separate file, the summary of costs that show the past and current amounts due , the summary of 
costs per line or SN, and finally the package summary. 
Identify how the summary of the calls in the bills will be consolidated, what part will be shown: the summary section, the itemised 
one, or both. Determine the file format of the invoices when the billing is done (see chapter 3.4.3): PDF, HTML, Excel, Word, CSV 
delimited by a tab or semicolon, ... 



 

Select the radio button that will set whether to show the money paid by customers (e.g., top-ups, prepayments…) in the summary 
parts or the money that corresponds to the use of goods and services available to and used by them. For the latter, the drop-down 
menus next determine how the summary and detailed sections that show the use of voice/data, recurring services and other items 
should be sorted. The main sections in an invoice’s summary are grouped together based on the product category by default. The 
sorting here is for sorting within each section in an invoice's summary part. 
 
The same settings under point ‘5.B.’ also appear in all the customers’ accounts and can be overridden there. If the programme does 
not find these settings under each customer account, the default values set here will be used. Additional settings relevant to invoices 
are given under point ‘8.A’. 
 
6.A. General billing options 
 

1. Billing cycle used in the programme: the programme uses this when it works out the alerts for the customers’ voice and 
data packages. 

2. TeleFactura uses the user’s today date on the invoices. However a different date can be used. Enter this date here. This 
date is typically there if an invoice for a particular customer has to be redone. If this is the case, another option in a 
customer’s account needs to be used in conjunction with this date field: option ‘g’ in the various options 4.B of a customer’s 
account. 

3. Specify how invoices are called in your configuration. Depending on your legal requirements, this can be typically ‘Tax 
invoice’, ‘Invoice’, ‘Bill’,…This name will be used as the main heading on invoices. 

4. Same as point ‘6.A.3’ but for billing notes. 
5. Enter the fee the customers will have to pay if they owe any money when an invoice is issued. The fee will be triggered if 

there are any unpaid invoices or billing note at the time an invoice is created. TeleFactura uses the date of any previously 
unpaid invoice and adds the number of days under the payment terms defined in the configuration. 

6. It is possible to create copies of the invoices that are created beyond simple originals. Indicate here the number of copies 
that should be created, if these should show the itemised part of the invoices or not and the numbering system that should 
be used and that will show on the invoice. 

7. Specify the date or day of current month when the next direct debit will occur for those customers who are subject to this 
kind of operation. This date will appear on the invoices of the relevant customers. An option (‘e’) under ‘Options 4’ inside 
the customers’ account, under ‘Various options’ has to be ticked. 

8. What is the number of calendar days when invoices are due. 
9. What is the number of calendar days for orders to be fulfilled. 
10. Customer referral system: Normal percentage rate granted to customers who obtain more customers for your company. If 

you change this figure later, only those customers that have this value as their current percentage will be updated. For 
customers who do not have any individual values, the commission rate that will apply to them will be this general value. For 
customers that do not have to have a commission rate, simply write 0 as being their current rate in their individual account. 
Each customer can individually be given a rate as explained per chapter 3.4.2 Commission rates apply to phone calls only. 

11. The program can increase the prices of all subscriptions and packages automatically. Specify the percentage increase and 
start date here. 

12. Write the text that will appear at the bottom of the invoices. Three boxes and one footer are provided; one could be for 
explaining things about the invoice, a 2nd one for advertising for example and the footer could have your company 
registration id. 

 
7.A. Housekeeping tasks and options 
 

1. An export can be done of all voice/data and recurrent services data. Select a lower date for the export. 
2. It is useful to regularly clean out any old voice/data and services data along with any old transactions not needed anymore 

so the programme does not run too slowly. 
3. Click the OK button to reset all the variables used to lock out users of some of the programmes screens when some of the 

programme’s resources are used (customers, distributors,…). 
4. A rebuild of the association between the customers’ SNs and their subscriptions and packages can be done here. This will 

link all of a customer’s subscriptions and packages with each one of their SNs. This has to be done with care, as all of a 
customer’s items and packages will be linked with all their SNs. 

5. Database table ProgrammeLogs can be periodically cleaned of all its entries by setting a number of days after which these 
will be deleted. 

6. If the program does not rate the customers’ SNs properly, click this option to rebuild the list of SNs in the database. 
Clicking this option is equivalent to opening a customer’s subscriptions screen, double-clicking an item and linking all its 
SNs with it. 

7. Under certain circumstances such as when an invoice is deleted from the customers’ transactions screen but not from the 
invoices screen, a mismatch can occur between these two screens. Click on this option to reconcile the two tables. 

 
7.B. Payment gateway 
 
The fields for a possible payment gateway are provided if you use an electronic payment system when receiving funds from your 
customers (e.g., Bpay, Worldpay, Paypal,…). Under this point, specify the name of the electronic payment system available to your 
customers. 
 
7.C. CRM 
 
Option a: Tick this option if you wish to enable users to add billing entries (Payments, invoices, top-ups,…) in customers’ accounts. 
 
8.A. Various options 
 

Tick the options under this heading as required. 
 



 

More information about the options available to the user in order to handle the way subscriptions are billed: The established 
billing model in the Telecom sector is to pro-rate excess usage for voice and data services in arrears for the previous period and bill 
the cost of this service one period in advance. If this is your billing model, use options ‘n’, ‘s’, ‘ad’ and ‘ak’. 

 
More information about option ‘r’: ticking this option will sort calls chronologically in packages and split calls that are at the 

threshold of a package into two parts: one part that belongs to the package and one part that falls outside of a package. Unticking 
will make the entire call fall within the package and sort from longest to shortest call. 

 
More information about option ‘ab’: This option cannot handle certain aspects of the subscriptions: It stops the programme 

from managing billing periods as scrupulously as is explained in chapter 3.4.2.1, it will not allow certain types of billing such as 
billing periods in advance, it will not ensure that periods already billed will no longer be billed and does not track minutes and money 
used by the user if pro-rated billing is selected. Finally it will not bill periods of an item or package that was for instance deactivated 
for a while and then activated again at a later stage (option ‘am’). This is because TeleFactura uses certain fields to keep track 
internally where the user was in terms of the last date billed for the subscriptions. Ticking the option will stop the programme from 
tracking these dates. So, for instance, advanced billing is not possible if option ‘ab’ is ticked as TeleFactura needs to know the dates 
it last billed. If a period is billed without this option and later the same period needs to be billed again, the items need to be reset as 
explained in chapter 3.4.2, point C. 

 
  More information about option ‘ae’: A payment through authorize.net is inserted automatically if the option to automatically 
insert a payment when creating invoices has been selected in the configuration. Option ‘e’ (Options 4 tab) under a customer account 
also needs to be selected. This only applies to users with the payment services add-on and if an account for authorize.net has been 
defined.’ 
 
  More information about option ‘ao’: Things like SMTP password and CC numbers are encrypted in the database if option ‘ao’ 
is selected. Some settings are then shown back to the user unencrypted like the SMTP password but others are kept encrypted on 
the user interface like the CC numbers. 
 
  More information about option ‘ay’: Tick this option if you wish to show on invoices all of possible free calls that fall within 
packages. 
 

Options that are relevant to voice part of packages are: q, r, s, y, ab, ak, am, aw, ay, ba, bc 
 
Options that are relevant to subscriptions are: n, ab, ad, am, aw, ba 
 
Options that are relevant to data part of packages are: ab, ak, ar (Radius), au, aw, ax, ba, bc 
 
Options that are relevant to recurrent services are: N/A 
 
Options that are relevant to what information is displayed on invoices are: a, b, c, d, e, f, g, i, k, o, p, t, u, v, w, x, aa, af, 
ag, ai, aq, as, at, av, bd 
 
Options that are relevant to the Accounting add-on are: ac, al, an, az 
 
Options that are relevant to Radius are: ar, az 

 
9.A. Inventory 
 
Enter here: 

- The different categories of assets 
- The locations where these assets are kept 
- The different statuses for these assets 

 
9.B. Sales taxes 
 
TeleFactura provides support for defining taxes for SNs and for up to 5 different percentage-based general sales taxes for you 
contact’s invoices. SN taxes can be defined as percentage or currency value. 
 
The general sales taxes can be over-ridden for each contact by going to their individual account screen and modify values there. 
 
Once created, the invoices will show a tax summary right after the invoice summary with a breakdown of all the taxes, their names 
and amounts. 
 
The programme supports sales taxes of up to 8 decimals values. 
 
9.C. Customer groups 
 
Customer groups are groups of customers to whom the carriers decides to give free calls or calls at reduced rates depending on 
whether calls are placed to other members of the same group. 
 
Link each group with a voice price list from this screen. Each group can include any number of customer sub-groups. 
 
It is important to pay attention to the fact that the call types you use in the customers’ underlying voice price lists need to be 
present in the price lists used here as the call types are what links an underlying voice price list with the price list you apply to a 
customer group. When TeleFactura comes across a call, it will extract the dialling code and look for a matching code in the 
customer’s underlying voice price list. However, instead of using the price in that list, it will use the call type it has found there and 
look up the correct price to use in the customer group’s price list. It will look to see first if the number called is a SN belonging to 
another customer within the same group. 



 

 
3.3.2. Call Settings 
 

 
 
Access: Main interface > Settings > Call settings (Voice services only) 
 
Call groups and call types are heavily used and are required throughout Dynasoft TeleFactura to: 
 

 Show and organise the summary part of the customers’ invoices so calls are grouped according to what groups of similar 
destinations were called: Domestic landline, domestic mobile, North America, Europe, etc; 

 For account reconciliation, to visualise profits made according to the groups of destinations that were called by customers. 
 
Most carriers around the world issue invoices and organise destinations in groups of destinations (e.g., Domestic, Western Europe, 
North America,…) or call types (e.g., national premium numbers together, national mobile numbers, etc…). Dynasoft TeleFactura 
requires that you identify in this tab call groups and call types and so makes use of the same widely used convention. 
 
Call types are sometimes called price groups, dial groups, dial classes etc. In the UK, Ofcom issues these for each type of number. 
More on this can be found at http://static.ofcom.org.uk/static/numbering/. TeleFactura includes them in the 
UKCallTypes_MonthYear.csv file located in the 'Assets > CallSettings' directory in the installation of your programme. The file will 
require regular updating from the information provided by Ofcom and your providers. 
 
Call types in this tab are useful also because they are used in parallel with the same tab in the supplier’s screens to give full control 
on how rates are billed across the day (peak-off-peak) and week (weekend rates) in your price lists. The tab in the configuration 
screen is a general one for settings that are valid across your set of suppliers and price lists. Call types in a supplier screen apply 
only to that supplier. 
 
These call types are also needed so your customer’s invoices can show the types of call that were made and how much was spent on 
each such type. See a screenshot for a typical invoice in chapter 3.4.3. 
 
Call groups are also used to organise the summary part of the invoices and organise the line items for voice services on the call 
group. 
  
Call categories are not used as heavily but are provided nevertheless to add another way of grouping similar call types at the 
database level. These call categories are not used when billing but the database table VoiceAutoCRCustomerInv will hold the 
categories identified here against each call type: each call in these tables will be associated with a call category. Call categories can 
be used if you have a need to integrate an application with TeleFactura and tap into the rated calls in the system. You can then sort 
calls in three ways: based on the type, the group and the category of a call. 
 
Here you are required to specify the call types that exist in your operators’ price lists. Give a type name for each of the call types on 
the screen. These types can be for instance GSM for national mobile calls, NTL for national landline, ITL for international, etc… A 
description field is required. It is this field of the description that will appear in the itemised part of the invoices rather than the call 
type field itself. Also, identify the dialling code that corresponds to the call type. This is used in case your price lists do not have such 
codes: the program will use the dialling codes identified in this screen that correspond to the call types in the price list. 
 
Important: 
 
The definition of these types is done here, but the use of them is done in each price list, so don’t forget to add these types in the 
corresponding column when you import and create your price lists in chapter 3.5.1.  
 
In the price lists and in order for the programme to use this functionality, it will be necessary to create a destination for the required 
price lists, where call types have to be identified in the columns CallType. 
 
It is possible not to write any peak and weekend times for a call type. This then means the call type is valid throughout the day and 
week. This rule holds true also for call types added via the suppliers’ individual screen. 
 
In 5, write the default call type that belongs to the default call group as identified in 2. 



 

 
In 6 and 7, specify the default code of the country and city/region you operate from. All national calls in price lists and CDRs will be 
assumed to have been made from this country code. 
 
In 8, identify the call group that includes the call types associated with local calls. This is used in order to apply a different pricing 
depending on whether a call is local or national. It is also necessary to identify destinations for local rates in the price lists and 
associate the appropriate call type for these destinations. An important consideration is that calls here are limited to ones to and 
from the same local dialling code. Another way of setting a different cost for local calls is through the use of packages. 
 
In the database for TeleFactura there exists a table called CustomersData. This is where most of the data for the programme’s 
configuration is kept. TeleFactura offers the ability to override all the parameters the user has selected via two fields in this table: 
FieldDataGlobal and UseDataGlobal. To set the parameters of the programme so that whatever the user selects is overridden, enter 
values of the parameters needed in FieldDataGlobal and set UseGlobalData to 1. Any other value in UseGlobalData  (e.g., Null or 0) 
will make TeleFactura use the values in FieldData. The user can still modify the configuration via the programme’s interface and if he 
does so, then these settings are kept in FieldData. However, TeleFactura will use the values in FieldDataGlobal instead if one sets 
UseGlobalData against the parameters needed to 1. FieldDataGlobal and UseGlobalData can only be modified from the db. This is 
useful if the administrator wants to make sure certain parameters are used through the various installations of TeleFactura on his 
network. 
 
3.3.3. Master Lists 
 

 
 
Access: Main interface > Settings > Master lists 
 
Master Price Lists 
 
This master lists screen is used when voice price lists that do not show the country codes, the destination or call type are imported 
from the price lists screen. When importing such a list, the programme will try to fill in the missing data by doing a match of the 
data that is present in the list being imported with the same data in the master list. For example if the code for Spain is not present 
in a list that is being imported and the user has selected a master list that indicates that code, the programme will add this code in 
the dialling code of the list being imported. 
 
Master lists are useful in the context of a market such as in the United Kingdom, where suppliers only make available to their 
operators lists with acronyms representing a destination and not dialling codes. 
 
Example of a list provided to an operator by a supplier: 
 
Call type; peak rate; set-up peak; 
SGB-B4;0.02;0.05; 
FAM;0.03;0.08; 
SGB-PN2;0.04;0.10; 
 
Example of a Master list to be imported into the system for these 3 destinations: 
 
DiallingCode;CallType; Country 
300;SGB-B4;UK Wide 03; 
374;FAM;Armenia; 
7002;SGB-PN2; Personal Number; 
 
The programme will add the missing dialling codes in the first list. 
 
It is also necessary to import any existing call types from the configuration screen or a supplier account ('Call settings' tab). 
To import a new list, give it a name and click on ‘Import’. To view or delete a list from the system, go to the second drop-down box, 
select it and click OK. 
 
All lines in this screen can be deleted, new ones added or existing ones modified simply by going directly to the cells needed in the 
table.  
 



 

To ensure the latest codes are always used, check these web pages periodically: 
 
http://www.itu.int/home/index.html 
http://www.itu.int/ITU-T/dbase/index.html 
http://www.itu.int/opb/publications.aspx?parent=T-SP&view=T-SP2 
For the UK: http://static.ofcom.org.uk/static/numbering/ 
 
Use the last column to add the call types. This will be used in the Price List in Details screen to help you populate the price lists with 
call types at the touch of a button without having to add these types manually. 
 
3.3.4. Provisioning 
 

 
 
Access: Main interface > Settings > Provisioning 
 
Configuration of Provisioning 
 
This section requires bespoke software development by Dynasoft. 
 
Enter the configuration details for Type I provisioning. 
 
3.3.5. Payment Gateways 
 

 
 
Access: Main interface > Settings > Payment gateways 
 
(Payment add-on only) 
 
Authorize.net 
 
Write the account ID obtained from authorize.net in the first box, the transaction key and the live URL where transactions will be 
posted. 
 
3.3.6. Billing files 
 



 

 
 
Access: Main interface > Settings > Billing files 
 

1. Standard 
 
Enter a valid path where the standard billing file will be saved. 
 

2. Advanced 
 
Enter the following information: 
 

 In 1, select the default TeleFactura columns and add them using the button with the right arrow. You may specify a 
different name for the column than the default names given. Advice: make a note of the original names of the renamed 
TeleFactura columns. 

 Enter an ad hoc user-defined column in 2. Enter a column name and value. Add the column to the file fields using the same 
arrow button. 

 In 3, view the file fields selected and identified. Use the left arrow button to remove fields and up and down buttons to 
change the order of the columns. Reset all identified fields back using the reset button. Point 3a enables you to identify 
values to look for in the default fields (see point 1 above) and replacement values. Click the double arrow button for more 
options. It is possible to combine an option '*TEXT*' and '*BLANK*' at the same time. This will mean that the programme 
will replace any text found with the '*TEXT*' option and if no text is found (empty fields), the text of the '*BLANK*' option 
will be used. 

 In 4, identify the path where to store the file. 
 In 5, identify the extension of the file (csv, txt,…) 
 In 6, specify the format of all date fields that has to be used. 

 
3. SEPA 

 
Enter the parameters required for the creation of SEPA files. The invoice number and date will replace the tags ‘<InvoiceNumber>‘ 
and ‘<InvoiceDate>‘ respectively. Other parameters need to be defined inside the customers’ accounts (bottom of Options 1 tab). 
 
Select option ‘f’ in the billing options screen in order for the programme to save the file during a billing session. Only customers who 
pay by Direct Debit (option ‘e’ under point 4.B in customer accounts) will appear on the SEPA file. 
 
The SEPA XML tag <MndtId> will hold the customer’s Sales tax number and the second tag<AdrLine> their post code. 
 

3.4. Home 
 
3.4.1 Dashboard 
 



 

 
 
Access: Main interface > Home > Dashboard 
 
Access 25 pieces of vital statistics about how your business is faring: from your turnover and profit over the previous 3 months to a 
list of best and least performing customers and distributors. Under the frame “Tasks”, access daily tasks such as: open a customer 
or distributor account, an invoice or price list,… 
 
3.4.2. Customers, Distributors and Suppliers 
 

 
 
Access: Main interface > Home > Customers, distributors or suppliers 
  
To view a customer, distributor or supplier, simply click twice on a line. You may also access these contacts via the ‘Relationships’ 
tab, which displays all customers and the relationships they have with their referral, distributors and suppliers. Click on Insert new 
or Delete selection to add or remove an existing contact. Click on Archive contacts to remove contacts from the list but not from the 
underlying database. These will be merely archived. Click on Restore contacts to retrieve these contacts. 
 
Switching between contacts tab makes the controls at the bottom of the screen apply to customers, distributors or suppliers 
depending on the tab you are viewing. 
 
Click the button in A to access and manage all of the customers’ CDR data or invoices: delete them, delete all data associated with 
them in the system and send them to the customers by email. The screen here lists the physical files that were created as opposed 
to just the invoice number, which is what the customers’ transactions screen outlines. See the chapter about customers below. 
Right-click over an invoice to mark it as paid and add this payment in the customer’s transactions screen, accessible by double-
clicking a customer here. For the Pay versions of TeleFactura, a drop-down box appears near the middle of the screen that makes it 
possible to process through various payment gateways such as Paypal, Authorize.net,... 
 
In B, the OK button at the far right is used to reset the subscriptions and packages of the selected customers in the main table. 
TeleFactura uses a couple of date fields in the database to keep track of the last time subscriptions were billed and when they should 
show next in the customers’ invoices. The controls given here help the user manage these fields by enabling him/her to reset the 
next date when the items should show. There exist three possible ways to reset these items as indicated in the drop-down box to 
the left of the OK button: 
 

 Reset the items to the date selected in the date field on the left 

A 
D C E 

B 



 

 Reset the items back to their activation dates 
 Reset the items to the date of the last known invoice 

 
It’s also possible to reset each individual item separately to their activation date by opening a customer account, go to the 
subscriptions screen, select a subscriptions and select ‘Reset dates only’. If a customer is clicked on the main contacts screen, it is 
possible to see left of the date field what the last billed date for the customer’s subscriptions was. If resetting the items to a date 
using the date field to the left, the date needs to be the date of the first day of the billing period sought. So if the date sought for the 
first day of the next billing period is, say, May 1st, the date selected here needs to be May 1st. This resetting of dates is not needed if 
the option ‘ab’ is selected in the configuration screen, point ‘8.A’. 
 
In C, you may do a search for terms in any of the fields of the contacts (click on the correct tab first) simply by typing search terms 
and clicking ‘Search’. Another tick box makes it possible to search a SN and highlight its owner in the main customers table. 
 
In the next set of controls (D), it is possible to list customers that belong to a specific distributor. By clicking on the distributor tab, 
this menu changes and displays the three levels of distributors so contacts belonging to each level can be displayed. By clicking on 
the suppliers tab, it is possible to reduce the list of suppliers displayed to the ones that are linked to a specific customer. The drop-
down menu at the bottom is used to export the financial data associated with customers in a specific format as supported in the drop 
down-menu. 
 
In the last set of controls at bottom of screen (D), reports can be created and a search for contacts can be done using a number of 
criteria’s. For example, the first item (‘Display sums owed…’) in the drop-down menu shows in a report the sums of money that are 
owed to you by your customers, the money payable to your distributors or suppliers. Simply specify a start and end date and press 
OK to display the report as per the screenshot below. In the case of the customers tab, the customers that are relevant to this 
report are then shown in the main table. Click on ‘Show all’ to list all your customers again. The list in the report will be grouped 
according to customer referrals and will be separated by a line. The same thing can be done for distributors and suppliers. Press 
export in the report to export the results in a file. 
 
Three types of distributors can be used with Dynasoft TeleFactura: 

 Distributors are customers of your company’s and so use your company’s services: Create an entry for the distributor in the 
customers screen and enter the distributor’s SNs and that of his customers as if he was a normal customer; 

 Distributors do not use your company’s services: Use the distributors screen and issue them with a credit note; 
 Distributors are customers of your company’s and so use your company’s services, but both him/her and his customers 

have to be billed separately: Enter the distributor and his customers separately as normal customers and associate each 
customer with the distributor using the sponsorship scheme provided with Dynasoft TeleFactura. 

 
In all three cases, remember to tick the box ‘Make the session an official one and save all its data’ in the Billing Options screen to let 
the programme work out any commissions payable to your customers and distributors. 
 
 

 
 
3.4.2.1. Customer Details 
 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > First and second 
tab 
 
Customer details 
 
Fill in the form with the customer’s details. Access additional screens to enter the customer’s bank and credit card details via the 
drop-down box at bottom right hand corner. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > 3-6 tabs 
 
Options 1, 2, 3 & 4 
 
1.A. Customer associations 
 

1. Who obtained this customer? Give the name of the distributor by selecting it from the drop-down menu. 
2. Select the commercial representative that created this customer. 
3. Identify the customer group and sub-group to which the customer belongs. 
4. Add the different departments and/or branches associated with the customer. It is then possible to link each SN in the SN 

screen with a department/branch. 
 
1.B. SEPA 
 

1. The SEPA parameters for the customer. The direct debit sequence takes the value ‘FRST’ with the first invoice and then 
takes the value ‘RCUR’ with subsequent invoices. This sequence goes back to ‘FRST’ if the customer’s unique mandate 
reference code (‘<MndtId>‘) changes. 

 
1.C. Design of the invoices 
 
Select and design the invoice template to associate with this customer. 
 
1.D. Folders and data 
 

1. Local path to the customer’s invoices as they are located on your Web server. Omit the name of the files here. This path is 
required to enable your customers to download their invoices via the TeleFactura Web Access. 



 

2. Local path to the customer’s price lists, as they are located on your Web server. Omit the name of the files here. This path 
is required to enable your customers to download their price lists via the TeleFactura Web Access. 

 
2.A. Customer parameters 
 

1. Enter the user’s user name and password for TeleFactura Web Access. Password length is limited to 50 characters for all 
passwords in TeleFactura. 

2. Set the status of this customer. This is just a placeholder for a status and is not used anywhere else in the programme. 
3. The next two boxes give to the user an idea of how many voice calls and minutes a customer is using at the moment. The 

option ‘ag’ in the configuration’s point ‘8.A’ has to be ticked first. This information is also shown on the customer’s invoices 
and the usage within packages is shown in the itemised part of the bills too (subscriptions and packages section). 

4. Language for this customer. This is the language that will be used for his/her invoices and when they access the Web 
Access. 

 
2.B. Display of the data in the invoices 
 
As was explained in the Configuration chapter 3.3.1, specify how the invoice (or billing note) will be saved, displayed or printed for 
this customer. If different formats are selected for the summary and itemised parts, then two files will be created. Only one file if 
formats are identical. 
 
3.A. General billing options 
 

1. Text to appear on the customer’s invoice or billing note. 
2. Payment method for this customer. See chapter 3.3.1, 1st Tab, for more information on how this works. 
3. Hide one or more of the columns that appear in the itemised part of the customers’ invoices. 
4. Do not display in the itemised part of invoices calls that are associated with the listed call types. This is useful if you wish to 

prevent certain calls from being shown on the customer’s invoice such as calls to adult lines, charities, social services lines, 
hide national calls to reduce the size of the itemised part of the invoices… 

5. Name and set the indirect sales taxes to apply to this customer’s account and invoices. 
6. Select the way numbers will be rounded throughout the programme for this customer. The way amounts are rounded by 

default is the one set in the configuration screen. 
7. Write how many days this customer has to pay their invoices. 
8. Default margin multiplier for the rating of CDR data. When the system is billing and rating CDR data, it can do so in a 

number of ways: using a price list or rate card, a margin multiplier which will be applied onto a purchase cost of the 
call,…Margin multipliers can be identified for a whole type of CDR or per customer. This default value under this point is the 
per customer figure. 

 
4.A. Customer referral and commissions 
 

1. If relevant, select the customers the current customer has referred. 
2. Who is referring this customer, i.e. which customer obtained this current customer whose file you are viewing? 
3. Select the types of commission the current customer will get. These can be: 

a. The percentage discount he will get in his next invoice based on the sum total of the monies payable by his 
referred customers. 

b. Customers can also get free periods for their subscriptions, inventory assets and packages if they have referred 
customers for the same items. Each quantity sold will get them a free period with a maximum of 12 free periods. 
The number of currently given free periods is reset to 0 if a billing period starts on the same day as an item’s 
activation date in the billing screen. More on this in chapter  

  
Notes: 
 
Any changes you make to the table of referred customers and to the drop-down menu holding the customer’s referrer will reflect on 
all other customers. For example, if a referred customer X is clicked in drop-down menu under point 2, it will be unchecked for all 
other customers in the system, as customers can feature as referred customer only once. If a referring customer Y is unchecked in 
table 1 and if you open his file, no referring customer will appear for him/her. 
 
4.B. Various options 
 
Tick the required options.  
 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Transactions 
 
This screen keeps track of all transactions and payments done by the customer and of all monies by him/her owed to you. From top 
to bottom: 
 

1. Select the type of transaction: a discount, a refund, a cancellation, a chargeback, a commission, a new invoice, a payment 
carried out by or to your customer, etc... Top-ups are typically money a customer says he will pay which will decrease the 
money owed by a customer. This is often used with prepaid accounts when the actual money has not been received yet 
from the customer, but a confirmation by fax has been received, for instance. Normally with prepaid accounts, the sums 
that appear on a customer’s invoice are the sums that were paid to reflect the use of top-ups. A billing note with the details 
of the calls made is then attached with the invoice. When running a billing session in chapter 3.4.3, the discount entries for 
this customer will be aggregated and deducted on the customer’s invoice for the period sought. If you select to use post-
paid accounts, you then would enter customer invoices and not top-ups. Customers will pay on receipt of their invoice. Top-
ups should be deleted when invoices are sent out to maintain consistency between the payments done by the customers 
and the invoices they receive. ‘Latest usage’ is the total amount of money owed since the last invoice and up to the very 
last CDR that was analysed in the billing screen. 

2. Write a reference number, such as an invoice number. 
3. Payment method that was used by the customer: bank, credit card, a popular online payment service,… 
4. Transaction date. 
5. Any notes or remarks about this transaction. 
6. If the transaction has been paid. 
7. Write the net amount of the transaction. 
8. Tax amount of the transaction set by the system. 
9. Press ‘Add’ after or select an item in the table and press ‘Modify’, ‘Delete’ or ‘Create document’ in order to create a 

document with the values entered here. Transactions have to be saved before a document can be created. Double-click a 
line to enter sub-items that correspond to the transaction entered. If the accounting add-on is installed, transactions and 
direct debits can be sent to or deleted from Sage Accounts or Xero. 

 
Right-click over an invoice or any item due by the contact to mark it as paid. 
 
The aggregated total of all transactions can be displayed in three ways: either for all the transactions, for invoices-type transactions 
or for all other transactions. Invoices-type transactions are the following: invoice, billing note, purchase order, credit note, credit 
advice and pro-forma invoice. 
 
Any money that increases a customer’s balance (e.g., credit notes,…) will show as a negative number. Sales taxes are applied to the 
following transaction types only: invoice, billing note, purchase order, credit note, credit advice and pro-forma invoice. The amount 
entered will show under the net amount column for all other transaction types. Documents and line items cannot be created for the 
following transaction types: computed usage, latest usage and commissions. 
 
When using the Billing part of the programme explained in chapter 3.4.3, if you click the option that says to include the invoice in 
the customer’s billing, the invoice will be added to the list in the table here for a particular customer. Positive amounts are monies 
owed by the customer to your company. These are normally invoices and charge-backs. When running a billing session for those 
customers that have referred other customers, any commissions they are entitled to will not show on this form, rather they will be 
deducted from the invoice and it is this reduced amount that will show here. If, on the other hand, some referred customers are 
invoiced, but not the referring customer, then the money owed as commission will show here. 
 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Finances 
 
This screen makes it possible to enter all sorts of other transactions or movements of money with the customer. The ones that 
appear in the first drop-down box above the main table are defined in the configuration. 
 
A credit limit can be set for a customer and is a transaction type given as standard. Credit limits are used in combination with credit 
limit alerts. See the messaging tool where the details about the sending out of alerts are set. A picture of the customer’s alerts 
screen is given below. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Customer alerts 
 
This screen makes it possible to set: 
 

- The parameters whenever a customer goes over their credit limit. This alert can be based on money or minutes allowed 
and are calculated for the current billing session (i.e. the data TeleFactura analyses if you have a billing session running 
at the moment), the amount since the last known invoice or the current month. Tick the last option if a copy of the 
alert message has to be sent to the customer as well. The alert is sent once only as soon as the customer goes over 
their limit. So the alert is not sent repeatedly but once only for the session currently under-way. Define the messaging 
parameters in the messaging tool. 

- The parameters whenever a customer goes over 90% of the number of minutes or calls associated with each package. 
- The parameters whenever a customer goes over 90% of the data allowance (bytes) associated with each data package. 

 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Friends and family numbers 
 
Enter numbers that are likely to be called by the customers that should be included in the customers’ packages. Here, whenever 
they call these numbers, TeleFactura will include them in the packages, in a similar way that numbers called of a particular call type 
are included in the packages screen. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Subscriptions and packages 
 
This screen lists the items other than voice/data and CDR-based services that can appear on a customer’s invoice. Items here can be 
of three sorts: Packages, subscriptions or inventory assets. The first ones refer to the rating packages that are identified in the 
Packages screen. Select Packages in the item type drop-down box and all available packages will then show in the Item name box 
underneath.  
 
Subscriptions are typically sales to the customer (e.g., phones, phone cards…). For these, select ‘Subscriptions’ and write the name 
of the item straight into the Item name box or select default subscriptions that were previously created in the configuration screen. 
Next, enter a description, how often it should run, a supplier and its reference. You would select activation and de-activation dates, 
meaning that an item will only start to be billed once the activation date has been reached in the billing screen. Setting a 
deactivation date will mean the item will not be billed after that date. Leave this field blank to mean ‘Never’, i.e. an item will never 
expire. Select the product category linked to the item. A distributor commission is entered next which is convenient as one does not 
have to go and set it in the distributor’s screen.  
 
There is a status box so these items can be tracked internally within your organisation. The statuses are there so each 
package/subscription can be marked with a status. This is useful if the progress of sales for instance needs to be traced and followed 
so that each product and service sold to a customer (i.e., each package/subscription) can to be tracked as it is being delivered to the 
customer until it is billed. For TeleFactura to bill an item, it needs to be marked as ‘Order Fulfilled’. There are reports that can be 
generated which give an idea of each item and where they are in the sales process. This is under the main contacts screen below: 
 



 

 
 
Explanation of the different statuses: 
 
Order Received: new order that just came through. 
Pending Configuration: could be a new server or piece of equipment needing to be configured with the customer. 
Pending Installation: could be a new server or piece of equipment needing to be installed with the customer. 
Pending Shipping: item ready to be shipped. 
Pending Activation: service waiting to be activated (DDI/SIM,...). 
Order Cancelled: order was cancelled by the customer and no longer is being billed. 
Order Closed: product or service that has run its course with the customer and that should no longer be billed. 
 
The status date box will always show the date of the latest status change. Write the purchase and sales prices and possible discount 
for the item. Inventory assets are also accessible from this screen and adding them to the customer follows the same pattern. 
 
If the tick box under the end date is ticked, the programme will propagate the same end date to all the other items in the list in the 
table. 
 
For POS commissions to the customer’s distributor, these are given whenever an item is entered or modified via this screen and is 
marked with ‘Order fulfilled’. Commissions are only given if a new item’s status is marked as such or if an existing item is given this 
status from a lower one. A value for the commission for any new item has to be entered here if the commission is of the POS type 
because this item will not show in the commission tab of the distributor’s account yet as it is a new item and it would not be possible 
to enter this value via that screen. 
 
Finally, tick the last tick box if a package is given away free during the first billing cycle. Note this giving away of free periods will 
only work if option ‘ab’ in the configuration’s point ‘8.A’ is unticked. Options ‘n’ and ‘s’ will also need to be ticked if pro-rating is 
required. 
 
Ticking or unticking the items is a shorthand way of letting the programme know whether to show the items on customer’s next 
invoice or not. 
 
When billing using the general configuration option 8.A, ‘ab’ unticked and billing option ‘Make the session an official one and save all 
its data’ (see chapter 3.4.6) ticked, packages, subscriptions and inventory assets entered in each customer’s ‘Subscriptions and 
packages’ screen  get billed once only even if you rerun the same period. The implication of this for call packages for instance is that 
calls (and the associated package itself) that were identified by the programme as being covered by a package will not be re-billed if 
the same period is selected twice in the billing screen. Packages and their recurrence are then scrupulously enforced. The 
programme uses anchor dates to keep track of when subsequent billing periods are due and will ensure that, if you run a billing 
session twice for certain dates, calls that were covered by a package will not be re-billed. In order to reset these anchor dates for 
the packages associated with your customers, simply go to each customer’s ‘Packages and subscriptions’ screen in their individual 
screen, then click on a package and click ‘Reset dates only’. The anchor dates will now be reset to the item’s activation date for your 
customer. 
 
In the database, these anchor dates are: 
 
LastBilledDate 
NextBillPeriod 
 
These are found in table AdditItems. 
 
An example to illustrate this is as follows: Customer A has a package that was activated on the 10th of May and that runs every 
month. In the Billing screen, dates are selected from May 1st to May 31st. The package will be billed for this customer from May10th 
to June 9th if no pro-rating is used. When the package is billed again for the month of June, the programme will then go through calls 
from June 1st to June 9th and assess whether these calls were part of the package of the previous month or if they need to be billed 
separately. This will not be done if the customer had already used up the allowance in calls that his package provided back in May. 
 
The same system exists for a customer’s subscriptions. This method is used only if the option in the configuration screen, point ‘8.A’, 
option ‘ab’ is unselected. If it is selected, TeleFactura will always reset the number of calls or minutes to the start date of the billing 
period selected in the billing screen and so it will not keep track of previous calls already billed for a particular period. 
 
If periods have to be pro-rated, options are available for this; both for subscriptions and packages in the configuration screen, point 
‘8.A’, options ‘n’ and ‘s’. If subscriptions need to be billed one month in advance following the first period after the activation date, 
select option ‘ad’ in the same table of options. In this scenario, if new items are entered in a customer’s account, the programme will 
show on the invoices entries for the first month (or day,…) plus one month in advance. The following month, only the advanced 
month will show. In terms of our anchor dates, they will be as follows: 
 
ActivationDate: 01/05/2020 
LastBilledDate: 31/05/2020 
NextBillPeriod: 30/06/2020 
 
The example here is for items that need to be billed in advanced for June having selected the dates for May on the UI. For packages, 
if the user billed on June 1st, this means the usage will be in arrears (month of May) and billing period is billed in advanced. 
 
You then select 01/05/2020 to 31/05/2020 in the automatic mode’s start and end dates where invoices are created. 
 



 

Normally, TeleFactura keeps track of these dates automatically from billing period to billing period. So for instance next month if 
01/06 to 30/06 are selected, the programme will bill the subscriptions for July and the calls for June. 
 
When adding a package or a subscription, it is possible to select the SNs that apply to this item by double-clicking a line once it has 
been added and selecting/deselecting the required SN(s). Note that if you decide to show the cost centre section in a customer’s 
invoice, only the first SN selected here will be shown in the SNs column in the cost centre’s section, against a particular package or 
item. 
 
If a system-wide subscription is modified from under the ‘Assets’ menu, the modifications will not affect the values that were set in 
the subscriptions screen under each customer’s screen where the item might have been added to him/her. If a subscription is linked 
to a customer’s account and the user wishes to modify it, it will have to be done from within each customer’s account. Once a 
subscription is added to a customer account, it becomes an item that is independent and specific to this customer. The same goes 
for inventory assets. Packages on the other hand can be modified in the Packages screen and the modifications there will modify the 
entry for this item that might have been made in a customer’s account. The fact that some controls in the packages/subscriptions 
screen above get greyed out reflects this. 
 
The prices entered have to be free of any sales tax. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Extended notes 
 
Screen that can be used to enter daily notes about the customer. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Customer invoices 
 
This screen displays invoices only whether they were created by saving them or by opening them on screen from the configuration 
screen. 
 
You may delete a customer’s invoices or send them via email to him/her (saved invoices only). It is necessary to configure the 
sending of invoices by email in the appropriate screen for this to work. This screen can also be reached from the ‘Data’ menu for all 
customers. 
 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Service numbers or SNs 
 
In TeleFactura, SNs are the customer’s phone numbers or account IDs. However, it is possible to define any series of character here: 
a Direct Dial-In (DDI), a Direct Inbound Dialing (DID), a Calling Line Identification (CLI), phone number, phone line, customer 
account ID, ANI number, IP address, PIN number, dial string, tariff class, NDI or anything that serves to identify a customer and 
their phone services. 
 
You may add phone numbers (no dots or slashes), IP addresses or any other series of characters as an SN. You may then link one or 
more sales or purchase price list(s) for the voice services with each SN, an activation or start date when this association comes into 
effect and a deactivation or an end date, a cancellation date (this date is just a place-holder for another end date value and is not 
used when billing). Link one or more voice/data CDR formats with this SN, one or more service CDR formats, a branch or 
department and finally a discount value. Click a line inside the table and press update to update any changes to an existing SN. 
Ticking a SN enables you to remember if this SN has been activated with your carrier or not via the Carrier Pre-Select (CPS) for 
instance. Ticking or unticking a SN will not affect the billing process, as all SN in this table will be available for billing. 
 
Write phone numbers by omitting any dialling code such as 00 or country code such as 44 (e.g. U.K.). If the full international 
number for one of your customer is, say, 00442071234567, write the root of that number likely to show in your CDRs as being the 
caller’s phone number (i.e., 2071234567 in this case). The root is the number but without any leading zeros or dialling code. Enter 
the national and regional dialling codes in their respective boxes on the interface. 
 
You may specify a range of numbers as a SN. For example, for 25557000 to 25557099 write R5557000-R5557099. For SNs to be 
ignored inside this range, follow it with the numbers separated by dashes and marked with an X. E.g. R5557000-R5557099-
X5557020-X5557021 would be a range of SNs where numbers 5557020 and 5557021 will be ignored. Duplicate entries for the SN 
are possible provided they each have different CDRs. Regular expressions can be used to manage the SN: In the DDI/SIM drop-
down menu, write the expression and tick the next box down. Example of regular expressions: (25551234), voip:.+"(25551234)", 
(25551234).* means the programme will pick up any SN that starts with 25551234,... The benefit of being able to work with regular 
expressions is that SN numbers are often “buried” in the CDR data and can be hard to extract. A regular expression will make it 
possible to extract the SN quickly and effectively. Ensure that the SN in the expression is enclosed in open “(“ and close “)” brackets 
as per examples above. More on regular expressions can be found here: http://www.regular-expressions.info and expressions can 
be tested here http://www.rubular.com. 
 
If a SN is associated with two or more price lists and that in these lists some destinations have the same dialling codes, the 
programme will always use rates from lowest to highest in the lists. 
 
It is possible not to enter an end date. This will be taken to mean that billing will never expire for a particular SN. The dates entered 
here will be compared with the dates found in the CDRs and not the actual date a billing run is made. So for instance if you enter 
that a price list for a SN is available from say 01 May 2020 to 31 May 2020, the programme will use this price list only for those calls 
that were made during that period. If you wish that all say April calls be billed using this price list, you will have to backdate a list’s 
validity to April of that year or to any date that precedes the date the 1st call of a billing period was made. 
 
It’s not necessary to link an SN with a price list if the CDR that was selected is rated using a sales price column in the CDR data, a 
purchase price column and margin multiplier, or if the CDR format is a data CDR only and contains no information about voice 
services. 
 
If the tick box under the end date is ticked, the programme will propagate the same end date to all the other SNs in the list in the 
table. 
 
It is possible to add several times the same SN provided each entry has a different start and end date, i.e. provided these periods 
stagger over time. The programme will, when running a billing session use the SN once only if the dates match the dates selected 
for the billing run. 
 



 

All numbers entered here for a particular customer will be billed when performing a billing session in chapter 3.4.3, if the dates 
identified here fit the dates selected in the Billing screen and if the CDR format identified here has corresponding CDR 
files/tables/web pages. 
 
You may associate SNs with country codes different to the code of the country of residence of the customer. 
 
You may also enter the word ‘ALL’ as a SN to associate an entire group of CDRs with a particular customer. This is useful to avoid 
having to manually enter all of a customer’s SNs and if you have one single big customer activated with one sole carrier. The 
programme will rate all the CDRs within a particular group of CDRs and associate all call, data and service items with this customer. 
You may then to make things even easier simply create a price list that has a value in the MarginMultiplier field and ensure that this 
CDR group has a cost column, to rate CDRs based on a permanent percentage value that does not change overtime. 
 
Select the CDR formats associated with the SNs. 
 
It is possible to duplicate a base list and create one specific to a customer: Right-click over a SN to access the price list details 
specific to this customer or to create a customer-specific price list from the underlying base list (‘Base list’). As soon as the list is 
accessed for the first time via this last action, a new instance of a customer’s price list is created in the database and specifically 
linked to the current customer. As long as it is selected, the underlying base list accessible from the Price lists detail screen will still 
be used by TeleFactura when the billing is done in case there should be any calls that cannot be matched to a dialling code using the 
customer’s price list created here. It is possible to access the customer’s newly created price list from their account screen or from 
the ‘Price list details’ screen, although it is safe to modify the underlying base list for reason given previously. However the prices 
TeleFactura will use first, are the ones defined in this newly created price list. 
 
Finally, ensure the column in the SNs for national dialling codes is reviewed if some of these codes are empty. Leaving these codes 
empty might introduce errors later when billing your customers. 
 
The discount identified for each SN will be added to the discount identified in the price lists for data and recurring services during 
invoicing. 
  
Important: 
 
• If the SNs are true phone numbers, ie the whole number is numeric, then these should not have any leading zeros and the 
national and/or regional dialling codes need to be placed in their respective boxes. 
• Non-true phone numbers (i.e. non numeric numbers) can have leading zeros. 
• Dialling codes should not have any leading zeros or spaces. 
• Often CDR data includes national numbers calling (that is to say a customer’s SN) or national numbers called that have no 
country code. In this case, the programme uses the country code set alongside the SN to manage such numbers. If SNs defined 
herein include non-numeric characters, the programme considers that these numbers are not real phone numbers. From then, when 
the programme compares the SN to an originating number encountered in the CDR data, it will ignore the prefixes for the analysis of 
the originating number. If this is the case, leaving the boxes for the dialling codes empty should not affect billing. In terms of the 
called number and if no country code is defined with the SN, the programme will use the customer’s general country code to identify 
the originating country of the calls. 
 It is strongly recommended to limit the number of lines in all price lists as a large number of lines may slow down the 
optimal running of the program when billing. 
 
3.4.2.2. Distributor Details 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Distributors tab > Double-click on a line 
 
First tab: Details 
 
Second, third and fourth tabs: Commissions 
 
TeleFactura uses two types of commissions: Point of sale and residual. The latter type applies to voice/data and recurrent services 
and is given to the distributor each time a customer invoice is raised. The former type is given to the distributor on each sale the 
distributor manages to secure. Typically these are on subscriptions, packages and inventory assets sold by your company to a 



 

customer. This occurs when a new sale is entered in the customer’s subscriptions screen. Residual commissions are always given as 
percentages. The packages and subscriptions that show are the ones associated with all the customers linked to the distributor. 

 
TeleFactura supports three scopes when it comes to commissions: 
 

 Commissions that are applied on all items, from voice services to subscriptions. Here, Point of Sale commission can be a 
percentage figure or be based on a fixed amount given out each time a sale is secured. 

 Commissions that are applied separately on each item type, i.e. on each package, subscription, and inventory item (Point of 
sale only) or call group or recurrent service (Residual). An item from inventory will be treated the same as a subscription 
when it comes to commissions. 

 Commissions that are applied separately on each item type as residual commission only, given out when invoices are 
raised. This type of commission is applied to all products and services from voice services to subscriptions. 

 
Finally, specify at the top of the first commissions tab: 

 The basis upon which commissions will be calculated: sales price, purchase price or profit of the item. 
 How the commissions identified will be split between the different distributors located above this one in the hierarchy. 
 Distributors can get extra commission if they reach a certain amount of sales. Specify these values here. 

 
Commissions are calculated on the price of the packages, not on values that correspond to any excess usage for the data part of 
packages. 
 
Fifth tab: Options 1 
 
Select the user name and password for TeleFactura CRM and Web Access, the commercial representative who created this contact, 
the levels of the sales taxes that apply to this distributor, the folder where the distributor’s price lists are located when they log into 
the Web Access, their language,… 
 
Sixth tab: Branded billing 
 
Here, all the elements required for the design and handling of invoices are given again but apply to the distributor. Branded billing 
means it is possible to show on an invoice the distributor’s details in lieu of the billing company in case billing of their customers is 
sub-contracted by them to the billing company. Fill in the information required from point 1 to 9 so that the distributor’s full design 
elements and details will show when his customers’ invoices are raised. For this option to work, make sure you tick the ‘Branded 
billing by distributors’ option in the Billing screen, activate this option here with the tick box and enter correct data for all the points 
on the tab. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Distributors tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
Transactions 
 
This screen keeps track of all transactions and payments done by the distributor and of all monies by him/her owed to you. It is 
similar to the one used under customer accounts. 
 
When using the billing part of the programme explained in chapter 3.4.3 and if you click the option that says to include the invoices 
in customers’ billing, the commissions associated with these invoices and distributors will be added to each distributor here. The 
same types of transactions exist here as do for the customers. 
 
Distributors can also log into TeleFactura Web Access and search calls made by their customers and check their balance. 
 
3.4.2.3. Supplier Details 
 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Suppliers tab > Double-click on a line > First tab 
 
Supplier details 
 
Enter the suppliers name and contact details. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Suppliers tab > Double-click on a line > Second tab 
 
Supplier call settings 
 
This screen is identical to the one provided in the 5th tab of the configuration screen but applies to the supplier being viewed only. 
Bank holidays are identified for each supplier at the bottom of this tab. 
 

 
 



 

Access: Main interface > Home > Customers, distributors and suppliers > Suppliers tab > Double-click on a line > Drop-down box at 
bottom right-hand corner on first tab > CDR formats 
 
CDRs - General considerations 
 
Some major aspects about CDR billing data with TeleFactura are as follows: 

 TeleFactura makes it possible to bill voice/data and recurring services CDRs. 
 The source of the CDRs can be: text files, http requests and databases. 
 For text files, the file encoding needs to be UTF8. 
 Rating of customer data can be made in three ways: 

o By defining rates in price lists 
o By identifying a purchase price column in the CDRs and a global margin multiplier 
o By identifying a sales price column in the CDRs 
o By identifying a purchase price column in the CDRs and a customer-specific margin multiplier 

 
TeleFactura makes it possible to have CDR data that runs to a different recurrence from the recurrence specified in the price lists. 
Simply specify the recurrence in both instances (i.e., in the CDR format as seen above and in the price lists for the different 
services). 
 
Rating of a package is done based on package codes. For the rating to work, the codes identified within a package code column in 
the CDR format will have to match the codes identified in your packages. 
 
There are several ways TeleFactura works out which purchase price to use for a voice call, data package or recurrent service: 
 

 The purchase price will be taken first from the CDR data if a purchase price column was identified when importing a CDR 
format (voice and services) 

 Then, the programme will fall back on the purchase prices identified in the sales price lists identified in a customer’s 
voice/data or service parameters under their account’s SN screen (voice and services) 

 Failing all that, the system will use the purchase prices identified in the customer’s purchase price list (voice and services) 
or packages (data) 

 
If margin multipliers are identified in a price list, these, combined with a purchase price in the CDR data, will always have 
precedence over per minute rates and fees in the same price list. 
 
For the recurrence of data packages and services, ‘one time’ means that each cost that appears in the CDR data will be priced once. 
Here the price for example in a data price list will be a price per kilo, mega … bytes. 
 
Tabs 1 and 2 are where the different CDR formats are added, whether for voice/data or recurrent subscriptions. A number of 
parameters have to be associated with each CDR format. A number of parameters must be associated with each CDR format. These 
are identified with an import wizard for CDR formats. 
 
Voice/data CDRs 
 
To add a new type of voice/data CDR, go to the ‘Actions’ menu and select ‘Add new’. You will be taken to a wizard. Simply complete 
the import process of your new format there. 
 
Not all options are relevant to the format you want to import. Select ‘>Not applicable<' if you are faced with an option that does not 
apply. 
 
Steps involved are detailed below: 
 

- 1. Identify if the format is for voice, data or both. The guidance that follows will be for a format that uses both types. 
- 2. Give it a name. This name is automatically used by TeleFactura to create the folder where CDR files that are 

associated with this format have to be stored. The path to this folder is the path given in the Configuration screen, 
point ‘2.A.3’. 

- If you have the Radius add-on, point 3 is where the programme will ask if the source is TekRadius / Radius Manager or 
other, if not carry on to the next point. 

- 3. & 11. The format of the date and time fields, either yyyymmddhhmmss (ISO format) or one that uses a separator 
between the year, month and day, hour, minutes and seconds. For ISO formats, make sure you do not split the date 
and time into separate date and time fields when importing fixed-width CDRs. These should be identified as being one 
field: date and time together. It is important to ensure that the date and time formats identified here are correct as 
this will ensure that errors are avoided and ensure formats are changed in the programme if they have changed in the 
CDR data. For instance for the time part ‘HH’ would mean 24 hrs and ‘mm’, 12hrs time formats. The tricky part in dates 
usually is the months, which should be mm if March (e.g.) is given as ‘3’ and MM for ‘03’. More information about date 
and time format strings can be found below: 

 https://en.wikipedia.org/wiki/Date_format_by_country 
 https://docs.microsoft.com/en-us/dotnet/standard/base-types/standard-date-and-time-format-strings 
 https://docs.microsoft.com/en-us/dotnet/standard/base-types/custom-date-and-time-format-strings 

- 4. Location of the date. The date cannot contain a value for the time if it is located in the name of the file or in the 
header row. 

- 5. If a column for the purchase price of call is found in a CDR file/table/url, the programme will use this when working 
out your profit and loss reports as explained in the Billing and Reports screen. 

- 6. Identify the strings that constitute a valid call that should be billed. Calls that do not include these flags will not be 
billed. In the wizard, identify the column that holds this information by selecting a column header for the marker called 
‘SUCCESSFULLCALLFLAGFIELD’ and associate it with a column in the CDR format. It is also possible to indicate whether 
calls should be charged if the column contains no value or if value is greater than 0. The CDR will not be rated if the 
field contains a value or if the field holds 0’s. 



 

- 7. If the CDR data does not have line returns, write the number of columns in the CDR data. Write ‘0’ if the data does 
have line returns. 

- 8. Field where a note can be entered about the CDR format. 
- 9. Select how the CDR data will be rated. If selecting the second or third options, the following need to be identified in 

the field mapping stage of the import wizard: a quantity, sales price or a purchase price and a margin multiplier. If one 
of these options is selected, one or more price lists of any kind can be associated with the customer’s SNs just as long 
as the CDR data holds that information so that the rating can be done correctly. A margin multiplier has to be identified 
if the 2nd option is selected. 

- A purchase price column has been identified in 5 above or the CDR is rated using a purchase or sales price value: 
- 10. Identify if all cost values are given as hundredths or not, i.e., as pence or pounds, cents or dollars. 
- You did not identify a purchase/sales price column: 
- 11. Identify how calls are rated: via the number called or call types. The former uses the dialling codes found in a price 

list or listed in the call settings; the latter uses the call types found in the CDR data matched against the call types 
found in a price list/call settings. Under the first option, select the format numbers called have (very important to 
ensure a correct match and to obtain the correct costing of your calls). This option essentially means the programme 
needs to know if numbers called start with the country codes or not. If national numbers have a fixed length, add all 
possible lengths in the drop-down menu. Leading zeros in front of a national number called do not count towards the 
total length of a number. 

- 12. Identify the separator that is used in the date and time strings if these appear in the same field. Select ‘>Not 
applicable<‘ if date and time are in separate fields. Select ‘No separator’ if the date and time is one block with no 
separator. 

- 13. Specify if the duration of calls is given in seconds, minutes, format hh:mm:ss, in second decimals or start and end 
times of the call are given. 

- 14. Specify what is the CDR field for the call types, as was explained in the Call settings screen above. The algorithm 
that pulls out the cost of the calls made by your customers requires matching a call type field from your price lists and 
a matching field from your CDRs. The use of call types is not necessary and can be ignored if you are happy to rate 
calls using the number called only. Using call types is useful in the following cases: 
o CDR data use dial classes 
o If two or more operators make use of number portability and therefore need to be differentiated. 
o When different operators exist in a country and operate with the same dialling codes. In Belgium, for instance, for 

a time there existed 2 phone-number-issuing operators that used the same established regional dialling codes. 
They each had their own rates when calls are placed to numbers that fall within their network. The only way to 
differentiate calls that were made to these same regional codes was to use the country field in the carriers’ CDRs 
and look for their company names, hence the need to use not only the dialling code but also the destination field 
(or any other field) to match a call and its cost. Select ‘Other - Select in wizard’ if you wish to directly identify this 
column in the wizard rather than use one of the default fields given in the drop-down box. 

- 15. Select how IP addresses are formatted in the CDR files/tables/web pages. 
- 16. Select if the operator masks numbers called. 
- 17. Select if for calls of zero duration, certain costs have to be computed. 
- 18. Tick this option if numbers called for this CDR are also SNs and to make calls to these SNs free. 
- 19. Select if calls are split as calls outbound and inbound*. Additionally, identify if these are on the same line or are 

split over 2 lines. If the former is the case, you will be taken to the wizard where inbound and outbound parts of the 
calls need to be identified. So for instance ‘Number called’ will be split into ‘Outbound number called’ and ‘Inbound 
number called’. If calls are on 2 lines, strings that identify the outbound and inbound parts are normally required and a 
column will have to be identified in the wizard with the flag ‘OUTBOUNDINBOUNDFLAGFIELD’. In this last case, calls 
will be split as 2 calls: one call for the outbound part of the call and one for the inbound part of the call. If no strings 
are identified then inbound and outbound parts of the calls are deemed to be contained in 2 columns: one column for 
‘inbound originating number/outbound number called’ and one column that holds ‘inbound number called/outbound 
originating number’. 

 
* The concept of incoming/outgoing calls is used by the programme in a very broad way and can be used for cases 
where strictly no incoming and outgoing calls exist. This makes it possible to configure any type of billing model. For 
example in VoIP telephony, if you have a type of CDR that includes a column with the CLI (DDI, DID) and another with 
the IP address that made the call and you want the program to manage both, identify one column as the incoming 
number and another as the outgoing number. This will allow the program to switch from one column to the other 
according to the needs of the CDR, for example in the case where some of the lines in the CDR have a blank in place 
for the CLI in the first column and the IP address should be used from the second column. 
 

- You have ticked parameter 19: 
- 20. Determine whether incoming and outgoing parties will be billed separately, i.e. as two calls or one. 
- You have checked the first option of parameter 20: 
- 21. The program will ask you to identify the fields that correspond to the incoming and outgoing parts of the calls later 

in the wizard. Identify here which party will be charged (incoming or outgoing) and which numbers should appear on 
the invoices as called and calling/originating numbers. For the 3rd radio button option, ie ‘Rate using the inbound 
number called and fall back on the outbound number called if the inbound number is empty’, the following fields are 
typically selected in the field mapping part of the wizard: 

 Inbound/outbound originating number or inbound originating number and outbound originating number, 
and 

 Inbound number called, and 
 Outbound number called 

- You did not tick parameter 19: 
- 20. What recurrence do the files use. 
- 21. How should the programme behave if no bandwidth consumption is found for a period of time for this CDR. 
- 22. How is the bandwidth given: In bytes, MB or GB. 
- 23. Identify how downloaded/uploaded bytes are displayed, ie, is there a single value for both or separate columns for 

downloads and anther column for uploaded traffic. 
- 24. Select whether the CDR data is located is a text file, in a database or on a Web page (HTTP GET/POST). 



 

 
For text file CDRs: 
 
- Select the separator used in the CDR files; 
- Select the number of lines TeleFactura should ignore as it opens the CDRs for analysis; 
- Select a CDR file in order to identify what each column is and for fixed-width CDRs, to identify the width of each column.  
 
For CDRs located in a database: 
 
- Identify the database connection string; 
- Click to test the connection and pick a table. 
 
For Web pages: 
 
- Select the separator used in the CDR files; 
- Select the number of lines TeleFactura should ignore as it opens the CDRs for analysis; 
- Select the HTTP address of the Web page. You may include parameters such as a user name and password in the URL.  
 
Click ‘Next’. 
 
Field mapping: link the columns in the CDR format with the types of data these hold. 
 
Click ‘Next’. 
 
TeleFactura supports the billing of outgoing and incoming calls. The former are also sometimes called outbound, egress or ‘b leg’ 
calls. The latter are sometimes called inbound, ingress or ‘a leg’ calls. 
 
TeleFactura makes it possible to bill a single CDR line that can hold both outbound and inbound calls. 
 
The table that stores the CDR data needs to have a numeric unique primary key (NUMERICPRIMARYKEYFIELD) as TeleFactura uses 
its values to keep track of the rows already analysed as it scans the records in the selected table. Note that values held by this field 
are limited to 8 decimals. 
 
See chapter 3.3.2 for more on the significance and on how to use call types. If you did not find a suitable field amongst those that 
TeleFactura offers by default under point ‘14’ above, select calltypeFIELD in the drop-down menu in the field mapping stage to 
indicate that the column holds the call types you wish to use. 
 
The voice/data CDR system offered here is best used for items that show a duration like voice calls. For items that do not have 
duration like SMSs, import the CDR format as a service CDR (see below). TeleFactura also allows the user to identify the length of a 
call based on pulse-codes as opposed to its duration. For this and when in the import wizard, simply link the column where phone 
pulse codes are stored with the heading ‘Other measurement of call length’. 
 
Dial classes 
 
As seen previously, dialling codes in a price list do not have to be ITU-styled codes. These can be any string of characters in fact, 
including pin codes, UK dial classes (fm3 , ukgeo, fm6,…), price groups, dial strings, ip addresses, NDIs … TeleFactura matches the 
dialling code part of the number called in a price list with the dialling code of the number called of a call. If the number called in the 
CDR data is not a real number but for instance a UK dial class, use the inbound/outbound option under step ‘19’ of the import wizard 
for CDR formats to set the field that will be used as the numeric number called in the invoices. Here you would select to rate the call 
as one call in step ‘20’ under a supplier account; in step ‘21’, select to rate the call using the inbound number called and select ‘show 
the outbound number called on the invoices’. In the field mapping stage, use the dial classes column as the inbound number called 
and select the actual number called by the user as the outbound number called (to be displayed on the invoices). 
 
An alternative to using the inbound/outbound model is to select ‘Rate calls using call types’ under option ’10. Determine the basis on 
which calls should be rated’. The dial classes need to exist in the CDR data and these need to be mapped as being the call type 
column. Ensure also that the price lists used against this CDR format have a call type column. 
 
Note that if a call type column is identified in the CDR format, these must exist in the associated price lists if CDR rating is done 
using a price list. 
 
Click ‘Next’. 
 
Identify the parameters in the CDR format for Quality of Service analysis. 
 
Click ‘Next’ then ‘Finish’. 
 
Service CDRs 
 
Service CDRs are used in cases where services need to be invoiced based on CDR data. One such example is LDRs or WLRs 
(Wholesale Line Rentals) in the UK. 
 
Create your CDR format for data services by specifying the following information: 
 

- 1. Name of the CDR format. 
- 2 & 3. Format of the date and time fields: ISO or character-separated. Write a value for the masks: yyyy/mm/dd, 

hh:mm:ss,…. See points ‘3’ & ‘11’ in the voice/data CDR section, above. 
- 4. See point ‘12’ in the voice/data CDR section, above. 



 

- 5. Location of the date. The date cannot contain a value for the time if it is located in the name of the file or in the 
header row. 

- 6. Purchase price column. See point ‘5’ in the voice/data CDR section, above. 
- 7. See point ‘6’ in the voice/data CDR section, above. 
- 8. See point ‘7’ in the voice/data CDR section, above. 
- 9. Field where a note can be entered about the CDR format. 
- 10. See point ‘9’ in the voice/data CDR section, above. 
- 11. Identify whether calls are rated based on service types or codes. The first option requires the use of the service 

types table in the settings menu. This system is similar to British Telecom's WLRs in the UK. If the service code option 
is selected, these same codes should be present in the CDRs for rating purposes. 

- 12. Recurrence of the files (daily, monthly…) or are the items listed single items that have to be billed individually with 
no pro-rated billing for a specific period. This is ideal for billing services like SMSs that do not have a duration but a 
fixed cost. 

- 13. Do service costs appear in pennies/cents or do they appear as pounds and dollars, e.g. 
- 14. Select source type of the data. 

 
A service start and end dates (and times) can be identified in the wizard. The programme calculates the pro-rated price of the 
services based on these dates and those selected in the billing screen during a billing session. Services are always pro-rated if a 
period smaller than the length of a cycle is billed. For this to work, ensure you use the first day of the period that needs to be billed 
as the service date in the CDR data. For instance if a service needs to be pro-rated for 01/05 to 10/05/2020 for a billing cycle of 
01/05/2020 to 31/05/2020, the service date in the CDR data needs to be 01/05/2020. 
 
Rating of a service is done based on service codes. For the rating to work, the codes identified within a service code column in the 
CDR format will have to match the codes identified in your price lists. 
 
If the 2nd or 3rd choice is selected in option ‘10’ in the import screen for service CDRs or option ‘9’ in the import screen for voice/data 
CDRs, the programme will not use any data from price lists, but only the data identified in the CDRs. Therefore, it is possible to not 
associate a price list with these CDR formats in the customers’ SN screens. 
 
Also under these two options, if no name or service package is associated with a column in the CDRs, the programme will attempt to 
retrieve them from the identified price list. 
 
Cost columns such as a purchase cost column in the CDR data can show comma or dot as the decimal separator. Price lists on the 
other hand have to show the decimal separator expected by the windows settings (dot or comma). 
 
Voir le chapitre 3.4.3 pour un survol complet du modèle de facturation en vigueur au Royaume-Uni. 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Suppliers tab > Double-click on a line > Third tab 
 
Options 1 
 
Many phone numbers in CDRs start with (e.g.) a plus sign, which can cause Dynasoft TeleFactura to fail to analyse CDR 
files/tables/web pages correctly. Specify the characters that should be ignored when rating this supplier’s CDR files/tables/web 
pages. Total length of all rules defined here is limited to 2550 characters. 
 
Identify the supplier’s representative within your organisation, the supplier type, the levels of the sales taxes that apply to this 
supplier, their language,… 
 



 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Suppliers tab > Double-click on a line > Drop-down box at 
bottom right-hand corner on first tab 
 
Transactions 
 
This screen keeps track of all transactions and payments done by the supplier and of all monies by him/her owed to you. It is similar 
to the one used under customer accounts. 
 
The model used here is similar to the Transactions screens that exist for customers and distributors. The only item that differs is 
what is called ‘Computed usage’. This refers to all the items that have been billed to a customer and for which a purchase price was 
available. This includes voice calls and subscriptions. Each entry will show the invoice number, customer number and date for easy 
reference. To reconcile the account you hold with a supplier, simply enter the money that is paid to him/her, the invoices received 
from them and the programme will work out the cost of the voice calls and other items using the supplier’s purchase prices. Money 
invoiced by your supplier should be equal to what the ‘Computed usage’ items the programme adds in this table overtime. 
 
The model used here is similar to the ‘Transactions’ screens used with the customers and distributors. The only element that differs 
is the transaction type called ‘Computed usage’. This refers to all the items that have been invoiced to a customer and for which a 
purchase price was available. This includes the voice calls and the subscriptions. Each one of these elements in the table indicates 
the number of invoice, customer and a date for reference. This functionality is useful in order to make sure suppliers invoice your 
company correctly. The programme will determine the costs of these calls and subscriptions by using the purchase prices defined 
throughout the programme. The money invoiced by the supplier should be equal to the sums corresponding to the ‘Computed usage’ 
given in the table for a given period. 
 
3.4.3 Modèle WLR de BT (UK) 
 
1. Recurrent services 
 
BT supplies WLR services operators can resell to their customers. TeleFactura supports this model. In order to use this functionality, 
follow these recommendations: 
 

 Import wizard for service CDR formats (Home > Suppliers > CDR formats screen): 
o Select option ‘Rate services using service types’ under parameter 11 
o Identify a column for ‘Service type’ when the field mapping part of the import wizard is reached 

 Service price list (Data > Price list details screen): 
o Identify values for service code and service type fields 

 Service types (Settings > Service settings): 
o Populate the table with service types/values pairs 

 
Example: 
 

a. Line in a CDR file: 
 
Fixed Line WLR only,0163558827,01/05/2020,31/05/2020,1,Monthly,0.09,0.09,WLR-Call Divert,, 
 

b. Price list: 
 
ServiceName Description ServiceCode SalesPrice Recurrence ProductCategory AcccountCode ServicePlan 
Call Divert  CDV 1.5 M   UKBNR1 
 

c. Service types: 
 
ServiceType ServiceCode 
WLR-Call Divert CDV 
 



 

Column with value ‘WLR-Call Divert‘ in the CDR file was identified as holding the service types during the importation of the CDR 
format. The programme will work from the CDR file, perform a look up for service number 0163558827 and search for a price list for 
that service type. It will look for a service code (‘CDV’) in the service type table that matches the one in the service price list and 
match the CDR’s service type with the type found in the service types table. The programme will use rate 1.5 in the above example. 
 
2. Voice services 
 
Under the WLR model, BT service types are also used for voice. The table used is the call types table under the Settings menu.  
 
3. Default data to aid in the setting up of BT’s WLR model 
 
We include database scripts and csv files, which contain complete data for UK WLR-type billing. These files are located in the 
Settings directory under Assets in the installation of your programme. 
 

 Price lists with UK and international call types for voice: 'VoicePriceLists_July2020.sql'. 
 Price lists with service types for WLR services: 'ServicesPriceLists_July2020.sql'. 
 List of default voice call types: 'IntlCallTypes_July2020.csv' and 'UKCallTypes_July2020.csv'. 
 List of default service types and codes: 'ServiceTypes_July2020.csv'. 

 
The data contained in the files and database tables need to be maintained once imported to ensure they have the latest elements. 
 
3.4.4. Billing 
 

 
 
Access: Main interface > Home > Billing > Controls tab 
 
This screen is used to invoice your customers, save all customer service usage and publish it on the Web via TeleFactura Web 
Access. 
 
According to our benchmark tests, TeleFactura can handle up to 9,000,000 calls/CDRs (lines in a CDR file/table) an hour. This is for 
CDRs that have just the required columns (SN, date and time of call…) and price lists with few regional codes for each country, no 
saving of any orphaned CDRs, for a single customer with one service number and where 10% of CDRs in the data belong to the 
customer. 
 
To work out what the usage has been for one or more of your customers, simply follow the steps given here: 
 
1. Customers and single number 
 
Select one or more customers to work with. The programme will run only using those customers that have been selected in the list 
on the first tab. This is the case when scanning CDRs and opening, saving or printing invoices, in manual or automatic mode. In case 
you modified a customer’s details and did not close the billing screen, use the refresh button to update the information displayed 
with the most recent data for the customers. You may also do a search for just one SN via the second tab. For this, you will only be 
able to use the A button (‘Load the customer’s items’) in the manual mode. The programme will look for a match with the defined 
service number in all defined CDR formats in the system. 
 
2: Billing modes 
 

1. Automatic mode 
- ‘A. Rate the CDR data: Select an initial date for the calls/data entries that have to be searched. 
- ‘Loop CDR rating every (min.)’: specify the iteration time when the programme will scan the directories/tables/web pages for new 
CDRs. 
- ‘Select type of scan to perform’: Select the scanning option required as stated in the drop-down box: 

 The option ‘Resume from last CDR analysed’ will make the programme look for new CDRs and matching calls/data/service 
entries after all current calls/data/service entries have been picked out from the files/tables/web pages. 



 

 The option ‘Resume by reopening CDRs and look for new data (tick customers and CDRs from list)’ will re-open the CDR 
files/tables/web pages already analysed and pick out new calls/data/service entries that did not get billed previously. This 
option can be used to make the programme scan a different set of customers once the stop button has been pressed. 

 The option ‘Delete post-dating data and re-rate selected customers (tick customers and CDRs from list)’ can be used to re-
rate customers that had already been rated. The programme will delete all previous entries for the selected customers and 
for the date that follows the start date selected of the scan. For this option and the previous one, make sure you tick the 
CDRs that have to be scanned again (‘Display’ tab > ‘CDR - Automatic’) and that you have selected customers that have to 
be searched again in the list of customers at top left hand-side corner. 

 The last option deletes all CDRs that were read and starts the process all over again. If you use this option this is what gets 
deleted: 

o The CDR data already rated 
o Invoice line items for a particular bill run 

 Use the stop button to stop the normal running of the programme. This does not delete any previously rated CDR from 
files/tables/web pages but only those currently being rated. By stopping the programme you can modify the SNs of any 
existing customer, add new customers and paste new CDRs in the CDR directory. The latter can also be safely done when 
the programme is running. When the programme is running in automatic mode, calls/data/service entries not only are read 
off the CDR files/tables/web pages but also processed at the same time (i.e. rates are applied). This way, the processed 
information is readily available for display locally but is also pushed in real time to TeleFactura Web Access supplied. The 
option ‘Resume by reopening CDRs and look for new data’ will re-open the files/tables/web pages already analysed and look 
for any unrated data. 

- ‘B. Generate the invoices’: Using these controls, it is possible to issue the invoices (display, save or print) when the programme is 
paused. Specify the billing period above the drop-down menu. 

 
2. Manual mode 

- ‘Select the cycle’: Select a period with two dates within which to do the search. 
- ‘Run the individual billing tasks’: Buttons A to E make it possible to handle the billing task one step at a time so that all calls 
gathered from the CDR files/tables/web pages appear in the sub-tabs of the second set of tabs under the tab ‘Display’. These are 
then computed (under sub-tabs ‘Out - Voice’, ‘Out – Data’ and ‘Out – Services’) using the price lists associated with the customers. 
The series of 5 buttons marked A, B, C, D and E perform the following tasks: 
A: Click here to load the calls/data/service entries that correspond to the customer(s). These items are loaded as they appear in the 
CDRs when they are scanned in their directories using the data you supplied in the configuration of the programme and in each 
customer’s account. 
B: Click to apply the computed rates to the calls/data/service entries previously loaded in the first sub-tab. 
C: Open the computed invoice on screen. 
D: Save the invoices in the directory specified in the drop-down menu in 2. 
E: Print the invoices to your printer. 
- ‘Select the tasks to perform’: You may use this drop-down menu to automate all these tasks and run the whole process 
unmanned: load calls/data/service entries, apply rates to them, open, save and print the invoices for one or more customers, all in 
one click. These individual steps are available with the individual buttons A to E. Once everything has been configured and set up 
correctly, using this button will make billing your customers effortless, as no interaction will then be needed. Ticks appear against 
the main tasks as and when these tasks have been carried out by the system. A cross indicates that the task has not been 
completed. Stop the execution of the programme by pressing the Stop button provided. Pressing the OK button again, restarts the 
whole process of reading all CDRs again from scratch. 
 

C. Common to Manual and Automatic modes 
1. Billing options: 

- You may give discounts to certain customers. Simply select the customers to whom these have to be given in the list of customers, 
click Add and specify the percentage in the box to the left of the ‘Add’ button. The customer numbers will appear in the drop-down 
menu. The caption of the ‘Add’ button will turn to ‘Empty’, so you can delete the entries from the drop-down menu. 
- You may include the invoices being created here, in each customer’s transactions screen (see chapter 3.4.2.1, above): add any 
commissions owed to your distributors in their billing and account for all commissions owed by your customers for inclusion in their 
invoice. To make sure all commissions that are owed to your customers are taken into account when invoices are issued, ensure that 
you click this button and that for any particular customer whose commissions you want to include in his invoice, all his referred 
customers have been duly selected in each customer’s screen. Then use the drop-down menu under ‘Running the individual billing 
tasks’. Ideally, you would simply select all customers and wait for the system to run its course. Commissions that are owed will be 
taken for the billing period specified previously. Discounts for customers will appear on their invoice in the totals column (see 
below). Any discounts currently owed to them that appear in their billing, will be deleted and will be included in the invoices being 
issued. In manual mode, if you forgot to click this after having launched an invoicing session and wanted to include the billing, you 
will have to launch a billing session again and include steps A and B of the manual mode again. In automatic mode, the invoices are 
sent to the customer’s billing and commissions are computed each time the OK button is pressed under ‘Select the tasks to perform’. 
Make sure you only tick this box and run the tasks using the controls to the right once only. If the selected customers have 
subscriptions or packages and this option is not selected, these items will always show on the customer’s bills for the relevant 
periods. It is only if the option is ticked that billing periods will be scrupulously implemented as explained in chapter 3.4.2.1. The 
programme will also increment the invoice count. Finally, TeleFactura keeps a history of all billed items in certain tables. Ticking this 
option will make the programme keep the information associated with the session. 
- Click on the next option to log all those calls/data entries/service that show in the CDRs but that can’t be associated with any of 
the customer’s SNs. 
- To ignore any numeric errors that might occur during an analysis and prevent the programme from exiting, check the fourth box in 
these options. 
- Tick this box to let the programme remove duplicate entries for data CDRs. 
- Click on the next option to make the programme retrieve all the latest CDRs from your operators before the billing is computed. 
See chapter 3.4.3. 
- Clicking on the next option will create a file with all the data of a billing session. In manual mode, this file is created when running 
the data that is read from the CDR against the customer’s price list, i.e. when the B button is pressed or called. In automatic mode, 
the file is generated when using the controls under ‘Select the tasks to perform’. To specify the path where the file will be saved, 
turn to the configuration screen and write it in under point ‘2.A.2’. 



 

- The next option will integrate the cost analysis for each call. This procedure adds some overhead in terms of the time the 
programme takes to perform the overall analysis. 
- The next option is useful if you wish to include calls that predate the billing period selected, that were part of CDRs that were not 
analysed and if you wish to include these in the next analysis. 
- Apply the distributors’ branded billing option to the next bill run. Tick configuration option ‘f’ under Options 8 tab if required. 
- The option to send customers their invoices by email will ensure these are sent at the end of the overall analysis provided they 
have been marked in their individual screens (see chapter 3.4.2.1). 
- Financial reports include the ability to list data by country called. Tick this option if you wish that each call be associated with its 
country. This will add additional routines to the rating routine and will slightly slow the process down. 
- If the programme finds a call, data or service entry that does not belong to a known customer or if a call does not have a matching 
rate in the price lists, TeleFactura can save the CDR in a separate file. This file is called ‘UnratedItems.txt’ and is located in each CDR 
folder. If the source of the CDR data is a database, TeleFactura will store the rated items in a text file in a folder of the same name 
as the CDR format. Another important file that is likely to contain information about run-time errors is MainLog.txt located in Assets 
> System. The BillingLog.txt file in the same directory contains information about billing sessions. 
- Click on the following option to show in the display tab the items that are being rated. Clicking on this display tab will also make 
the programme show these items but only those that are being rated as the user clicks the tab. Clicking this option slows the 
programme down. 
- This option will only display in the invoices the subscriptions and packages. 
- Tick the next option to get TeleFactura to check the integrity of the voice price lists. 
- Tick this box to let the programme remove duplicate entries for services CDRs. 
- Tick this box to let the programme remove duplicate entries for voice CDRs. 
- Invoices can be saved in one of two locations: In the folder identified in the configuration option 2.A (default) or in each customer’s 
invoice folder as per option 1.B.1 inside their account. Tick to save invoices in the latter. 
 
Under ‘Log’, press ‘View’ to check for any errors during the execution of your programme. A non-exhaustive list of possible errors is 
given below: 
- Not specifying a price list for your customer. 
- Not having specified the call type in your price lists for voice services. 
- Using the wrong type of CDR file in a CDR directory. 
- Not using the normal standard format in your voice price lists: dialling code and country code for all destinations in your price lists 

(national destinations have to have the national dialling code in front), followed by country, then the rates and call types. 
- The customer’s phone number was not written in correctly in the customer details screen. 
- If the programme finds a call, data or service entry that does not belong to a known customer. 
- If the programme finds a call, data or service entry that does not belong to a selected customer. 
- If a CDR directory cannot be found. 
- Erroneous configuration data (times for peak rates…) 
- In data billing, if a date cannot be found in a CDR. 
 
See the error codes detailed in point H of chapter 3.13. 
 
Only calls that have durations greater than zero are displayed and processed. 
 
The programme works best with the following date and time formats: dd/mm/yyy hh:mm:ss. 
 
The underlying code used by the automatic and manuals modes are the same and so in terms of rating and error handling there is 
no difference. 
 
Important: 
 
Some functionality in TeleFactura will only work with the automatic billing mode. These are: 

 The Web Access portal 
 Retrieving CDR data as a billing option in the main billing screen 

 
To stop a billing run by using any of the ‘Stop’ buttons will make the programme delete the data currently being processed. This 
ensures that no duplicate data exist in the system if the user decides to redo that same CDR data. 
 
The manual billing mode is provided mainly to test how the programme carries out billing, i.e. how calls are rated, identify possible 
problems with billing scenarios or with how certain calls are rated. It is recommended to switch to the billing mode as soon as 
possible once the configuration needs have been identified. 
 
In the lines that show the invoice’s totals located under the summary part, the line for ‘Discount’ reprises the commissions earned 
by the customer along with any refund for the period billed if these have not been already marked as paid in the customer 
transactions screen. 
 
It is recommended to periodically check the database table ProgrammeEvents for any errors that might arise during a bill run. If the 
table gets filled with too many errors it means your configuration is likely causing problems. 
 
It is important to ensure that the date and time formats and the field mapping identified when CDR formats were imported are 
correct as this will ensure that errors are avoided and that these are changed in the programme if they have changed in the CDR 
data. 
 
Below is an example of an invoice that was generated using Dynasoft TeleFactura. The language can be modified from within the 
configuration screen. 
 



 

 
 

 
 
Access: Main interface > Home > Billing > Display tab 
 
- First Tab of Second set of Tabs 
 
Display of all voice calls as they are picked out from the CDR files/tables/web pages. 
 
- Second Tab of Second set of Tabs 
 
Display of all calls as they are processed after the rates are applied to these from the first tab above. 
 
- Third Tab of Second set of Tabs 
 
Display of all data entries as they are picked out from the CDR files/tables/web pages. 
 
- Fourth Tab of Second set of Tabs 
 
Display of all data entries as they are processed after the rates are applied to these from the third tab above. 
 
- Fifth Tab of Second set of Tabs 
 
Display of all service entries as they are picked out from the CDR files/tables/web pages. 
 
- Sixth Tab of Second set of Tabs 
 
Display of all service entries as they are processed after the rates are applied to these from the third tab above. 
 
- Seventh Tab of Second set of Tabs 
 
Display of the CDR files/tables/web pages that are read. Click one or several CDR files/tables/web pages to delete all 
calls/data/service entries associated with the files/tables/web pages from the system and from all billing. You may also tick CDR 
files/tables/web pages if the programme was stopped and if you wish to pick up any newly identified SNs in the customers’ accounts. 
Select the second option (‘Resume by updating the SNs (tick CDRs from list)’) in Ib of the main interface. 
 
When stopping the programme as it is running, it will delete all references in the system to the last CDR table or file that it was 
reading, so that it will read it again fully when you resume the scanning of CDRs.  
 
- Eighth tab of Second set of Tabs 

IV 



 

 
Click on the Voice or Services radio buttons to display a graph of the billing that appears in the first (for voice) and third (for 
services) tab above. 
 
In IV, under the second set of tabs, it is possible to search for the totals owed by a particular customer (better suited for the manual 
mode), provided their calls/service entries appear in the ‘In – Voice’ or ‘Out – Voice’ tabs (voice only). This is useful if you decided to 
do a search for a single number on the main tab. Click on the tab ‘In – Voice’ in order to show a total for this tab. Click on ‘Out – 
Voice’ to show the total for the 2nd tab. 
 

3.5. Data 
 
3.5.1. Price Lists 
 

 
 
Access: Main interface > Data > Price lists 
 
This is where price lists for voice and recurrent services are imported into Dynasoft TeleFactura. These lists are then accessed using 
the screen detailed in the following chapter 3.5.2 
 
A: Write the name of the list in the first box at the top of the screen, the path to the file by choosing the right file (click on the 
ellipsis), the type of price list (voice or services), the customer associated with the list and finally go to the ‘Actions’ drop-down 
menu, select ‘Add to list’ and click ‘OK’. Ensure you actually click on a selection in drop-down menus and not just write the 
information in the boxes. 
To modify a list, click inside the table to select a list, modify it and select ‘Modify’ under ‘Actions’ and click ‘OK’. 
To delete a list, click inside the table to select a list and select ‘Remove from list’. You might have to click on ‘Remove from db’ first 
if the file was imported. 
B: TeleFactura makes it possible to import a list that does not have country codes, the country labels or call types. It does this by 
filling in the missing data from a master list before importation of a price list. Simply select the master list from the drop-down menu 
before clicking the button ‘Import into db’ and TeleFactura will fill in the missing country codes, labels or call types in the price list to 
be imported. The importation of these master lists is made from the Master List screen in the settings menu. 
C: Click inside the table to select a list not already imported into the db, click on ‘Import into db’ to save the list in the system. A 
wizard will come up where the various fields in the list have to be identified (peak rate, dialling code,…). 
D: Click inside the table to select a list and click ‘Remove from db’ if the list was imported previously. 
 
Important: 
 
TeleFactura works on four levels when working with price lists during the billing process: it will try and look for a rate with which to 
rate a call first in the price list associated with a customer sub-group, then its customer group, then with the customer-specific price 
list, and finally in the base lists. This is useful as base lists can be designed as catch-all lists to ensure calls are always rated. See 
chapter 3.3.5 for more on customer groups and sub-groups. 
 
An additional safety level can be added when billing is being done: See last paragraph under chapter 3.5.2.1 below. 
 
The prices entered have to be free of any sales tax. 
 
Explanation of all default fields included with Dynasoft TeleFactura: 
 
1. Voice Services 
 
As a general rule in TeleFactura, rates are time-dependent and fees are applied to each call. 
 

 PeakRate1: Peak rate. 
 OffPeakRate1: Off-peak rate. 
 WeekEndRate1: Weekend rate. 
 PeakRate2: Additional peak rate. This cost is added to the peak cost PeakRate1 when calculating the cost of a call and 

multiplied by the duration. 

A 

B 

C 

D 



 

 OffPeakRate2: Additional off-peak rate. This cost is added to the off-peak cost OffPeakRate1 when calculating the cost of a 
call and multiplied by the duration. 

 WeekEndRate2: Additional weekend rate. This cost is added to the weekend cost WeekEndRate1 when calculating the cost 
of a call and multiplied by the duration. 

 PeakRate3: Additional peak rate. This cost is added to the peak costs PeakRate1 and PeakRate2 when calculating the cost 
of a call and multiplied by the duration. 

 OffPeakRate3: Additional off-peak rate. This cost is added to the off-peak costs OffPeakRate1 and OffPeakRate2 when 
calculating the cost of a call and multiplied by the duration. 

 WeekEndRate3: Additional weekend rate.  This cost is added to the weekend costs WeekEndPeakRate1 and 
WeekEndPeakRate2 when calculating the cost of a call and multiplied by the duration. 

 SetupPeakFee1: Setup fee for placing a call during peak times. 
 SetupOffPeakFee1: Setup fee for placing a call during off-peak times. 
 SetupWeekEndFee1: Setup fee for placing a call during weekend times. 
 SetupPeakFee2: Additional setup fee for placing a call during peak times. This cost is added to SetupPeakFee1. 
 SetupOffPeakFee2: Additional setup fee for placing a call during off-peak times. This cost is added to SetupOffPeakFee1. 
 SetupWeekEndFee2: Additional setup fee for placing a call during weekend times. This cost is added to SetupWeekEndFee1. 
 SetupPeakFee3: Additional setup fee for placing a call during peak times. This cost is added to SetupPeakFee1 and 

SetupPeakFee2. 
 SetupOffPeakFee3: Additional setup fee for placing a call during off-peak times. This cost is added to SetupOffPeakFee1 and 

SetupOffPeakFee2. 
 SetupWeekEndFee3: Additional setup fee for placing a call during weekend times. This cost is added to SetupWeekEndFee1 

and SetupWeekEndFee1. 
 SetupPeakDuration1: Duration of the initial stage of the call that is covered by the setup peak cost ‘SetupPeakFee1’ (in 

seconds). The per-minute PeakRate1 will then only be come into play after this number of seconds has passed. In the case 
of a billing model where calls are rated to the nearest 6 seconds after the first 30 seconds, a value of 30 would be written 
under this column. Write 6 in the ChargeRoundingPeak column. 

 SetupOffPeakDuration1: Duration of the initial stage of the call that is covered by the setup off-peak cost 
‘SetupOffPeakFee1’ (in seconds). 

 SetupWeekEndDuration1: Duration of the initial stage of the call that is covered by the setup weekend cost 
‘SetupWeekEndFee1’ (in seconds). 

 SetupPeakDuration2: Duration of the initial stage of the call that is covered by the setup peak cost ‘SetupPeakFee2’ (in 
seconds). 

 SetupOffPeakDuration2: Duration of the initial stage of the call that is covered by the setup off-peak cost 
‘SetupOffPeakFee2’ (in seconds). 

 SetupWeekEndDuration2: Duration of the initial stage of the call that is covered by the setup weekend cost 
‘SetupWeekEndFee2’ (in seconds). 

 SetupPeakDuration3: Duration of the initial stage of the call that is covered by the setup peak cost ‘SetupPeakFee3’ (in 
seconds). 

 SetupOffPeakDuration3: Duration of the initial stage of the call that is covered by the setup off-peak cost 
‘SetupOffPeakFee3’ (in seconds). 

 SetupWeekEndDuration3: Duration of the initial stage of the call that is covered by the setup weekend cost 
‘SetupWeekEndFee3’ (in seconds). 

 RateIncrementPeak: The time increment that the peak rates applies to, in seconds. If the rates shown in the PeakRate1,.. 
columns are in currency units (i.e. in GBP rather than pence, USD rather than cents,…), the values should be 60. If the 
rates are given in pence rather than pounds, cents rather than dollars, write 6000. 

 RateIncrementOffPeak: The time increment that the off-peak rates apply to, in seconds. 
 RateIncrementWeekEnd: The time increment that the weekend rates apply to, in seconds. 
 ChargeRoundingPeak: The nearest value that is used for rounding the duration of the calls and working out the total cost of 

these for peak times. Write 1 if the calls are billed per second, write 5 for a rounding of the cost up to the nearest 5 
seconds, etc… 

 ChargeRoundingOffPeak: The nearest value that is used for rounding the duration of the calls and working out the total cost 
of these for off-peak times. 

 ChargeRoundingWeekEnd: The nearest value that is used for rounding the duration of the calls and working out the total 
cost of these for weekend times. 

 MinimumChargePeak: Minimum billable charge as soon the caller successfully places a call during peak times. 
 MinimumChargeOffPeak: Minimum billable charge as soon the caller successfully places a call during off-peak times. 
 MinimumChargeWeekEnd: Minimum billable charge as soon the caller successfully places a call during weekend times. 
 MaximumChargePeak: Maximum charge levied on a call during peak times. 
 MaximumChargeOffPeak: Maximum charge levied on a call during off-peak times. 
 MaximumChargeWeekEnd: Maximum charge levied on a call during weekend times. 
 OtherPeakRate: TeleFactura makes it possible to measure the length of a call as a time-dependent variable and the fields 

above apply to this. Under his scenario and when CDRs are imported, the heading to use in the import wizard would be ‘Call 
duration’. However, it is also possible to measure the length of a call in terms of any other criteria (pulse-code 
modulation…). When importing a CDR, the heading of the column to use for this would be ‘Other measurement of call 
length’. The field in the price lists ‘OtherPeakRate’ is the rate that has to be used against this CDR heading in order to 
successfully rate a call. See chapter about voice/data CDR for more on this. 

 OtherOffPeakRate: Off-peak rate to apply to calls that make use of the CDR field name ‘Other measurement of call length’. 
 OtherWeekEndRate: Weekend rate to apply to calls that make use of the CDR field name ‘Other measurement of call 

length’. 
 MarginMultiplier: Margin added to the cost of a call instead of using the rates listed above. A column for the cost of a call 

has to have been identified in the CDRs for this margin to be used. See chapter on importing CDRs for this. A margin of 
30% would be written 1.30. Calls that use this system will be then be rated through the use of this value will which will be 
multiplied by the cost of the call that exists in the CDR being analysed. You may specify any numeric value. If nothing or 0 
is specified, the timed rates will be used to rate the call. 

 CallType: Type of the call as defined in the call settings screen. 
 CarrierCode: Code used to dial into the carrier’s services. 



 

 ActivateRoute: Tells the programme if this route is active and is available when building Least Cost Routing price lists. Write 
OK if the route is active. 

 
Set up duration fields (SetupPeakDuration, SetupOffPeakDuration...) are useful if you need to rate with a fixed rate the initial 
minutes of a call. The set up fees (SetupPeakFee1, SetupOffPeakFee1…) work in conjunction with these fields and are added up if 
more than one (SetupPeakFee1, SetupPeakFee2…) field is defined. The fields work together based on their number. For instance, 
SetupPeakFee1 is the setup fee for PeakRate1… 
 
2. Recurrent Services 
 
ServiceName: The name of the service. It is this name that will show on the invoices. 
ServiceCode: This is the code of the service that appears in the CDRs and that is used to link a CDR with an item in a price list (like 
‘ISDN 30 Access’ in the service CDR supplied by default with TeleFactura). This code is the set of characters that have to exist in 
both the price list and the CDR so this service can be billed successfully. 
ServiceSalesPrice: Sales price of service, i.e. the monthly fee usually levied for a subscription (e.g., Internet service…). 
ServiceCostPrice: Purchase price of the service. This field is used to work out the profit of each service. 
ServiceDiscount: Discount given to the service. This amount shows on the invoices and is deducted from the service price. In the 
customer’s accounts, under the ‘Service numbers’ screen, another discount field is given for each SN the amount of which is added 
to this price list-based discount when billing is carried out. 
MarginMultiplier: Margin added to the cost of the service instead of using the ServiceCost above. A column for the cost of a service 
has to have been identified in the CDRs for this margin to be used. You may specify any value: 30% margin would be written 1.30. 
This value will then be used and be multiplied by the cost item that exists in the CDR being analysed. 
ServiceRecurrence: Use the following symbols to specify the number of days the values identified here apply to: ‘D’ for daily, ‘W’ for 
weekly, ‘M’ for monthly, ‘Q’ for quarterly,‘Y’ for yearly, ‘F’ for fixed without any pro-rated calculation. 
ServiceDescription: Description of the service. 
 
Notes: 
 

 Make sure that no single or double quotes are present in the text values in all price lists. 
 Ensure that no non-numeric characters exist in columns of price lists where numeric values are expected. 
 The programme automatically adapts itself on what information is supplied to it via the price lists. For instance, if no 

MaximumUsageAllowed value is given or its value is nil, no billing for excess usage will be billed as it is assumed that the 
user can use as much bandwidth as he wants. 

 Services are pro-rated based on the dates start and end dates identified in the CDR data unless the service was marked 
with a fixed recurrence. 

 
Important (voice services only): 
 

 You need to have at least a peak, off-peak and weekend column in your lists and if relevant, matching minimum charges, 
set-up costs and calling fees. If you work with just one rate no matter the time of day, simply copy this single column and 
paste a copy of it next to it twice using a spreadsheet programme so that you end up with the 3 required columns. You can 
then import the three columns via a csv file into TeleFactura. As a failsafe measure, this is also done automatically by the 
programme: if the off peak and weekend rates columns are omitted on import, the programme will replicate the peak 
column twice to fill in the missing columns. 

 Dialling codes should not have any leading zeros or spaces. 
 All dialling codes have to start with matching country codes. For example, if you are based in France, all dialling codes for 

all sub-destinations in France have to have 33 at the start of the sub-dialling code. 
 All destinations in the list have to have a call type as defined in the Configuration screen, last tab or in your supplier’s call 

type tabs. 
 For destinations to be taken into account, all values under the field ActivateRoute need to hold the letters ‘OK’. 

 
All rates and costs have to use the decimal separator that is set in your Windows settings (dot or comma). 
 
Ability to add your own costs not already present by default in Dynasoft TeleFactura (voice services only): To add costs 
of your own, add them as you create the lists by writing an alphanumeric name with no spaces for this cost directly into the drop-
down menus of the wizard you get when pressing the button for importing lists into the database. Once this is done and to make the 
programme use these costs in the calculations of the costs billable to your customers, go to the configuration screen (option 3.C) 
and select the non-standards cost items you wish to take into account. Send us an email to support@dynasoft.net if you have a field 
you would like to integrate and don’t see how to do it with the current version. 
 
Check the example list provided and accessible in chapter 3.5.2 for an illustration of how price lists should be formatted. 
 
3.5.2. Price list details 
 



 

 
 

 
 
Access: Main interface > Data > Price lists in detail 
 
A: Select a price list by ticking a line. 
B: All the different destinations for the selected list show up in this table. The columns are made of the columns that were identified 
in the previous chapter. 
C: By using the first drop-down box under the table in C (point 2), you may select all the destinations in the active list, deselect 
them all or write the leading characters for a set of destinations you wish to select. Then click OK. For instance to select all countries 
that start with the letters ‘FRA’, write ‘FRA’ in the drop-down box, select ‘Country’ in the 2nd drop-down box to do the search for 
‘FRA’ on the country and click OK. 
D: Selecting one line of the table in B will show the content of the line in D. To modify this single line, click inside the cells in the first 
column in D and change the values there. The cells in this column (the first one) are sometimes a little difficult to modify: move the 
mouse while clicking repeatedly. Selecting more than one line in B will just show the column headers. Enter the values you wish to 
use for the selected line of table B. The drop-down menu under the table in D holds the system’s current call types should you need 
to modify these in the table under D. 
E: You may apply an action to one or more lines of the table in B by using the drop-down in E. To let the programme automatically 
add the call types, select a master price list and press the OK button next to it. You may apply a percentage to any of the columns in 
table B (provided they have numeric values) by filling in a margin multiplier and selecting the field in the field in the drop-down 
menu where the percentage should apply to. Press Ok to finish. 
F: Other: By choosing two or more lists in A, you may then click here to merge these lists into a Least Cost Routing list. See below. 
Click ‘CSV’ to create a csv file that can be imported in a spreadsheet programme. Click ‘HTML’ to create an html file that can be 
uploaded to a website. 
G: Once you are happy with all the changes you have made, click on ‘OK’ under ‘Update selected list in database’. 
 
3.5.2.1 Voice Services 
 
A percentage margin (see column named ‘MarginMultiplier’) can be used instead of the traditional time-dependent rates (peak, off-
peak rates…). This percentage will be applied to any cost field that appears in the CDR files/tables/web pages when these 
files/tables/web pages are rated using our price list. Dynasoft TeleFactura will apply this percentage system over the application of 
time-dependent rates as soon as values appear in the relevant price list and values also exist in the cost field of a CDR file/table. 
Dynasoft has introduced this system to enable the billing of calls in a market where numerous operators exist and where they 
appear and disappear quickly, essentially where service provision is volatile and keeping up-to-date price lists is arduous work. The 
same thing holds true for recurrent subscriptions (see below). If a percentage margin is set for these lists and a carrier cost figure is 
found in a CDR, then the programme will use the margin multiplier over the minute rates and will multiply the first figure by the 
second one to work out the cost of a call when running a billing session in.  
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It is possible not to use numbers in the dialling code column if your CDRs do not use digits but text for the numbers called. You still 
would need to identify the initial characters of these pieces of text and place them in the price lists’ dialling code column just as you 
would with normal dialling codes. 
 
TeleFactura makes it possible to modify the entries of a price list for each individual customer without having to re-import a whole 
new list from the Price lists screen. To do so, go to the customers’ accounts, go to their SN screen and right click over a SN and 
select the price list to be modified for this customer. When it is time to do some billing, TeleFactura will first use the rates that were 
modified for individual customers via this method. If no individual destination prices were modified, the main price list as associated 
in the SN screen will be used. 
 
Important: 
 
It is strongly recommended to limit the number of lines in all price lists as a large number of lines may slow down the optimal 
running of the program when billing. 
 
3.5.2.2 Recurrent Services 
 
Use this option to create price lists to apply to recurrent services located in CDR data. These lists must be associated with customers 
in the customers’ individual screens (Service numbers). 
 
If a margin multiplier is used to determine the sale price of the services, leave the field ‘Service Sales Price’ empty or equal to zero. 
Similarly, if the sales price of a service is not arrived at using a purchase price in the CDR data and a margin multiplier, leave the 
margin multiplier field empty or equal to zero in the price list. The programme will then use the sales price from the price list. Margin 
multiplier will be used over rates whenever these are defined in a price list, in a similar way to how this is done for rating voice 
services. 
 
TeleFactura will always calculate the sales and purchase prices to use based on the way CDR formats are defined. For instance, if a 
price is defined in a price list and is set to apply to the period of a month (ServiceRecurrence = ‘M’) and a CDR format was defined 
to represent daily CDRs, then TeleFactura will work out a daily price from the price list and use this to rate the CDRs. Conversely, if 
a price list holds daily prices and a CDR format was defined as holding monthly CDRs, then TeleFactura will work out monthly rates 
based on these daily prices. 
 
For the service recurrence, write ‘O’ (for one-time) for the sales price per CDR entry. Write ‘D’ for a sales price per day, ‘W’ for a 
price per week, ‘M’ for a price per month, ‘Y’ for year, ‘Q’ for quarter and ‘F’ for fixed without any pro-rated calculation. 
 
3.5.3. Invoices 
 

 
 
Access: Main interface > Data > Invoices 
 
View invoices created by the programme when selecting to save invoices in the main billing screen, whether using the manual or the 
automatic mode. Delete invoices and their corresponding data from here or double-click a line to open the files on screen. If the 
accounting add-on is used, deleting an invoice will delete it in either Xero or Sage Accounts. 
 
3.5.4. CDR Data 
 



 

 
 
Access: Main interface > Data > CDR data 
 
View or export all the CDR data the programme has rated under the billing’s manual or automatic modes and for voice/data or 
recurrent services. Select a line to delete, add a new line by going to the bottom of the table or modify data by going to the required 
cells in the table. 
 

3.6. Tools 
 
3.6.1. TeleFactura Web Access 
 

 
 
Access: Main interface > Tools > Web Browser 
 
The path to your Web Access is set in the configuration screen, point ‘4.C.4’. TeleFactura Web Access enables customers to securely 
access their balance online, download their invoices and check the calls that they made. 
 
3.6.2. TeleFactura Customer Relationship Management 
 



 

 
 
Access: Main interface > Tools > Web Browser 
 
The path to the TeleFactura CRM is set in the configuration screen, point ‘4.C.6’. TeleFactura CRM enables you to expand your 
business by allowing distributors to create customer accounts and follow-up on the activation of their account. 
 
3.6.3. FTP Tool 
 

 
 
Access: Main interface > Tools > FTP 
 
Add the FTP locations, login and password and if the server is classic FTP or SFTP. These are then used for the other FTP tools in 
Dynasoft TeleFactura. Note FTP server addresses have to follow this syntax: ftp://mydomain.com for FTP and sftp://mydomain.com 
for SFTP. 
 
Note that SFTP servers cannot be accessed from the FTP tool but this does not affect the CDR retrieval tool. If you have FTP and 
SFTP addresses and ports, set both here, use the FTP server to access files in FTP mode here and use the SFTP server to access CDR 
files in the CDR retrieval tool. 
 
3.6.4. Back-up Tool 
 



 

 
 
Access: Main interface > Tools > Back-up – MS Access only 
 
The data backed-up is the following: 
 

 TeleFacturaDB.mdb database located in the ‘Programme Files > Dynasoft > TeleFactura > Assets > System > MS Access’ 
directory 

 
3.6.5. Retrieval of CDR via FTP 
 

 
 
Access: Main interface > Tools > Retrieval of CDR via FTP 
 
Each CDR format that was identified in the configuration screen has to be associated with: 

 An ftp server, 
 A remote directory path, 
 A set of extensions for the files to be retrieved, 
 Whether the files should be unzipped, 
 If the programme should delete the zipped files after they have been downloaded, 
 How many days old should the files be for download 

 
You may either set the retrieval to operate automatically at each interval specified in the drop-down menu or manually using the 
button underneath. 
 
Files already on your local directories will not be overwritten by files on the ftp servers. Only new files will be saved locally in the 
individual CDR directories. This is also valid for zipped files as the programme compares files in a zipped folder with those that exists 
locally. Before it saves them. 
 
File extensions are case sensitive. 
 
3.6.6. Web Access Replication 
 



 

 
 
Access: Main interface > Tools >Web Access replication – MS Access only 
 
The mdb file located on a Web server can be updated using this functionality. Simply enter the name of the remote file, select the 
FTP site or disk location and finally the times when this update has to be done and TeleFactura will automatically update your 
database at the remote location. You may also perform a manual update. 
 
3.6.7. CDR file Mediation 
 

 
 
Access: Main interface > Tools > CDR file mediation 
 
This tool is used to convert raw CDR files as they come out of hardware equipment (gateways, switches,…) into formats Dynasoft 
TeleFactura can readily use. Identify a source and target directories and the type of conversion wanted. Dynasoft can integrate any 
other CDR file mediation as required by the customer. 
 
3.6.8. Messaging Tool 
 



 

 
 
Access: Main interface > Tools > Messaging 
 
This screen is used to configure the messaging functionality of Dynasoft TeleFactura. This is useful if the invoices of the customers 
have to be sent in bulk at the end of a customer’s billing run or manually for each customer’s invoice from this screen, the invoices 
screen or from within the customers’ accounts. See chapters 3.4.3 , 3.5.3 and 3.4.2.1 respectively. If you wish to write a series of 
email addresses in the field for the email address in each customer’s screen, separate these by a single comma with no blank 
spaces. 
 
Use the tabs to identify the subject line and message body of the messages for sending out the invoices, generating files using the 
SQL Builder, sending out email alerts if customers go over their credit limit, sending out email alerts if customers go over their 
allowance for their voice or data packages, sending out outstanding invoices by customers and sending the emails for the 
provisioning. 
 
The option ‘Use secure SMTP access’ will encrypt the connection to the SMTP server by establishing a TLS-type connection. 
 
For the messaging to work when running billing sessions, ensure you select to save invoices as TeleFactura will not be able to send 
any email if opening or printing invoices has been selected. 
 
The size of the message body for all types of messaging is limited to 5100 characters. 
 
All email address fields in TeleFactura can hold comma-separated lists of email addresses (myname1@mydomain.com, 
myname2@mydomain.com,..). 
 
The customer’s own first, last and company names, email address and invoice and customer numbers can be placed in the body of 
email messages using the following tags: 
 
<LASTNAME> for the customer's last name 
<FIRSTNAME> for the customer's last name 
<COMPANYNAME> for the customer's company name 
<EMAILADDRESS> for the customer's email address 
<INVOICENUMBER> for the invoice number 
<CUSTOMERNUMBER> for the customer number 
 
3.6.9. Import Data 
 

 
 
Access: Main interface > Tools > Import Data 
 
It is possible to import a file to add or update customers, distributors or suppliers; import new SNs; import new customer or general 
subscriptions and packages. This is useful if you wish to avoid having to painstakingly type the content of data lists from another 
system. 



 

 
1. Import new or update existing customer, distributor and supplier accounts 
 

There is no formal format to follow when importing contacts. Simply import any csv that holds any contact data you need. The 
system will auto generate contact numbers if none are identified on import. 
 
Ensure that the import list holds the contact numbers if a list has to be imported to update the contacts in the system. 
 

2. Import new customer SNs 
 
When importing SNs and their associated price lists, CDR format(s), start and end dates, write their names as one string with each 
name separated by ‘space+vertical bar+space’. An example for importing UK SN 3493456 for customer Cust_01 would be: 
 
Cust_01;3493456;44;MySalesPriceList1 | MySalesPriceList2 | MySalesPriceList3;MyPurchasePriceList1 | MyPurchasePriceList2 | 
MyPurchasePriceList3;MyCDRFormat1 | MyCDRFormat2 | MyCDRFormat3;01/05/2020;30/09/2020 
 
To associate customer SNs with base lists or customer-specific price lists, write the lines as in the example that follows: 
 
Cust_01;3493456;44;MySalesPriceList1 – Base list | MySalesPriceList2 – Cust_01 | MySalesPriceList3 – 
Cust_01;MyPurchasePriceList1 – Cust_01 | MyPurchasePriceList2 – Base list | MyPurchasePriceList3 – Cust_01;MyCDRFormat1 | 
MyCDRFormat2 | MyCDRFormat3;01/05/2020;30/09/2020 
 
The above means we are linking SN 3493456 with three sales price lists: a base list called MySalesPriceList1, a list specific to 
Cust_01 called MySalesPriceList2 and another list specific to this customer called MySalesPriceList3. Service start date is 01/05/2020 
and end date set here is 30/09/2020. Leave the end date blank if the service will always run. 
 
It’s also possible to write single price lists or CDR format names like so: 
 
Cust_01;3493456;44;MySalesPriceList1;MyPurchasePriceList1;MyCDRFormat1;01/05/2020;30/09/2020 
 
Entries in lists that require customers to exist in the system such as for bank details, Radius details… will be ignored if the customer 
accounts cannot be matched with existing one. 
 
Write 1 against column ‘Is DDI/SIM’ if this number is a DDI/SIM from an existing pool of DDI/SIM (See Assets > DDI/SIMs). If this 
is the case, then the programme will allocate the DDI/SIM with the customer account whose SNs are being imported. If the DDI/SIM 
does not exist in the DDI/SIM screen, the programme will import it into the list of available DDI/SIMs. 
 

3. Import new customer and general subscriptions 
 
For subscriptions, the import file should follow the formats below. Not all columns are needed when importing but the programme 
will require the following fields: customer number (if importing lists for more than one customer), a sales price, a recurrence and an 
item name. 
 
The columns of a general subscription are given below: 
 
Item activation date;Item purchase price;Item deactivation date;Item description;Item discount;Item name;Item quantity;Item 
sales price;Next bill date;Product category;Recurrence 
 
The columns of a customer subscription are given below: 
 
Branch/Department;Customer number;Item activation date;Item purchase price;Item deactivation date;Item description;Item 
discount;Item name;Item quantity;Item sales price;Next bill date;Product category;Recurrence;Service numbers 
 
The items’ recurrence needs to be one of the following letters: D (daily), W (weekly), M (monthly), Q (quarterly), Y (yearly), N (no 
recurrence) or O (one time). 
 
If the file does not have any SNs, then the programme will associate the items with every SN already in the system present for a 
particular customer. If the list has SNs, there should be separated by ‘space+hyphen+space’, as per the following example: ‘12345 | 
67890 | 54321 | etc…’. The programme will only associate a subscription with the SNs in that string if SNs are specified. It will not 
use these SNs to associate any previously existing charge with these SNs. Newly added SNs are linked to all price lists (voice and 
services) and CDR formats (voice/data and services) in the system.  
 

4. Import new customer and general packages 
 
The programme needs to have the data about general packages before one can import the associations of customers and their 
packages. Therefore, import the general packages first. Columns are: 
 
Name;Description;Recurrence;Customer type;Product category;Call types (voice);Number of minutes/calls or cost of calls 
(voice);Definition of package (minutes, calls or cost) (voice);Package code (data);Maximum usage allowed (data);Excess usage 
increments (data);Excess usage cost (data);Download/upload ratio (data);Quantity (subscriptions);Name (subscriptions);Quantity 
(inventory assets);Name (inventory assets);Purchase price;Discount;Sales price 
 
For the field ‘Definition of package (minutes, calls or cost) (voice)’, write M for minutes, C for calls and S for cost. Call types within 
the package have to be separated by a vertical bar. Separate the quantities for subscriptions and inventory assets with 
‘space+vertical bar+space’. The same goes for subscription names and inventory assets names. 
 



 

The items’ recurrence needs to be one of the following letters: D (daily), W (weekly), M (monthly), Q (quarterly), Y (yearly), N (no 
recurrence) or O (one time). 
 
An example of general package is given below: 
 
MyPackageName;MyPackageDescription;M;ALL;MyProductCategory;GSM | NTL;500;M;MyDataCode;5000000000;1000000;5;3:1;1 | 
3;MyInventoryAsset1 | MyInventoryAsset2;2 | 4;MySubscription1 | MySubscription2;4.99;2;9.99 
 
This package, called MyPackageName, associates a voice part, a data part and inventory assets as well as subscriptions and 
inventory assets. The voice part cover call types GSM and NTL, includes 500 minutes and is valid to all customer types (‘ALL’). It 
also includes a data part which the user can use up to 5 GB, with a download to upload ratio of 3:1. If his usage goes over this, they 
will be billed 5 monetary units for every MB used. Finally, this package includes the use of 1 inventory asset MyInventoryAsset1 and 
2 MyInventoryAsset2, as well as 2 subscriptions MySubscription1 and 4 MySubscription2. Purchase price of package is 4.99, discount 
is 2 and sales price is 9.99. 
 

5. Import general inventory items and DDI/SIMs 
 
Set Add asset back to 0 to mean the asset should not be added back to the inventory or pool of DDI/SIMs when an item’s 
deactactivation date has been reached with a customer. Write 1 if the item should be added back. If DDI/SIMs are associated with 
customers, after importing DDI/SIMs, the corresponding service numbers should be imported and marked as DDI/SIMs (Is DDI/SIM 
= 1). See point 2 above. 
 

6. Call types 
 
Import call types along with a description field, its call group, category and times of day and days of the week when peak periods 
occur in your system. Set the day of the week as a number: 0 for Monday, 1 for Tuesday, etc… 
 

7. Notes 
 

 Make sure that the import files contain only the data to be imported and not things such as column headers, for example. 
 Make sure that the fields that must contain numeric values such as quantity, sales price, etc ... contain only numeric 

values. 
 The vertical bars ‘ | ‘ and the hyphens ‘ – ‘ have to be preceded and followed by a blank space. 
 The fields in the files can follow any order and not necessarily the order given in the examples above. 
 The field separator can be: tabulator, semi-colon, comma, or space 
 If the programme finds a customer in the import list that does not exist, a new customer account will be created and the 

same goes for any non-existent package or subscription in the system but found in the list. 
 The columns in your file can be in any order, as you will be asked to map the fields when importing the file. 
 If the programme finds a new SN in an import file, it will enter it in that customer’s list of SNs. 

 
3.6.10. SQL Builder 
 

 
 
Access: Main interface > Tools > SQL Builder 
 
This utility lets the user create export jobs he can go back to and use to export data from the programme’s database. To create a 
job in mode 1, click the New button, give the job a name, a target folder where the files will be saved, an optional email address 
where the file needs to be sent to and finally select the table fields needed and click the right arrow key. Click the left arrow key to 
remove fields from the list of fields to be exported. Click the up and down arrow keys to move the order of the fields / final columns 
in the export file. Once a list of fields is selected, click Save at bottom of screen. Click the Edit button to return to the job and modify 
it (repath the target folder, rename the job or modify the fields to be exported). In mode 2, follow the same procedure, but instead 
of selecting fields, simply write a series of sql queries in the mode 2 tab. Only one select statement is allowed per job. Press the Set 
button to show the columns in the query, then save the job. Mode 3 supports more complex queries that use aliases, INNER JOINs, 
embedded SELECTs,… 
 
It is possible to associate values with values found in the database. TeleFactura sometimes uses codes (instead of the actual word) 
in order to store some of its data in the database. For example the payment method Cash is stored by default with the symbol 
‘*CH*’. You may convert this code to its normal meaning of ‘Cash’ when export files are done by entering both values in the table to 



 

the right of the screen and identify the field where this conversion has to be done. To do this after having selected the columns or 
written the query, click the Add button in the table at far right to add these associations. Likewise it is possible to enter one or more 
columns in the export file made up of a specific value that will be repeated on each line. For example if you wish that an export file 
contains a column with the same string of characters, use the small table at bottom right-hand corner. To do this, click Edit on a job, 
then add the values required in the small table using its Add button. Click the job’s Save button when done. 
 
3.6.11. Financial, Data and Quality of Service (QoS) Reports 
 

 
 
Access: Main interface > Tools > Reports > Financial reports 
 
Select the type of report required using the first drop-down menu and select the parameters needed to build the report from 1 to 9. 
The grouping criteria enables the report to work out sub-totals for specific groups of data as given in the drop-down menu. The 
ordering criteria will list the items in the report within each group of data as indicated. Click display to see the report. 
 
Individual items mean individual calls in the case of voice services, individual recurrent services or the individual itemisation of a 
package, subscription or inventory assets as it appeared in an invoice. 
 
The subscriptions billed reconciliation report only gives results for scenarios where the option to let the programme handle the 
resetting of the subscriptions is not ticked. (option ‘ab’ in the configuration screen, point ‘8.A’). SNs linked only show for MySQL and 
MS SQL Server. 
 
The program distinguishes two types of dates: the date associated with the elements of an invoice (i.e. the sections in the summary 
section of an invoice) and the date of the invoice itself. For example, if voice services were billed on 01/06/2020 for the period from 
01/05/2020 to 30/05/2020, the date associated with the invoice will be the 01/06/2020 while the items that make up the bill will 
have as date the upper date of the billing period that was selected when the billing was made, i.e. 30/05/2020 in the example here. 
 
This will impact how reports can be viewed and which dates to select to view them as follows: 

 The following reports use a date that corresponds to the upper date of the period that was billed: 
o Subscriptions billed reconciliation report 
o Revenue and profit report 
o Billed SNs reconciliation report 
o Usage report 
o Quality of service report 

 All other reports use a the date of the day the transaction was created. 
 
QoS parameters 
 
Here are the Quality of Service parameters TeleFactura is able to display and what they mean: 
 

 Answer Bid Ratio - ABR 
Add up all the bids resulting in answer signal, divide by all the bids and multiply by 100. It is similar to ASR except that it includes 
bids that do not result in a seizure. 

 Percentage Overflow - OFL 
Overflow bids (to another circuit group or to a circuit busy signal) x 100 / Total bids for the circuit group (or all circuit groups to a 
destination). % OFL indicates the relationship between the total bids offered to a route or destination, in a specified period of time 
and the quantity of bids not finding a free circuit. It will therefore, give an indication of the overflow from one route to another or the 
bids that fail because all routes to a destination are busy. 

 Bids per Circuit per Hour - BCH 
BCH is an indication of the average number of bids per circuit in a specified time interval. It will therefore identify the demand and, 
when measured at each end of a both-way-operated route, will identify the direction of greater demand. Bids per hour / Quantity of 
circuits available for service. 

 Answer Seizure Ratio - ASR 
Add up all seizure resulting in answer signal, divide by all the seizures and multiply by 100. 

 Seizures per Circuit per Hour - SCH 
Seizures per Hour divided by Quantity of circuits available for service. SCH is an indication of the average number of times each 
circuit in a route is seized in a specified time interval. When related to the expected values of average call holding times and 
effective call/seizure rate for the route, it will give an indication of the effectiveness of the service being offered. 



 

 Network Effectiveness Ratio - NER 
Add up all the seizures resulting in answer signal, add user busy, add ring no answer, add terminal rejects, add unavailability, divide 
by all the seizures and multiply by 100. 

 Congestion Ratio - CR 
All seizures / All bids and multiply by 100. 

 Greatest Occupancy - GO 
Occupancy can be represented in units, for examples, erlangs, hundred calls-seconds (CCS) or as a percentage. It can be measured 
as a total for a destination or for a route and as an average per circuit on a route. This parameter will show usage and identify 
unusual traffic levels. The detection of the occupancy of a telephone line is carried out by identifying the actual speech signals from 
amongst all the signals sampled or those of a telecommunication channel. TeleFactura measures it as the total for the dates selected 
by the user for all calls made. 

 Average Holding Time - AHT 
Traffic / Call attempts, in seconds. AHT is defined as the duration of a call from receipt of a 200 OK and an associated BYE message 
indicating call completion. 

 Mean Holding Time per Seizure - MHTS 
This is the total holding time divided by the total number of seizures and can be calculated on a route basis or for switching 
equipment. Holding Time (HT) is the period of time a server is busy on a call. The holding time includes the channel request and 
seize time, the message length and the hang and the squelch time. 

 Average Conversation Time - ACT 
Average holding time * (All Seizures/Seizures with Answer Signal), in seconds. 

 Revenue Generated - RG 
Average Conversation Time * All Seizures * (Charge/60), in money. 

 Average Call Duration - ACD 
Duration of calls added up / Number of calls, multiply by 100. 

 Average Post Invite Delay -APID 
This is the average of Time of Status Indicative Response - Time of INVITE. In a successful request attempt, PID is defined as the 
time interval from the moment the INVITE message containing the necessary information is passed by the originating agent or user 
to the intended mediation or destination agent until a response is received indicating an audible or visual status of the INVITE 
request. 

 Average Post Dial Delay - APDD 
This is the time between punching in the last digit of a telephone number and receiving a ring or busy signal. 

 False Answer Supervision - FAS 
FAS flags potential false billing by detecting problematic communication between a public switched telephone network (PSTN) and 
the gateways that manage a call to proper termination. In a common problem scenario, a telephone call is mishandled by the 
gateways of a Wide Area Network, so that the calling party is billed for an incomplete call to a busy signal.  

 Busy Hour Call Attempts BHCA, Busy Hour Call Completion BHCC 
BHCA is the number of telephone calls attempted at the busiest hour of the day (peak hour) and the higher the BHCA, the higher the 
stress on the network processors. BHCA is not to be confused with busy hour call completion (BHCC) that measures the throughput 
capacity of the network. If a bottleneck in the network exists with a capacity lower than the estimated BHCA, then congestion will 
occur resulting in many failed calls and customer dissatisfaction. 

 Average Answer Time Response - AATR 
 Call Completion Ratio - CCR 

Volume of release cause OK / Volume of release causes. It expresses the ability of the system to successfully assign and also 
connect , without problems, a radio circuit for use by subscribers when they wish to receive or place a wireless call. 

 Call Failure Ratio - CFR 
Volume of release cause failure / Volume of release causes. 

 Switch Call Completion Ratio - SCCR 
It expresses the ability of the system to successfully deliver a call to not only the radio environment but also to the PSTN. An 
unsuccessful call would be a case in which the party receiving the call -whether the PSTN or the wireless network- does not answer 
the call or is blocked due to facilities not being available. 

 Billing Call Completion Ratio - BCCR 
It expresses the number of calls that are successfully completed and that can be billed, in comparison to all the other attempts to 
complete a call, which could also mean calls that are not billed. 

 Most Costly Numbers – MCN 
Ten numbers most costly to ring. 

 Most Frequently Dialled Numbers - MFDN 
Ten most frequently dialled numbers. 
 
When specifying the location of each parameter value on importing a new CDR, the following fields have to contain only numeric 
values: 
 
Quantity of circuits available 
Occupancy 
Holding time 
Post dial delay 
Post invite delay 
Answer time response 
 
3.6.12. Supplier Provisioning 
 



 

 
 
Access: Main interface > Tools > Supplier provisioning 
 
This section requires bespoke software development by Dynasoft. 
 
This section is used when new customers require being activated with a distributor or supplier. Double-click on a customer to create 
SNs or accounts and send an advice email message to a distributor or supplier associated with the customer. To configure this 
section, go to the configuration menu. 
 
3.6.13. Web Browser 
 

 
 
Access: Main interface > Tools > Web browser 
 
The Web browser includes most of the common buttons found in a standard Web browser (forward, back,…). It’s possible to load a 
file from disk using the ellipsis button next to the address bar. TeleFactura also makes it possible to preload URLs for each end-user 
of the software so they can quickly navigate to Web sites. 
 
3.6.14. LCR 
 



 

 
 
Access: Main interface > Tools > LCR 
 
(Voice services only) 
 
Read the captions on this screen together with the information below. 
 
1. Select the voice price lists to analyse. 
2. Select the columns that will show data in your new list. For example if you wish to show the countries, dialling codes, peak and 
off-peak rates in the LCR, you would click all four columns. 
3. Identify the columns that will be used to work out the lowest rate between the lists. These have to contain numeric data. If you 
wish to only minimise the peak-times column in the previous example, you would only click the peak-times column. 
4. You may select between two methods to build your list: 

 By selecting a field in the drop-down menu you will force the new list to use the operator/carrier code of the list that has 
the lowest cost for this particular rate, no matter the actual differences in the other rates. So for example whilst you may 
have a cheaper rate for off-peak times for list A, since you chose to use peak rates as the main criteria in the drop-down 
menu, the LCR list will use list B, because it has a cheaper rate for peak rates. 

 One that will work out the lowest rates for each type of rate (peak, off-peak,…) from all the base lists. You then would have 
for instance a list with an operator code for each period of the day (peak times, off-peak times,…). 

5. Set the main reference criterion to be used, meaning, what do we compare between the different base-lists to build the LCR list? 
The dialling code, the destination,…? This criterion has to show the same data for this particular column and for all lists concerned. 
6. For all the other data not selected in 2, which list will be used to fill in the columns of the new list? 
7. Select the field that identifies the operator dialling code. This is needed to build the new list. It is normally the CarrierCode. 
8. When a comparison is done between rates of several operators, some rates come out as being cheaper via general codes as 
opposed to city-specific codes for instance (e.g., Spain 34 as opposed to Madrid 3491). The programme can make it possible to 
select the more attractive code and carrier. For example if Carrier A offers a cheaper rate to calls to Spain than Carrier B and any of 
its sub codes, but Carrier A does not list the code 3491 for Madrid, but Carrier B does, then the programme will use the more 
general dialling code 34 that Carrier A does have and route all calls through Carrier A. This is because Operator A has better prices 
than Operator B, even though he does not show a rate for Madrid in his price list. For this option to work, call types have to be 
identified in each of the price lists. Use these types, so that destinations with long dialling codes and short relevant ones have the 
same call type. The programme will only compare similar call types together for the same initial digits and will ignore destinations 
that might display shorter codes, but that are not routable for a particular long code. For instance, say we have in a list code 
3369699 for France-Mobile-Orange and code 336, France-Mobile-Others, in another list. This list also shows a destination with code 
3369699, but that is more expensive. You will have to identify these with 2 separate types as the 336 code can’t be used for routing 
France-Mobile-Orange calls. 
9. Select if only one (the one with the smallest cost) figure is to be given for each minimised cost item or if each cost item (peak 
rate,…) should show rates from smallest to highest. In the latter case the list will not be saved in the database but in a text file. This 
is what is meant as multiple routes. 
 
Once the list has been built, you will find the carrier code for each destination in the carrier code column as a single number or as a 
string separated by slashes depending on what you chose in 3. In the latter case, the slash-separated values correspond to the 
times of day when the carrier code can be used. 1666/1587/1875 would mean that it is best to use carrier with code 1666 for peak 
times, 1587 for off-peak times and 1875 for weekend times if these three columns were selected in 2 to make the analysis. 
 
For lists with a choice of multiple routes, each price associated with its corresponding carrier code from least to highest will show. 
 
Notes: 
 

 LCR lists cannot be used as base to build other LCR lists. 
 Make sure you have identified carrier codes (CarrierCode), Call Types and wrote the letters ‘OK’ in the ‘ActivateRoute’ 

column for each list to let TeleFactura know that a particular route (i.e. an A-Z destination) is active. 
 Ensure that you are selecting columns with numeric data where required. 
 Let the programme run its course all the way to the end when building a list. It might take a good few minutes, depending 

on the size of the original lists. 
 

3.7. Assets 
 



 

3.7.1. DDI/SIMs 
 

 
 
Access: Main interface > Assets > DDI/SIMs 
 
Use this screen to enter DDI/DID and SIM card numbers. 
 
DDI/SIMs numbers can be entered via this screen along with 8 parameters for each one of these numbers. The numbers entered 
here are accessible directly from the SN screen inside in each customer’s screen so that they can be assigned to the customer. 
 
To change the association that was done between a customer and a DDI/SIM and do so with another customer, will transfer the 
ownership of the DDI/SIM and its corresponding service number to this new customer. To click and empty the identification of a 
customer and his/her DDI/SIM will cause the deletion of the service number that corresponds to this DDI/SIM from the customer’s 
account. 
 
3.7.2. Inventory 
 

 
 
Access: Main interface > Assets > Inventory 
 
Inventory assets can be entered via this screen along with 22 parameters for each one of these assets. The status, warehoused and 
categories parameters are configured in the settings menu of the programme. Furthermore, the assets entered here are accessible 
directly from the ‘packages and subscriptions’ screen in each customer’s screen so that they can be sold to the customers. 
 
3.7.3. Packages 
 



 

 
 
Access: Main interface > Assets > Packages 
 
(Voice and data services only) 
 
Add as many packages as are required using the controls on the right of the screen. Write the following: 

 Name of the package 
 Description. Name and description will show on the customers’ invoices where relevant 
 A recurrence 
 The type of the customer receiving the calls (important: not the customer making the calls - Select ‘ALL’ if a package 

applies to all customer types) 
 The product category of the package 
 The following parameters depending on whether a package has a voice and/or data part: 

o Voice part: 
 The call types that should be linked to each package. Use the controls under heading ‘Identify the call 

types’ to add or remove call types to and from each package. Care should be taken not to add packages 
that are likely to clash or overlap each other. For instance, call types should be used once per package 
and per customer to avoid any conflict when the customer’s calls are finally billed. 

 The number of minutes, number of calls or cost of calls under heading ‘Package is defined as’. Write 0 in 
the number of minutes of a package to signify that there is no such limit to the package. 

o Data part: 
 Package code (not required) 
 Package allowance (Bytes) 
 Excess usage increments (Bytes)Excess usage cost 
 Excess usage cost 
 Download/upload ratio 

o Subscriptions/Inventory assets: 
 Select if a subscription or an inventory asset has to be included in the package, then select 
 Name of subscription or asset 
 Quantity 

 A sales price 
 A discount 
 A purchase price 

 
The subscriptions added to a package will always appear on the invoices no matter the last date billed or the subscription’s 
recurrence. 
 
Modifying the price of a package will modify the price of any such package that has been added to a customer’s account. To change 
the name and description of packages already associated with customers, check the last option above the Actions menu. Not 
checking this box will make only the other elements of the packages already associated to customers to change: price, call types,... 
 
By default, all costs of packages are not pro-rated when billed. In order to pro-rate packages, ensure option ‘au’ is ticked in point 
‘8.A’ of the configuration screen. 
 
The way that the excess fee is worked out is TeleFactura will apply the ratio to the totals of bytes downloaded and uploaded and the 
fee is then applied to whichever one is over the limit. 
 
Here is how it does it: 
 
From a price list: 
Maximum usage allowed (bytes): 107374182400 
Excess usage increment (bytes): 1073741824 
Excess usage cost: 1.3 
Download/upload ratio: 3:1 
 
Usage was: 



 

Total bytes downloaded: 117211803541 
Total bytes uploaded: 41551825396 
 
TeleFactura will work out the excess fee as follows: 
 
x = 107374182400 * 3 
y = 107374182400 * 1 
 
a = 117211803541 - x 
b = 41551825396 - y 
 
The highest value between a and b will be used to work out the fee as follows: 
 
Assuming a > b, then k = 1.3 * (a / 1073741824) where k will be the fee for excess usage. 
 
Write 0 for the fields MaximumUsageAllowed, ExcessUsageIncrements, ExcessUsageCost, DownloadUploadRatio if a package is 
unlimited. 
 
For the package recurrence, write ‘O’ (for one-time) for the sales price per KB. Write ‘D’ for a sales price per day, ‘W’ for a price per 
week, ‘M’ for a price per month, ‘Y’ for year, ‘Q’ for quarter and ‘F’ for fixed without any pro-rated calculation. For a recurrence ‘O’, 
the elements MaximumUsageAllowed, ExcessUsageIncrements, ExcessUsageCost, DownloadUploadRatio will be ignored. 
 
Important: 
 
Whenever billing work is done, TeleFactura marks those calls that fall within a package and makes them unavailable either to 
another subsequent billing period for the package or to a bill run that goes back in time to a period that predates the last correct bill 
run that was done where the package appeared. This is to ensure that calls are not given away with a package more than once and 
to enforce packages scrupulously. The reasoning is that one billed period is supposed to follow another chronologically and calls that 
were given away with a package should not be expected to be given more than once. 
 
So for instance if you ran a creation of an invoice in automatic mode from 01 May 2020 to 31 May 2020 and got a package 
previously to show up with an end date of the 30 April 2020, the package will appear for the month of May as intended and the calls 
that fall within this package won’t be included in the totals of the summary part of the Voice services section. This is how we expect 
it. However if you then tried to bill the same period again, the package will not show and the calls that had been marked as 
belonging to the May period will not be billed individually and will not increase the totals under the Voice services section. For the 
package to carry on showing, you will have to bill the period that follows the last full period where the package appeared, in this 
case the month of June. 
 
In order to reset a package and get the calls that were included with a package to show again, reset the start date for a package in 
the contacts screen (click on ‘Reset the subscriptions’ -This will reset all your subscriptions.) or the customer’s account (packages 
and subscriptions screen, click on the package and select ‘Reset dates only’, then ‘OK’). Note resetting a package will only reset the 
dates. 
 
The prices entered have to be free of any sales tax. 
 
3.7.4. Subscriptions 
 

 
 
Access: Main interface > Assets > Subscriptions 
 
It is possible to add items with TeleFactura that are not related to phone calls, data or recurrent service items such as: Internet 
subscriptions, phone cards, etc… Use this interface for this purpose. Items in this table are available to all your customers, via the 
customer’s subscriptions screen. To add an item, use the controls above the table. Write the name of the item, its description, the 
quantity, how often it is to be billed, the item’s supplier, a supplier reference, the activation and deactivation dates, a product 



 

category, the purchase price, the discount given if relevant, the sales price and finally if the first period billed will be free. The 
activation and deactivation dates are the dates after which and until which the item will show as being available for billing in the 
customers’ packages and subscriptions screen in their individual screen. 
 
If the tick box under the end date is ticked, the programme will propagate the same end date to all the other items in the list in the 
table. 
 
The prices entered have to be free of any sales tax. ‘No recurrence’ is similar to ‘One time’ but here the entire period is billed as one 
period from the activation date to the item’s deactivation date. The difference is terms of invoicing will be that no-reccurence items 
have an end date on the customers’ invoices whereas one-time items have a single date. 
 
By default, all costs of subscriptions are not pro-rated when billed. In order to pro-rate subscriptions, ensure option ‘n’ is ticked in 
point ‘8.A’ of the configuration screen. 
 

3.8. System 
 
3.8.1. User accounts 
 

 
 
Access: Main interface > System > User accounts 
 
Use this screen to create user accounts and allocate access rights to them via the table on the right-hand side. The login box when 
TeleFactura is opened would then be used to let in the users defined here. 
 
3.8.2. Record Locking 
 
Access: Main interface > System 
 
Reset the system variables that are used for managing user record locks. This reset can also be done from the configuration screen, 
via point ‘7.A.3’. 
 
3.8.3. Customer SNs 
 
Access: Main interface > System 
 
Reset and rebuild the customer SNs in case these fail to bill. This reset can also be done from the configuration screen, via point 60. 
 
3.8.4. Customer SNs and Subscriptions 
 
Access: Main interface > System 
 
Reset and rebuild the association between a customer’s subscriptions and packages and all their SNs. This reset can also be done 
from the configuration screen, via point ‘7.A.6’. 
 
3.8.5. Customer Transactions and Invoices 
 
Access: Main interface > System 
 
TeleFactura will only show in the invoices screen, those invoices that were saved as files when working in the billing screen. Select 
this option in order to reset and reconcile the content of the screens for customer billing and that of the invoices. This reset can also 
be done from the configuration screen, via point ‘7.A.7’. 
 

3.9. Tasks 
 



 

 
 
3.9.1. Invoices 
 
Access: Main interface > Tasks 
 
Open the folder where your invoices are located. 
 
3.9.2. Price lists 
 
Access: Main interface > Tasks 
 
Open the folder where your pricelists are located. 
 
3.9.3. Voice/data CDR 
 
Access: Main interface > Tasks 
 
Open the folder where your CDR files for voice services are located. 
 
3.9.4. Services CDR 
 
Access: Main interface > Tasks 
 
Open the folder where your CDR files for recurrent services are located. 
 

3.10. Help 
 
3.10.1. About … 
 

 
 
Access: Main interface > Help > About … 
 
Click on the buttons for more information on our services and to purchase Dynasoft TeleFactura from our Website. 



 

 

3.11. External Add-ons 
 
3.11.1. TeleFactura Web Access 
 

 
 

 
 
Access: Web application supplied by Dynasoft Ltd 
 
This application allows your customers and distributors to connect and do the following: 

 View and edit contact information 
 Consult financial data, such as current balance, usage for voice and data packages that have been activated, view 

transactions, download invoices and price lists, search of calls made. 
 Consult the financial data with charts and graphs 
 Pay for invoices and buy subscriptions and packages using Paypal and Authorize.net (requires activation of add-on). 
 Access a help-desk application for your customers and distributors. This application includes a separate portal for authorised 

administrators (requires activation of add-on). 
 
For the Web Access (WA) to work, install all the files provided by Dynasoft on the web server that will host the portal. The file 
structure has to be preserved when unzipping the installation file. 
 
Changes need to be made to the configuration files. These are: 



 

 In the ASPX pages, modify, remove or translate the elements of text required. 
 Do not remove the elements that are marked with the tags ‘<asp:…></asp:…>‘ as these are needed for the WA to work 

properly. To hide certain sections (e.g., the customer balance,…), simply change the value of the visible parameter from 
true to false. 

 In the ‘web.config’ file located in the root directory, a number of settings under ‘appSettings’ have to be entered as follows: 
o AppSettings: 

 The type of database system you wish to use: ‘MySql’ or ‘MsSql’ 
 Connection strings to the database under ‘Database Connection String - Main’: Example for MsSql or 

MySql ‘Server=MyServer;Dsn=MyDSN;Database=MyDB;trusted_connection=Yes’ 
 Connection strings to the database under ‘Database Connection String - Linq’: Example for MsSql 

‘Server= MyServer;user id=MyUsername;password=MyPassword;persist security 
info=True;database=MyDB’ and for MySql 
‘Server=MyServer;Uid=MyUsername;Pwd=MyPassword;Database=MyDB;’ 

 The local path to a folder where the downloadable result sets for searches made via the WA will be saved 
 The path to the folder and file for the error log 
 The redirect page 
 Subject line of the email message sent for the retrieval of user’s details 
 Body of the email message sent for the retrieval of user details 
 Payment success message to show when a payment has been successful 
 Payment failure message to show when a payment has failed, and finally 
 The queries and names of queries to be used in the WA’s statistics section for customers and distributors: 

voice services, data services, subscriptions and financial data. The queries included in the web.config by 
default are ones that are compatible with MsSql only. 

 Example of the section ‘appSettings’: 
 

  <appSettings> 
    <!--***MODIFY HERE***--> 
    <add key="Application Name" value="Dynasoft TeleFactura Web Access"/> 
    <add key="Application Version" value="6.21"/> 
 
    <!--MySql or MsSql, comment out lines not needed--> 
    <add key="Database Type" value="MsSql"/> 
    <!--Best strings--> 
    <add key="Database Connection String - Main" value="Driver={SQL 
Server};Server=xxx;dsn=TeleFacturaDB_MSSQL_DSN;uid=xxx;pwd=xxx;database=TeleFacturaDB;persist security 
info=true;"/> 
    <add key="Database Connection String - Linq" value="Driver={SQL 
Server};Server=xxx;database=TeleFacturaDB;user id=xxx;password=xxx;persist security info=true;"/> 
    <!--Alternatives--> 
    <add key="Database Connection String - Main" value="Provider=MSDASQL.1;Persist Security Info=True;Data 
Source=TeleFacturaDB_MSSQL_DSN;uid=xxx;pwd=xxx;"/> 
    <add key="Database Connection String - Linq" 
value="Server=xxx;Uid=xxx;Pwd=xxx;Database=TeleFacturaDB;integrated security=true;"/> 
    <add key="Database Connection String - Linq" value="Server=xxx;User 
id=xxx;password=xxx;database=TeleFacturaDB;integrated security=True"/> 
     
    <add key="Database Type" value="MySql"/> 
    <add key="Database Connection String - Main" 
value="Server=xxx;Dsn=TeleFacturaDB_MySQL_DSN;Database=TeleFacturaDB;trusted_connection=Yes;"/> 
    <add key="Database Connection String - Linq" 
value="Server=xxx;Uid=xxx;Pwd=xxx;Database=TeleFacturaDB;integrated security=true;"/> 
     
    <add key="Local Path to CDR Download Folder" value="C:\...\Assets\cdrs"/> 
    <add key="Local Path to Log File" value="C:\...\Assets\logs\TeleFacturaWALog.txt"/> 
    <add key="Web Access Redirect Page" value="http:\\www.dynasoft.net"/> 
    <add key="Password Retrieval - Subject Line" value="Dynasoft Telefactura WA - Password assistance"/> 
    <add key="Password Retrieval - Body Message" value="Dear Customer,&lt;br&gt;&lt;br&gt;Your username for 
Dynasoft TeleFactura WA is: [UserName]&lt;br&gt;Your password is: [UserPassword]&lt;br&gt;&lt;br&gt;Best 
regards,&lt;br&gt;&lt;br&gt;Dynasoft Ltd"/> 
    <add key="Payment Success Message" value="Thank you [FirstName] [LastName] for your payment of [Currency] 
[Amount]!&lt;br&gt;The email address used for this payment was '[EmailAddress]'.&lt;br&gt;The payment service's 
transaction id for this payment is '[TransactionID]'.&lt;br&gt;Our order id or invoice number for this payment is 
'[OrderID]'."/> 
    <add key="Payment Failed Message" value="The payment has failed. Please get in touch with your financial 
institution."/> 
    <add key="Statistics Voice Services Query - Customers" value="SELECT TOP 10 Customer_Call_Group AS COLUMN1, 
ROUND(SUM(Customer_Call_Cost), 2) AS COLUMN2 FROM VoiceAutoCRCustomerInv WHERE Date_Time_Called &gt;= 
DATEADD(DAY, -9000, GETDATE()) AND Customer_Index = [CustomerID] GROUP BY Customer_Call_Group ORDER BY 
ROUND(SUM(Customer_Call_Cost), 2) DESC"/> 
    <add key="Statistics Voice Services Name - Customers" value="Top 10 call groups - Last 3 months"/> 
    <add key="Statistics Plans Query - Customers" value="SELECT TOP 10 ItemCriteria AS COLUMN1, 
ROUND(SUM(SubSalesTotal), 2) AS COLUMN2 FROM AutoCRCustInvMain WHERE DateTimeBilled &gt;= DATEADD(DAY, -
9000, GETDATE()) AND ContactIndex = [CustomerID] AND ContactType = 0 AND (ItemType = 1 OR ItemType = 2) 
GROUP BY ItemCriteria ORDER BY ROUND(SUM(SubSalesTotal), 2) DESC"/> 
    <add key="Statistics Plans Name - Customers" value="Top 10 plans - Last 3 months"/> 
    <add key="Statistics Service Charges Query - Customers" value="SELECT TOP 10 ItemCriteria AS COLUMN1, 
ROUND(SUM(SubSalesTotal), 2) AS COLUMN2 FROM AutoCRCustInvMain WHERE DateTimeBilled &gt;= DATEADD(DAY, -
9000, GETDATE()) AND ContactIndex = [CustomerID] AND ContactType = 0 AND ItemType = 4 GROUP BY ItemCriteria 
ORDER BY ROUND(SUM(SubSalesTotal), 2) DESC"/> 
    <add key="Statistics Service Charges Name - Customers" value="Top 10 service charges - Last 3 months"/> 
    <add key="Statistics Financials Query - Customers" value="SELECT TOP 10 ItemCriteria AS COLUMN1, 
ROUND(SUM(SubSalesTotal), 2) AS COLUMN2 FROM AutoCRCustInvMain WHERE DateTimeBilled &gt;= DATEADD(DAY, -
9000, GETDATE()) AND ContactIndex = [CustomerID] AND ContactType = 0 GROUP BY ItemCriteria ORDER BY 
ROUND(SUM(SubSalesTotal), 2) DESC"/> 
    <add key="Statistics Financials Name - Customers" value="Top 10 spend areas - Last 3 months"/> 



 

    <add key="Statistics Voice Services Query - Distributors" value="SELECT...WHERE...[DistributorID]"/> 
    <add key="Statistics Voice Services Name - Distributors" value="Top 10 customer call groups - Last 3 months"/> 
    <add key="Statistics Plans Query - Distributors" value="SELECT...WHERE...[DistributorID]"/> 
    <add key="Statistics Plans Name - Distributors" value="Top 10 customer plans - Last 3 months"/> 
    <add key="Statistics Service Charges Query - Distributors" value="SELECT...WHERE...[DistributorID]"/> 
    <add key="Statistics Service Charges Name - Distributors" value="Top 10 customer service charges - Last 3 
months"/> 
    <add key="Statistics Financials Query - Distributors" value="SELECT...WHERE...[DistributorID]"/> 
    <add key="Statistics Financials Name - Distributors" value="Top 10 spend customers - Last 3 months"/> 
  </appSettings> 
    
Example connection strings for MySql: 

 
<add key="Database Type" value="MySql"/> 
<add key="Database Connection String - Main" 
value="Server=localhost;Dsn=TeleFacturaDB_MySQL_DSN;Database=TeleFacturaDB;trusted_connection=Yes;"/> 
<add key="Database Connection String - Linq" 
value="Server=localhost;Uid=MyUsername;Pwd=MyPassword;Database=TeleFacturaDB;"/> 

 
 Provided the Payments Services add-on has been activated, open the web.config file and change the settings below. The 

web.config file for the Payments Services is normally installed under the following path if the Web Access was installed by 
Dynasoft on your server: C:\inetpub\wwwroot\TeleFacturaWA\Payments. 

o Review the tag elements required for each payment service used (PayPal, AuthorizeDotNet, Skrill, SagePay). 
o Example of the section ‘Paypal’ and ‘AuthorizeDotNet’ sections: 

 
  <PayPal> 
    <add key="PayPalUsername" value="mypaypal@emailaddress.com"/> 
    <add key="PDTToken" value="xxx"/> 
    <add key="PayPalSubmitUrl" value="https://www.paypal.com/cgi-bin/webscr"/> 
    <add key="PayPalReturnUrl" value="http://mywebsite.com/TeleFacturaWA/Payments/PayPal/PDTSuccess.aspx"/> 
    <add key="APIUsername" value="mypaypalapiusername"/> 
    <add key="APIPassword" value="mypaypalapipassword"/> 
    <add key="APISignature" value="mypaypalapisignature "/> 
    <add key="APIVersion" value="57.0" /> 
  </PayPal> 
  <AuthorizeDotNet> 
    <add key="AuthorizeDotNetEmail" value="myauthorizedotnet@emailaddress.com"/> 
    <add key="AuthorizeDotNetLoginID" value="myauthorizedotnetloginid"/> 
    <add key="AuthorizeDotNetTransactionKey" value="myauthorizedotnettransactionkey"/> 
    <add key="AuthorizeDotNetSubmitUrl" value="https://authorize.net/gateway/transact.dll"/> 
    <add key="AuthorizeDotNetReturnUrl" value="http://mywebsite.com/TeleFacturaWA 
/Payments/AuthorizeDotNet/PDTSuccess.aspx"/> 
  </AuthorizeDotNet> 

 
For the user to be able to download the customer’s invoices from the WA, a local path to a folder where these are located has to be 
defined in each customer’s options screen in their account (Options 2 > Point 13). TeleFactura saves invoices in that folder. The 
same is done for the distributors and for the customers’ price lists. 
 
The user name and password for customers/distributors to access the WA is entered for each customer/distributor in their individual 
account screen. 
 
Certain characters are not allowed when defining customer, administrator and admin user names and passwords. The ASCII values 
for the characters that are allowed are as follows: 
 
33, 35 to 38, 48 to 57, 64 to 90, 97 to 122. 
 
On the ‘Your data’ ASPX page, your customers can display their current balance, billing items, downloadable invoices and price lists 
and view voice and data package usage. They can also search phone calls and data items (bytes downloaded) by using the following 
filters: 
 

 An upper and lower date 
 The way results need to be displayed and grouped (by individual item, day, month or year) 
 The number called 
 The type of call, as these appear on the invoices 
 The call group 
 Select if the next controls apply to the voice or dart part of the billing process 
 The dialling code 
 The originating number or SN 
 The package 
 The associated customer, if the logged user is a distributor or a customer that is referring other customers 
 The pre-defined department/branch for a customer (See chapter 3.4.2.1) for voice or data services 
 The name of the carrier (MCI…), provided this name is the one that was used to identify the type of CDR in the 

configuration screen 
 
For the carrier name and number called, it is possible to enter only the initial characters. The programme will then search for a 
match in the data sought. For example, if 44 is entered, all calls made to the UK will be displayed. 
 
The balance displayed is calculated from the customer’s transactions screen, using the ‘Latest usage’ transaction type. This type of 
transaction is arrived at by adding the value of all voice/data and service items that exist in the database since the date of the 
customer’s transactions screen last invoice. The date that shows up next to the customer’s balance is the date of the last billing 
item/transaction for this customer. 
 



 

This enables the end-user to have an accurate figure that should be up-to-date, provided CDRs are rated regularly. 
 
The list of items that show in the customer’s transactions screen will be displayed after the user’s balance. 
 
The WA uses the data that was created using the automatic mode in the main application of TeleFactura and requires that the main 
Windows application run at least once a week as pieces of data are shared between the 2 applications and a licence authentication is 
done between the 2 systems once a week. 
 
This manual does not cover installing a ASP.Net app generally as this is outside the scope of a manual for a specific application, but 
more information can be found on the Internet, e.g.: 
  
http://technet.microsoft.com/en-us/library/hh831428.aspx 
http://technet.microsoft.com/en-us/library/hh831475.aspx 
 
Prerequisites for a successful installation of the Web Access: 

 The Microsoft .Net Framework v4.7.2 
 If necessary install Microsoft Visual Studio 2010 Shell (Isolated) Redistributable Package 
 Ensure point B in chapter 3.12 is adhered to 
 Installation of the Dynasoft DLL file ‘TeleFacturaTDLL.dll’ located in folder ‘Drive:\…\bin\Dynasoft Assemblies’. If the WA is 

not being installed on the machine that already hosts the main TeleFactura programme, the file will need to be registered. 
This is done from a command prompt as follows: 

o Switch the command prompt to the folder ‘Drive:\…\bin\Dynasoft Assemblies’ 
o Run the following commands: 

 gacutil /i "TeleFacturaTDLL.dll" 
 regasm /tlb "TeleFacturaTDLL.dll" 
 Both utilities come bundled with the .Net or Windows SDKs: http://www.microsoft.com/en-

gb/download/details.aspx?id=8279 
 
Once this is done and if you have named the web site for the Web Access something like ‘TeleFacturaWA’, it should be reachable at 
the following local address on your server: 
 
http://localhost/TeleFacturaWA/Default.aspx 
 
The admin section would be located at: 
 
http://localhost/TeleFacturaWA/HelpDesk/TFWAHelDesAdminLogin.aspx 
 
3.11.2. TeleFactura Web CRM 
 

 
 
TeleFactura CRM is an ASP.net add-on to the TeleFactura Windows application and requires a separate licence in order to install it on 
your server. It works with a dongle key that is inserted in a USB port or with a special version of the main application. 
 
Once the user logs in he is taken to a menu page as per the following picture: 
 



 

 
 
In order to correctly show the graphs in the “My business at a glance section” of the dashboard, use “Column1” as alias for the Y 
axis and “Column2” as alias for the X axis in the SQL queries. 
 
The following package will be needed in order to run some of the reports in the CRM: 
 
32 bit: 
http://resources.businessobjects.com/support/downloads/redistributables/vs_2008/redist/x86/CRRedist2008_x86.msi 
 
64 bit: 
http://resources.businessobjects.com/support/downloads/redistributables/vs_2008/redist/x64/CRRedist2008_x64.msi 
 
The following links might be of further help: 
 
http://stackoverflow.com/questions/53347/crystal-report-icons-toolbar-not-working-when-deployed-on-web-server 
http://codebetter.com/blogs/peter.van.ooijen/archive/2004/01/06/Get-your-Crystal-report-working-on-your-customers-server-
_2800_Cannot-find-KeycodeV2.dll_2C00_-or-invalid-keycode_2900_.aspx 
http://shaunakpandit.wordpress.com/2008/09/10/crystal-report-toolbar-images-not-displayed-aspnet/ 
 
3.11.2.1. Distributors 
 
In the configuration screen of the Windows application, three levels of distributors have to be defined. Each distributor belongs to 
one of these levels and only the levels under him/her are shown in this section. Click on a level to create a new sub-distributor. 
 
3.11.2.2. Customers 
 
In the next section, customers can be added, sales of any of the subscriptions, packages and inventory assets defined in TeleFactura 
can be added and billing transactions can be modified or added provided the right option was selected in TeleFactura’s CRM settings. 
 
Click on the first link; select a country of residence for the new customer and click on ‘Create’.  On the ‘Create a new customer’ 
page, fill in the information required. An asterisk denotes a required field. Click ‘Submit’ to enter the shipping and emergency 
services details of the customer and then the person’s bank details. The last screen lets you add as many sales of subscriptions, 
packages and inventory assets as you want. 
 
The second link in this section lets you select a customer and add sales to his/her account. 
 
The third link makes it possible to quickly see all the logged user’s customer details and even see and add billing transactions 
providing the right setting was selected in TeleFactura. 
 
The fourth link lets the user search and see a particular billing transaction. 
 
3.11.2.3. Details of existing partner distributors 
 
Update the details of one of your partner distributors. 
 



 

3.11.2.4. Customers, partner distributors and sales history 
 
This section gives the user access to lists of customers, distributors and information on the status of the sales he has secured. 
 
1. Customers and partner distributors 
 
The first link gives a list of sub-distributors and customers. The second link makes it possible to select a sub-distributor to see their 
details. The third link will give the user a breakdown of all commissions earned through each customer and commissions earned by 
each sub-distributor. 
 
2. Details of items cancelled 
 
Here, the distributor can check what recent items sold the operator has cancelled. 
 
3. Details of items activated 
 
Here, the distributor can check what recent items sold the operator has activated or the SNs that are still to be activated. 
 
4. Details of items shipped 
 
Here, the distributor can check what recent items sold the operator is about to ship. 
 
5. Details of items installed 
 
Here, the distributor can check what recent items sold the operator is about to install. 
 
6. Details of items charged 
 
Here, the distributor can check what recent items sold the operator has charged to the distributor’s customers. 
 
3.11.3. Help-Desk 
 

 
 
TeleFactura Help-Desk is an ASP.net add-on to TeleFactura Web Access and requires a separate licence in order to install it on your 
server. It works with a dongle key that is inserted in a USB port or with a special version of the main application. 
 
TeleFactura Help-Desk is an integration of AdefHelpDesk (http://www.adefhelpdesk.com/). Most of the functionality offered by this 
Help-Desk are supported in TeleFactura Help-Desk. For more information and help on how to run the application, turn to 
http://www.adefhelpdesk.com/Documentation/tabid/57/Default.aspx. 
 
To set your localisation details, go to the web.config file and set the parameter “globalization uiCulture” to the one you need. 
 
More information about setting up the Web Access for the Help-Desk can be found in chapter 3.11.1. 
 
 
3.11.4. Payments Services 
 



 

 
 
TeleFactura Payment Services is an ASP.net add-on to TeleFactura Web Access and requires a separate licence in order to install it 
on your server. It works with a dongle key that is inserted in a USB port or with a special version of the main application. 
 
TeleFactura Payment Services makes it possible for your customers and distributors to pay for any outstanding money due 
(invoices,…), pay for topping-up their account as well as to order products and services (subscriptions) that have been previously 
created via the main application’s Assets screen. Services supported are Paypal and Authorize.net. 
 
More information about setting up the Web Access for the Payment Services can be found in chapter 3.11.1. 
 
3.11.5. Accounting 
 

 
 
Access: Main interface > Settings > Accounting 
 
TeleFactura is integrated with all versions of Sage Accounts since 2011 (UK and Canada editions) and Xero. Configuration options 
are given in the configuration (point ‘8.A’) and in the accounts for the customers and suppliers (see “Various options”). 
 
Version numbers for Sage apply as follows: 
 
2011 applies to Sage UK and Canada 
2012 applies to Sage UK and Canada 
2013 applies to Sage UK and Canada 
2014 applies to Sage UK and Canada 
2015 applies to Sage Canada 
2016 applies to Sage Canada 
2017 applies to Sage Canada 
2018 applies to Sage Canada 
2019 applies to Sage Canada 
2020 applies to Sage Canada 



 

v21 applies to Sage UK 
v22 applies to Sage UK 
v23 applies to Sage UK 
v24 applies to Sage UK 
v25 applies to Sage UK 
v26 applies to Sage UK 
 
The programme installer will install the runtime files for Sage 50 Canada version 24.0.0.1 by default. Enquire with Dynasoft if you 
need the files for any other version installed. 
 
In order to activate all functionality linked to the Accounting add-on, make sure the following options are ticked in ‘Options 8’ tab 
under the configuration screen: ac, al, an, az 
  
Functionality offered include: 
 

 Add, modify or delete customer accounts: A line is shown as ticked inside the accounts of those that are present in 
Sage/Xero. For this go point ‘4.B.’, Various options. 

 Add, modify or delete supplier accounts: A line is shown as ticked inside the accounts of those that are present in 
Sage/Xero. For this go to point ‘4.B.’, Various options. 

 Add, modify or delete customer bank details 
 Add, modify or delete customer credit card details 
 Add customer transactions (invoices, credit notes, payments, direct debits, credited amounts to the Debtors control 

account,...): For this go to a customer’s account, then go to their transactions screen and the drop-down box at bottom 
left-hand side has an option to send the transaction to Sage and/or its payment. 

 Replication of new and existing customers and suppliers’ details from TeleFactura to Sage and Xero. This replication is 
triggered from the accounting screen and occurs on opening TeleFactura. 

 Import all invoice payments that exist in Sage and Xero. 
 Fetch a list of all contacts that exist in Sage and Xero on start-up and load it in local memory so as to make checking user 

details quicker and smoother. 
 
Limitations to these are as follows: 

 Sage UK does not allow: 
o Working with distributors 

 Sage Canada does not allow: 
o Deleting contacts such as customers,… 
o Deleting transactions such as invoices, payments,… 
o Working with distributors 
o Updating contacts’ bank account details 
o Updating contacts’ credit card details 

 Xero does not allow 
o Working with distributors 
o Updating contacts’ credit card details 

 
Sage 
 
Enter the connection settings to Sage in the first tab. Write the following: 

 User name (Required) 
 User password (Required) 
 Installation folder of the programme (e.g., ‘C:\Documents and Settings\All Users\Application Data\Sage\Accounts\2020\’) 

(Required) 
 The default customer account in Sage (e.g. 4000, 4030,…) (Required) 
 The tax type code (e.g., G for Sage Canada or T1 for Sage UK) (Required) 
 The default company (e.g. My Company Ltd) (Required). For Sage Canada write the name of the company file without the 

SAI extension. 
 The hosting computer’s name so the programme can connect directly to Sage (Sage UK only) (Optional) 
 The work-space (e.g. Example if you use the example company) (Sage UK only) (Required) 
 In order to get the add-on to work correctly with Sage, write the path and name to the Sage Interop SDO file (e.g., 

‘Interop.SageDataObject170.dll’) in the last box. The Interop file needs to be located in the TeleFactura’s bin folder, under 
the System folder. This file is provided by Dynasoft but we require that you email us the Sage SDO file (e.g., 
Sg50SDOEngine170.DLL) for your version of Sage 50 Accounts UK. Finally, Sage requires that a number of elements be in 
place for the integration to work. These are detailed in the help file of their SageDataObject’s SDK under the Getting 
Started chapter for your version of Sage (Sage UK only) (Required). 

  
Sage Accounts truncates customer and supplier account numbers to 8 characters and so if more characters are used in TeleFactura, 
Sage will remove them. The consequence being that Sage might complain that is being added via TeleFactura already exists. 
 
Sage Accounts has different field lengths that TeleFactura. Therefore, TeleFactura will truncate the fields to accommodate the 
maximum lengths allowed in Sage accordingly. Check the Sage objects lists in your SDK’s Sage Data Objects (Sage UK) or Data 
Dictionary (Sage Canada) for more on this. 
 
Sage Accounts requires the activation of what is called Sage’s Third Party Integration. Enquire with Sage in order to get the 
appropriate licence. 
 
TeleFactura does not allow changing an account number if the contact is present in Sage as Sage does not allow this. 
 



 

TeleFactura adds an invoice and not a transaction. In order for the program to identify that a TeleFactura transaction exists in Sage 
(especially from the customer transaction screen), it is necessary to pass an invoice or any Sage movement as a transaction under 
Sage. 
 
In order for the add-on to retrieve payments from Sage successfully, TeleFactura expects the reference/description/name of the 
payment to be followed by a space, a dash a space and the number of the invoice that was paid. An example would be for invoice 
INV_101, ‘My payment 123 – INV_101’. TeleFactura will always follow this format when adding a payment via it’s user interface. 
 
Xero 
 
For Xero, in the second tab, write the following: 

 The consumer key 
 Path and name to the private/public key file 
 Password 
 Certain account types: 

o The sales account code (e.g., 200), 
o The tax type code (e.g., OUTPUT2), 
o The account code for payments (e.g., bank 090). 

 
The program matches contacts between Xero and TeleFactura based on the following field mapping and order: 
 

Xero Account number Contact code or number Name First and last names 
TeleFactura Accounting contact* 

number 
Contact* number Company name First and last names 

Order 1st 2nd 3rd 4th 
 
* Customer, distributor or supplier 
 
The 'Name' and 'Account Number' fields in Xero must be unique if they are specified at the risk of producing an error. 
 
Sage and Xero do not provide an API to delete transactions, customers and suppliers and these tasks are not possible via 
TeleFactura. Deleting a customer for Xero will only mark it with the status VOID. 
 
If you get a message saying a customer is not present in Accounting, click ‘Yes’ or go to the settings’ Accounting screen and set a 
replication of contacts to run so missing contacts in Accounting can be updated with those in TeleFactura. 
 
TeleFactura uses what Xero calls api scopes which are computer programming areas of their service needed by TeleFactura in order 
to set and access Xero’s data. The scopes used are Contacts, Transactions and Settings. Go to 
https://developer.xero.com/documentation/api/api-overview for more information about aspects such as fields lengths allowed by 
Xero, field descriptions, etc. 
 
There is a cost to using option ‘d’ because the process of creating the invoices will be slowed down due to the fact that the 
programme needs to wait for Accounting to return an invoice number before the invoices can be fully generated. 
 
Xero uses version 2 of OAuth, the standard for authorising and authenticating a user and allows only 30-minute sessions. The option 
to log in at start-up is not supported because it is necessary to log in manually from the Accounting settings screen. 
 
To automate all activity fully between your add-on and TeleFactura the following additional options need to be selected: 
 

 Under point 8.A in the configuration: options ‘al’, ‘an’ 
 Inside customer accounts, point 4.B: option ‘k’ needs to be unticked 

  
3.11.6. TekRadius 
 

 
 



 

Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
TeleFactura has been integrated with TekRadius, which allows the programme to offer the management of customer accounts in 
prepaid mode. That is to say, TeleFactura can tell TekRadius to block accounts that fall below certain parameters determined by the 
programme, such as the credit limit of the customer or the limits imposed by the voice and data packages. 
 
Certain parameters need to be identified: 
 

 In the configuration screen, point ‘2.C.1’: the directory where the TekRadius command line programme TRCLI.EXE is 
located 

 In the customer screens:  
o Some basic TekRadius user data need to be entered in the first three text boxes: username, password and select a 

group. The first 8 options under the ‘Actions’ drop-down menu use these settings. For instance click ‘Add user’ to 
add a user in TekRadius that uses the username, password and group identified here. 

o TeleFactura will perform a number of tasks automatically. These are given in the list box with the check boxes 
located below the previous boxes. Tick the tasks as required. 

o Next, send attributes (name, values, type) to TekRadius by using the actions under the ‘Actions’ menu called ‘Add 
a user attribute’, ‘Delete a Radius client’, ‘Add a group attribute’ and ‘Delete a group attribute’. Select ‘Retrieve all 
user attributes’ and ‘Retrieve all group attributes’ to display a user’s or a group’s attributes in the large text box at 
bottom of screen. 

o Finally, the last 4 actions under the ‘Actions’ menu will use the content of the ‘Other’ text box to ‘Add a Radius 
client’ and ‘Delete a Radius client’. Typically a Radius client would be an IP address. Use the last actions to ‘List all 
Radius client entries’ and ‘List active sessions in the large text box’. 

 
The text box at the bottom allows you to see the commands as TeleFactura sends them to TekRadius. The user does not send 
commands to Radius. It is TeleFactura that will do this automatically based on the triggers defined for packages, data packages and 
credit limits. 
 
See TekRadius’s manual for more information about this application. Go to the chapter titled ‘TekRADIUS Command Line Interface - 
TRCLI.exe’. 
 
In TekRadius’s database, the Accounting table is used as repository for your voice/data and service CDRs. When configuring the CDR 
format (see chapter 3.4.2.3), select TekRadius as the source of the CDR data. The field that holds Telefactura’s originating number 
(i.e. the service numbers) is the TekRadius field called UserName. The effective numbers that are shown on invoices are the 
numbers that appear under the CallingStationID field in TekRadius. 
  
3.11.7. Radius Manager 
 

 
 
Access: Main interface > Home > Customers, distributors and suppliers > Customers tab > Double-click on a line > Drop-down box 
at bottom right-hand corner on first tab 
 
TeleFactura has been integrated with Radius Manager, which allows the programme to offer the management of customer accounts 
in prepaid mode. That is to say, TeleFactura can tell Radius Manager to block accounts that fall below certain parameters determined 
by the programme, such as the credit limit of the customer or the limits imposed by the voice and data packages. 
 
Furthermore, TeleFactura sends the user’ complete details to Radius Manager via Radius Manager’s database (table rm_users), 
including the credit limit identified in the customers’ finances screens of TeleFactura. 
 
Certain parameters need to be identified: 
 

 Configuration screen, point ‘2.B.2’: the connection string for the Radius Manager database 
 Customer screens:  

o Some Radius Manager data need to be entered such as username and password (press HASH to hash the 
password) 



 

o Go to the ‘Actions’ drop-down menu to delete, disable or enable the user manually in Radius Manager 
o New users in TeleFactura are added to Radius Manager if they are not already in, when the customer account 

screen is closed in TeleFactura. The programme will send the new user’s user name and password to Radius 
Manager along with their contact details. 

 
In Radius Manager’s database, the radacct table is used as repository for your voice/data and service CDRs. When configuring the 
CDR format (see chapter 3.4.2.3), select Radius Manager’s as the source of the CDR data. The field that holds Telefactura’s 
originating number (i.e. the service numbers) is the Radius Manager’s field called username. The effective numbers that are shown 
on invoices are the numbers that appear under the callingstationid field in TekRadius. The programme also requires the existence of 
tables rm_users and rm_services in order to work. 
 
See Radius Manager’s manual for more information about this application. 
 

3.12. Basic System Requirements 
 
1. In terms of hardware: 
 

 For optimum performance: 866 MHz processor or better 
 128MB of RAM or more 
 245MB of available hard-disk space or more 
 800x600 screen resolution or better 
 32 or 64 bit system 

 
2. In terms of software: 
 

 TeleFactura: 
o Microsoft Windows 7/2008 R2 Server or more recent 
o Microsoft SQL Server 2008, MySQL Server 5.1, MS Access 2000 or more recent 
o Microsoft .Net Framework 4.7.2 or more recent 

 TeleFactura Web Access: 
o Microsoft Windows 2008 R2 Server or more recent 
o Microsoft SQL Server 2008, MySQL Server 5.1 or more recent 
o Microsoft .Net Framework 4.7.2 or more recent 

 
3. Benchmarking TeleFactura 
 
On Windows 10 with 4x1.60Ghz XEN E5.2603 CPUs, 5GB RAM and a database on a Synology NAS running Maria DB with 1G RAM, it 
takes 60 minutes to go through 1500 customers. Half of the customers have voice data and the other half only subscriptions. 
 

3.13. Troubleshooting 
 
A. When installing on Windows Vista, 7 and server machines it might be necessary to perform the following steps, although 
TeleFactura normally does these tasks itself via the installer: 

 Open a command prompt as administrator and run the command ‘bcdedit.exe /set {current} nx AlwaysOff’ 
 Reboot machine 
 Right-click over the TeleFactura installer and click ‘Run as administrator’ 
 Complete the installation until the end 
 Open a command prompt as administrator and run the command ‘bcdedit.exe /set {current} nx AlwaysOn’ 
 Reboot machine 
 TeleFactura should now start normally 

It is also possible to add TeleFactura in the list of programmes allowed by Windows by following the steps here: 
http://www.vistax64.com/tutorials/65790-dep-turn-off-programs.html. 
 
B. If you are installing on a 64-bit machine and wish to access TeleFactura via ODBC, use the Windows ‘Data Sources (ODBC)’ utility 
for 32-bit applications located in the SysWow64 folder in the Windows folder. Also, if you package to use the MySQL, use the 32-bit 
versions of MySQL applications throughout. For MySQL, ensure the 32-bit ODBC drivers (v5.1 preferably) are installed. For MS SQL 
Server, 64-bit version is recommended. 
 
C. It is recommended to use OLE DB instead of ODBC as connections are faster and more stable. However, if the server is 64 bit, 
only a connection through ODBC will work as the OLE DB driver will be 64 bit on the server and not 32 bit. For ODBC use a 
connection string like this one: Provider=MSDASQL.1;Persist Security Info=True;Data Source=TeleFacturaDB_DSN;Initial 
Catalog=TeleFacturaDB;User ID=xxx;Password=xxx. For OLE DB, use a connection string like this one: 
Provider=SQLOLEDB.1;Persist Security Info=False;User ID=xxx;Password=xxx;Initial Catalog=TeleFacturaDB;Data 
Source=ServerIP. 
 
D. It is important to regularly run some maintenance on your database to avoid it from running too slowly. This includes especially 
checking the table indexes and rebuilding them if time out errors occur for instance. More on this here: 

 For MS SQL Server: http://technet.microsoft.com/en-us/library/bb808953.aspx 
 For MySQL: http://dev.mysql.com/doc/refman/5.1/en/partitioning-maintenance.html 

 
E. If compatibility issues are found whilst running the programme, you may try running it by changing the compatibility version of 
the programme by following the steps detailed here HHhttp://windows.microsoft.com/en-HK/windows7/Make-older-programs-run-in-
this-version-of-Windows. 
 
F. Problems found when billing and their solutions: 

 “The voice calls tab under the Billing screen’s display tab gets filled with calls for only some of the SNs or none at all”. The 
possible solutions to this are as follows: 



 

o Click option 63 in the configuration screen. This should rebuild all SNs. 
o Ensure you identified correctly how numbers calling and called are displayed in the CDRs (see option C in the 

voice/data CDR screen of the supplier’s account). 
o Ensure the SNs’ dialling codes are not included in the SNs that are written in the customers’ accounts as dialling 

codes need to appear in their own boxes under the SN. 
 "Calls are found in my CDRs, but these are not rated." Possible resolutions include: 

o A call type column has been identified in the CDR format but these have not been defined in the price lists 
associated with the customer(s) that is being billed and/or in the configuration or in a supplier account. 

o Ensure that all destinations in your price lists have a country code. This includes national destination. 
o Check that all SNs are associated with one or more price lists in the customers’ accounts. 

 "Sending invoices to accounting from the billing screen does not work." Ensure that a number of options have been 
selected: 

o The billing option "Make the session an official one and save all its data" under the billing screen. 
o Option ‘al’ and ‘an’ in point ‘8.A’ of the configuration has been selected. 
o Uncheck option ‘k’, under point ‘4.B.’ in customer accounts. 
o Ensure that the program is connected to accounting in settings screen. 
o Ensure that the customer is in accounting. 

 “The rated data and the reference the last CDR file the programme is working on, get deleted from the system in the billing 
screen when I click to stop rating CDR data”. This is by design. If the user clicks to stop the rating of CDR data, the 
programme will delete all data associated with the last CDR file it was working on so only fully scanned files are kept in the 
system. To avoid this, stop the rating process when the programme shows “Waiting for new CDRs…” on the user interface. 
This will not make the programme delete anything. 

 “Packages don’t show”:  
o Check the call types you used to define the package exist in the configuration. 
o Check the customer type to which the package applies is correct. Customer type here is the type of the callee not 

the caller. 
o Make sure the package has been ticked in the customer’s account. 

 “Package do show but the allowances are not applied to the user’s calls”: 
o Check the items in previous point are correct. 
o Delete the package and enter it again and associate it with the customer again. 

 “Some of my national calls are being billed as international calls”. The possible solutions to this are as follows: 
o Your price list does not have the country code for all destinations, including national codes 
o In the definition of the CDR format, if you defined national calls using the lengths of possible numbers, there might 

be a length missing. 
o If you use call types, you might need to review these in your price lists to ensure they match call types found in 

your CDR data. 
 
G. TeleFactura uses SQL bulk insert statements. Ensure your database’s variable ‘max_allowed_packet’ has a value high enough for 
MySQL and a Transaction Size Limit for MS SQL Server that is high enough. 
 
H. TeleFactura error codes: 

1. Billing codes 
 1001: The file is empty, the wrong separator was selected or the CDR data does not have the same number of 

columns that were defined in it’s format. 
 1002: General error found. Check your configuration data. 
 1003: There seems to be a CDR file that is using an unidentified format. Check the file as not all calls might have 

been rated correctly. 
 1004: A directory seems to be missing or the path to a CDR can’t be found. 
 1005: A data item was not picked up because it is not associated with a selected customer. 
 1006: A service item was not picked up because it is not associated with a selected customer. 
 1007: Check the configuration of the format of dates. The CDR shown under column EntryCaption3 has an 

unexpected date format. Make sure you are using the right case when it comes to defining the month and hour 
parts of the string (mm vs MM, hh vs HH,…). See this link for more information: https://docs.microsoft.com/en-
us/dotnet/standard/base-types/custom-date-and-time-format-strings. 

 1008: A directory could not be found. 
 1009: A voice call was not picked up because it is not associated with a known customer. 
 1010: A file that should have contained the date does not. 
 1011: A data item was not picked up because it is not associated with a known customer. 
 1012: A service item was not picked up because it is not associated with a known customer. 
 1013: The following line contains a SN with no associated price list. 
 1014: There is a risk that calls can’t be found for the following SN. The reason might be that you identified SNs 

incorrectly as some have shown to start with the user’s dialling code. Ensure none of the SNs identified in the 
Customers screen show the country dialling codes. 

 1015: The following series of character has an incorrect date format. 
 1016: No data found. 
 1017: No flag for inbound/outbound calls was found in the following CDR line. 
 1018: A non-numeric character was found where a number is expected. 
 1019: A number without any match in the price list and CDR was found. 
 1020: Wrong price list entered for this customer SN, or this code is not included in customer’s price list 
 1021: Number called is empty. 
 1022: Check that the customer’s sales price list has the following: A dialling code for the number called, an OK flag 

is defined in the ActivateRoute field, all destinations have a call type that match those identified in the 
configuration, if a call type field was identified in the CDR format that these call types exist in the configuration, all 
dialling codes start with the country code including national dialling codes. 

 1023: Check that the customer’s purchase price list has the following: A dialling code for the number called, an OK 
flag is defined in the ActivateRoute field, all destinations have a call type that match those identified in the 



 

configuration, if a call type field was identified in the CDR format that these call types exist in the configuration, all 
dialling codes start with the country code including national dialling codes. 

 1024: Problems accessing the following database. 
 1025: No voice items could be found for the customer, a sales price list is missing or not defined or no voice/data 

CDR format is associated with the customer. 
 1026: No data items could be found for the customer or no data CDR format is associated with the customer. 
 1027: No service items could be found for this customer, no services CDR format is associated with the customer 

or his price list does not contain the right code and description for the services found. 
 1028: Connection to the database to manage unmatched CDRs failed. The database connection string should be 

reviewed. 
 1029: Error associated with a DLL component of the programme. See the details given in log file MainLog.txt under 

Assets > System for more information. 
 1030: ODBC and/or non-ODBC connection to the database failed. Check your database connection details. If an 

SQL user is used to connect to the database, it is important to specify its database user name and password in the 
Configuration screen > Option 4.C.9. 

 1031: Certain pieces of data are missing from the CDR data: the number called, calling or no value was found for 
the date field. 

 1032: The following folder does not exist. It's needed in order to save the unrated line given. 
 1033: One or more numbers calling have a format which is not consistent with parameter c identified in the CDR’s 

configuration. It is recommended to log or save the unmatched call using billing options ‘b’ and ‘l’ to save all the 
lines involved. 

 1034: An invoice is already being created for this customer number by another user or the program must be reset 
by pressing 'Record locking' under the System menu. 

 1035: Unmatched items have been found. Only a limited subset of these are given in the log. To gather a list of all 
such items in a separate text file, click billing options ‘b’ and/or ‘l’. The text file is called ‘unrateditems.txt’ and is 
found under each CDR format’s respective folder in Windows. 

 1036: No price list exists for the customer’s service number. 
 1037: Loading the price lists in memory for the customers that were selected has caused an out of memory error. 

The programme will now try to rate by querying the database directly instead. Note that this will impact the 
programme’s performance. Check the price lists for the customers selected to try to reduce the number of lists 
associated with each customer and the number of destinations in each list. 

 1038: The following CDR file has a number of columns different from the number that was identified when the 
format for it was imported. 

 
I. TeleFactura is slow to start. This is normal as the programme performs some metadata checks every 4 days or so. It is 
recommended to let the programme run its course until it loads normally even in Windows says the programme is not responding. 
 
J. TeleFactura seems to be stuck trying to saving unmatched items during a billing session: Stop the programme and select ‘Resume 
from last CDR analysed’. 
 
K. TeleFactura has crashed whilst saving unmatched items during a billing session: Restart the programme and select ‘Resume from 
last CDR analysed’. 
 
L. Known bugs from third party tools that Dynasoft has identified that might affect the behaviour of TeleFactura: 

 MS Access 
a. Concatenating long strings that straddle 3 or more database fields does not work with 100% reliability. 

 Windows 
a. The Windows update KB3102429 should not be installed as it interferes seriously with Crystal Reports and 

prevents it from being able to generate Crystal Reports files. 
 Ms SQL 

a. The programme uses functions such as STUFF that are problematic under the ODBC drivers provided by Microsoft. 
It is best to use the default SQL Server drivers for Windows servers if a large number of customer service numbers 
are used. 

 MySQL 
a. When selecting data from a table containing a DATE or DATETIME column defined as NOT NULL, data retrieval 

stops with error 80004005, ‘Data provider or other service returned an E_FAIL status’, apparently at the first row 
containing ‘0000-00-00’ or ‘0000-00-00 00:00:00’ values (on DATE or DATETIME fields, respectively). When the 
columns are defined as accepting NULL values, no error occurs when values ‘0000-00-00’ or ‘0000-00-00 
00:00:00’ are fetched. The problem seems to be related with the use of ADO. More on this here: 
HHhttp://www.roseindia.net/mysql/Data-Provider-or-other-service-returned-an-E_FAIL-status-Error.shtml 

b. TeleFactura has been tested with MySQL v5.6 and ODBC drivers v5.1.13. Later versions of the se drivers were 
found to be buggy. 

c. MySQL randomly returns BLOB values both when using MySQL functions like CONCAT or not. More on this here 
http://dev.mysql.com/doc/refman/5.7/en/blob.html, http://dev.mysql.com/doc/refman/5.7/en/blob.html.   

 
M. How can I make TeleFactura run faster? 
 
Here are a few pointers: 

 To keep TeleFactura maximised is not efficient as Windows has to refresh the entire screen whenever TeleFactura calls a 
GUI element. It's best to keep TeleFactura to its default size. 

 Make sure your CDR data only holds the minimum information required for billing. Having redundant data will slow rating 
speeds. 

 Make sure you have all the latest Windows and Dynasoft software updates for your system. 
 Clean up your database: Delete all entries from ProgrammeEvents and ProgrammeLogs tables from your product's 

database. 
 Allow enough space for, shrink, optimize and/or compact your database regularly 
 Periodically run optimization software like CCleaner. 



 

 Generally, MS Access is slower than MySQL which is slower than SQL Server. MS Access does not have bulk insert SQL 
queries and things like deleting duplicate records in a database table is slow. MS Access is good though for low traffic 
managed by a user who already feels comfortable using MS Access. 

 Get a faster hosting machine. 
 
N. Error from Crystal Reports “Page Header plus Page Footer is too large for the page” 
 
This error is due to Crystal Reports which is used to render the programme’s invoices and reports. More information about the 
nature of this error can be found here: https://stackoverflow.com/questions/12098164/what-causes-the-page-header-plus-page-
footer-is-too-large-for-the-page-error-i.  
 

3.14. Important Notes 
 
A. Included with TeleFactura are a number of Crystal Reports files that are located in Assets > System > Reports. These can be 
modified to best suit your needs. However, care needs to be used so that the changes you make do not break anything in the 
software and to ensure the reports run fine. We have found that the best way to modify the files is from inside Microsoft’s Visual 
Studio and not from inside the Crystal Reports IDE. The reports can be modified using Visual Studio 2010 or more recent. It will be 
necessary to install SAP Crystal Reports for Visual Studio 
(http://downloads.businessobjects.com/akdlm/cr4vs2010/CRforVS_13_0.exe). Make sure also that This add-on is not installed 
alongside TeleFactura as this will break the installation of your programme. 
 
To save the modified file in Visual studio, select save as in the File menu and click no if you are asked if file should be upgraded to a 
later version of Crystal Reports. 
 
Once you decide to run the modified files with TeleFactura and if you get any unwanted dialogue box which seemingly cannot be 
removed, then send the files to us with written comments on the changes you tried to apply and we can send you the files correctly 
formatted by return. Note this is only available to customers who have contracted our annual support service. 
 
It is recommended to close TeleFactura if it is not being used, unless you are running the Web Access or CRM in which case it will 
have to be run at least once a week. 
 
B. If you wish to modify some of the captions on the programme, you may do so by going to the file TeleFacturaLangTxt.txt located 
in the system folder of the programme’s main installation folder. It’s important that if you decide to change a caption in one block 
that all the other blocks that use the exact same wording be changed as well to the same new wording. It is advised that the blocks 
that you need changing are kept in a separate file too as new updates overwrite the previous language file. 
 
Also, never use an old version of the caption file as important errors will arise. Always use the latest one installed by TeleFactura. If 
blocks have been modified in a previous file, it is best to keep a record of all the blocks you need to modify and do a search and 
replace in the latest file only. 
 
C. To get in touch with Dynasoft for support and if you require that we analyse your data, provide the following information: 

 Copies of the following xml files: Program Data > Dynasoft > TeleFactura > Assets > System > TeleFacturaXML001.xml 
and TeleFacturaXML002.xml 

 A backup of your TeleFactura database. 
 A number of CDRs files that illustrate the issues you are having or an export from the CDR database table. 

 
D. How to report bugs: Note that in order for bugs to be fixed Dynasoft needs as comprehensive a bug report as possible. Below is 
the information we will need: 

 We have to know the exact steps that lead to a bug appearing: what buttons are clicked, in what order, what settings were 
entered, time of day, date, screenshots of the problems and exact configuration of the windows machines used,...  

 We need to know exactly what piece of data is giving problems (i.e., the exact CDR records, customer number and SNs) 
 We need to know the detailed scenario that was used and that we can use to reproduce the problem and also know the 

exact outcome that was expected but that was thwarted because of the bug 
 A copy of the log files located in ‘drive:\Program Data\Dynasoft\TeleFactura\Assets\System’ 
 A script file of your data or a backup of the database (MySQL or MS SQL Server) or a copy of the database (MS Access): 

o In the database for TeleFactura, there is a table called ProgrammeEvents that stores all the runtime errors the 
programme encounters. Send us all the entries in it, but only those that relate to when the bug caused the 
programme to malfunction. It is advised to delete all the other entries of table ProgrammeEvents with a view to 
reducing the size of the file. If it is not possible to do so, delete the table entirely and re-create it using the query 
in the script files located in ‘drive:\Program Data\Dynasoft\TeleFactura\Assets\System’. Doing this will not affect 
the programme. 

o Delete all entries in table ProgrammeLogs 
o Optimise and compress the database (“Shrink” in the case of a MS SQL Server database) 
o Create an SQL export file for the tables and their content or a backup file for MySQL and MS SQL Server or a copy 

of the database for MS Access. 
 A copy of the problem CDR files if necessary 
 Zip all files and send all bug reports to support@dynasoft.net or send a download link for the files 
 Dynasoft might require to have access to the server via VPN and to your database so we can see what the problem is and 

see what your data and settings are. 
 Do not send us any sensitive information contained in your files such as customer credit card details, smtp details,… 
 More detailed information on this subject can be found here. 

 
E. More information about how to configure ODBC for MySQL and MS SQL Server. This is useful if you use a database (Asterisk,…) as 
a source for the CDRs or to configure TeleFactura to use MySQL/MS SQL Server as its database system: 
 

 MS SQL Server: http://technet.microsoft.com/en-us/library/cc879308.aspx 
 MySQL: http://dev.mysql.com/doc/refman/4.1/en/connector-odbc-configuration-dsn-windows.html 



 

 
F. Always perform regular backups of your database, especially if big changes have to be made to it. 
 
G. If errors relating to possible timeouts in SQL queries are encountered in the database, potentially serious errors in the calculation 
of the invoices might result. Regular checks should be conducted to ensure that these errors do not occur. If they do, go to the 
tables Voice/Data/ServiceAutoCRCustomerInv and delete any all old non-relevant data. Also, increase the timeout values in the 
settings of your database. You may create alerts in the programme using the SQL Builder. 
 
H. Here is how to perform tests on your data safely between software updates and if a software update has been released: 
 

 Back up your database 
 Download the software update 
 Run the update’s installer and open TeleFactura from the desktop. It is TeleFactura not the installer that makes the 

necessary changes to the database. 
 Perform the required tests 
 Close TeleFactura 
 If all is ok, restore the database 
 Start TeleFactura and it will update your database again 

 

3.15. Documentation 
 
TeleFactura encrypts certain pieces of data in its database such as the credit card number, customer password for the Web access. 
Get in touch with Dynasoft if you require the source code that encrypts/decrypts this information to use in your own applications. 
 
More information about certain database tables and fields in case integration work needs to be done with TeleFactura: 
 

 VoicePricePlans: Packages 
o PlanRecurrence: D is Daily, W is Weekly, M is Monthly, Q is Quarterly, Y is Yearly 

 VoicePriceLists: Price list details for voice services (as shown in the Price list details screen) 
 VoiceCDRFormat: The various voice/data CDR formats that exist (as shown in the CDR screen in the supplier accounts) 
 VoiceAutoCRCustomerInv: Records as shown in the itemised part of the invoices for voice services billing (auto and manual 

modes) 
o Outbound_Inbound: indicates if a call is outbound or inbound (0 is outbound, 1 is inbound) 

 VariousItemsCLI: Link between the customers’ SNs and the subscriptions as shown when double-clicking on a subscription 
in a customer screen 

 SysUserAccounts: Table holding the users with authorised access to the programme 
 Suppliers: This table holds the suppliers’ details 
 SupplierBilling: This table holds the suppliers’ transactions 

o PaymType: P is Payment by, I is Invoice, D is Discount, T is Top-up, R is Refund, C is Cancellation, G is 
Chargeback, M is Commission, Q is Payment to, U is Computed usage, L is Latest usage, N is Credit note, B is 
Billing note, A is Credit advice, J is Adjustment 

o OrigInvNbr: Holds the invoice number for the payment of a transaction (e.g., invoice) 
 ServicePriceLists: Price list details for recurrent services (as shown in the Price list details screen) 
 ServiceCDRFormat: The various services CDR formats that exist (as shown in the CDR screen in the supplier accounts) 
 ServiceAutoCRCustomerInv: Records as shown in the itemised part of the invoices for recurrent services billing (auto and 

manual modes) 
 ProgrammeLogs: All logs are kept in this table 

o EntryType: Type of entry (billing, messaging,…) 
 ProgrammeEvents: Repository for all the runtime errors  
 InvoiceCostCentre: Cost centres that get created when invoices are generated 
 Inventory: Inventory table 
 GlobalPriceLists: Table holding the references to the price lists for all services (as shown in the Price lists screen) 
 Distributors: This table holds the distributors’ details 
 DistributorBilling: This table holds the distributors’ transactions 

o PaymType: P is Payment by, I is Invoice, D is Discount, T is Top-up, R is Refund, C is Cancellation, G is 
Chargeback, M is Commission, Q is Payment to, U is Computed usage, L is Latest usage, N is Credit note, B is 
Billing note, A is Credit advice, J is Adjustment 

o OrigInvNbr: Holds the invoice number for the payment of a transaction (e.g., invoice) 
 DIDsCLIs: Inventory of DDI/SIMs 
 DataPriceLists: Price list details for data services (as shown in the Price list details screen) 
 DataCDRFormat: The various data CDR formats that exist (as shown in the CDR screen in the supplier accounts) 
 DataAutoCRCustomerInv: Records as shown in the itemised part of the invoices for data billing (auto and manual modes) 
 CustomerVoiceCLIDetails: Individual numbers belonging to customers. Ranges are split into individual numbers 
 CustomerVoiceCLICDRFormats / CustomerDataSNCDRFormats  / CustomerServiceSNCDRFormats: Table linking the 

customers’ service numbers (via a foreign key) and CDR formats 
 CustomerServiceSNPriceLists: Table linking the customers’ service numbers (via a foreign key) and recurrent services price 

lists 
 CustomerVoiceCLI: Table that has the customers’ service numbers and number ranges 
 CustomersData: This table holds the programme’s general configuration details (e.g., next invoice number,…) 
 Customers: This table holds the customers’ details 
 CustomerBilling: This table holds the customers’ transactions 

o PaymType: P is Payment by, I is Invoice, D is Discount, T is Top-up, R is Refund, C is Cancellation, G is 
Chargeback, M is Commission, Q is Payment to, U is Computed usage, L is Latest usage, N is Credit note, B is 
Billing note, A is Credit advice, J is Adjustment 

o OrigInvNbr: Holds the invoice number for the payment of a transaction (e.g., invoice) 
 AutoCRCustInvMain: This table holds the information shown in the invoices’ summary part (auto and manual modes) 



 

o ItemType: 0 is voice, 1 is voice part of a package, 2 is data part of a package, 3 is recurring services, 4 is 
subscriptions, 5 is prepayment by customer 

 AutoCDRFiles: CDR files analysed during the billing process (auto and manual modes) 
 AdditItems: This table holds the list of sales (subscriptions) to the customers 

o ItemType: 0 is Package, 1 is Subscription, 2 is Inventory asset 
o ItemStatus: 0 is Order received, 1 is Pending configuration, 2 is Pending installation, 3 is Pending shipping, 4 is 

Pending activation, 5 is Order fulfilled, 6 is Order cancelled, 7 is Order closed 
o ItemRecurrence: O is One off, D is Daily, W is Weekly, M is Monthly, Q is Quarterly, Y is Yearly, N is No recurrence 
o VariousItemIndex: Foreign key from VoicePricePlans and Inventory tables for package or inventory item or for a 

general subscription from AdditItems 
o CustomerIndex: Foreign key holding the primary key of customers. If value = 0 then the item is a global 

subscription. 
 

4. Additional Information 
 

4.1. Accessing this Programme via the Web 
 
Accessing this billing system via the Web using any Web browser is easily achieved using Myrtille, a free programme enabling any 
Windows user with Remote Desktop privileges to access a Windows server remotely. Installing Myrtille only takes a few seconds and 
users can connect to their server immediately. 
 
Download the programme from here: http://www.dynasoft.net/download/Myrtille_2.5.5_x86_x64_Setup.exe 
 
Get the latest version from https://cedrozor.github.io/myrtille/ 
 
More on Remote Desktop: https://support.microsoft.com/en-us/help/4028379/windows-10-how-to-use-remote-desktop 
 
More on using Remote Desktop with Windows 10 Home: https://www.thewindowsclub.com/how-to-use-windows-10-remote-
desktop-in-windows-home-rdp 
 
Alternatives to Windows Remote Desktop: 
 
https://remotedesktop.google.com/ 
https://www.realvnc.com/ 
  
More about how to use Dynasoft TeleFactura and Myrtille: https://www.dynasoft.net/telecom-cdr-billing-software/voip-cloud-
system/ 
 

5. FAQ 
 
Turn to our website for a detailed Frequently Asked Questions section: http://www.dynasoft.net/telefactura-telecoms-billing/faq 
 

6. Videos 
 
Turn to our website for a detailed series of videos about the programme: http://www.dynasoft.net/telefactura-telecoms-
billing/training-video 
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